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About this Guide

This document contains information about using the Mobile Development plug-in of
Software AG Designer.

Document Conventions

Convention Description

Bold Identifies elements on a screen.

Narrowfont Identifies service names and locations in the format
folder.subfolder.service , APIs, Java classes, methods, properties.

Italic Identifies:

Variables for which you must supply values specific to your own
situation or environment.
New terms the first time they occur in the text.
References to other documentation sources.

Monospace
font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

{ } Indicates a set of choices from which you must choose one. Type
only the information inside the curly braces. Do not type the { }
symbols.

| Separates two mutually exclusive choices in a syntax line. Type
one of these choices. Do not type the | symbol.

[ ] Indicates one or more options. Type only the information inside
the square brackets. Do not type the [ ] symbols.

... Indicates that you can type multiple options of the same type.
Type only the information. Do not type the ellipsis (...).
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Online Information and Support
Software AG Documentation Website

You can find documentation on the Software AG Documentation website at “hp://
documentation.softwareag.com”. The site requires credentials for Software AG's Product
Support site Empower. If you do not have Empower credentials, you must use the
TECHcommunity website.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to
“empower@softwareag.com” with your name, company, and company email address
and request an account.

Once you have an account, you can open Support Incidents online via the eService
section of Empower at “hps://empower.softwareag.com/”.

You can find product information on the Software AG Empower Product Support
website at “hps://empower.softwareag.com”.

To submit feature/enhancement requests, get information about product availability,
and download products, go to “Products”.

To get information about fixes and to read early warnings, technical papers, and
knowledge base articles, go to the “Knowledge Center”.

If you have any questions, you can find a local or toll-free number for your country
in our Global Support Contact Directory at “hps://empower.softwareag.com/
public_directory.asp” and give us a call.

Software AG TECHcommunity

You can find documentation and other technical information on the Software AG
TECHcommunity website at “hp://techcommunity.softwareag.com”. You can:

Access product documentation, if you have TECHcommunity credentials. If you do
not, you will need to register and specify "Documentation" as an area of interest.

Access articles, code samples, demos, and tutorials.

Use the online discussion forums, moderated by Software AG professionals, to
ask questions, discuss best practices, and learn how other customers are using
Software AG technology.

Link to external websites that discuss open standards and web technology.

http://documentation.softwareag.com
http://documentation.softwareag.com
mailto:empower@softwareag.com
https://empower.softwareag.com/
https://empower.softwareag.com
https://empower.softwareag.com/Products/default.asp
https://empower.softwareag.com/KnowledgeCenter/default.asp
https://empower.softwareag.com/public_directory.asp
https://empower.softwareag.com/public_directory.asp
http://techcommunity.softwareag.com
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Data Protection
Software AG products provide functionality with respect to processing of personal data
according to the EU General Data Protection Regulation (GDPR). Where applicable,
appropriate steps are documented in the respective administration documentation.
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About Mobile Development
Software AG Designer provides a set of Mobile Development features that you can use
to develop mobile applications. Use the Mobile Development perspective to display the
views and editors needed to work with mobile applications.

Mobile Development uses the principles of model view controller (MVC) architecture,
which separates the user interface from the business logic and data.

When using Mobile Development, you define the user interface in the Outline Editor
that Mobile Development provides. In the Outline Editor, you can also define additional
information for the mobile project, such as the languages the application supports or
identify services that your application uses to obtain data.

Mobile Development generates Java code for the application. The generated code is
based on the project you define in the Outline Editor. When generating the code, Mobile
Development maintains code that it generates separate from the business logic code that
you provide. Mobile Development generates code, for example, that displays the user
interface you design and that can respond to user-initiated events, such as when a user
presses a buon.

Mobile Development also creates Java classes where you put your business logic. These
Java classes are placed in a location known as the user space. After initially creating the
Java classes, in the user space, Mobile Development does not make any further changes
to the classes so that any code you add is not overwrien or changed.

Other Resources for Mobile Development
In addition to the information contained in this Mobile Development help, you can also
find information about working with mobile applications in the following locations:

Using webMethods Mobile Designer. This publication describes how to:

Set up your environment for various mobile platforms (for example, Android
and iOS) so that you can develop mobile applications for a platform.

Code resource handlers and mobile applications.

Build mobile applications.

Install applications on various platforms.

webMethods Mobile Designer Native User Interface Reference. This publication provides
general information about how to build the user interface for a mobile application.
Additionally, it provides details about the Mobile Designer native user interface
that you can use to create user interfaces for mobile applications. The native
user interface objects described in this publication correlate to the user interface
elements you can add to a mobile application using the Outline Editor in the Mobile
Development perspective.
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webMethods Mobile Designer Java API Reference. This publication describes the Java
classes that Mobile Designer provides and that you can use when coding mobile
applications.

You can download these files from the Software AG Documentation website.

Mobile Development Terminology
The following terminology is used in webMethods Mobile Development Help:

Term Explanation

Android Styles An Android style is a collection of aributes that
specify the appearance of a View object. It can be
modified in the ASL Editor. Android styles have
the file extension themes.asl and are stored in
your_project /model/resources/themes.asl. For more
information, see “hps://developer.android.com/
guide/topics/ui/look-and-feel/themes”.

App Icons The app icon is the icon displayed when an
application starts. It can be modified in the App Icon
Editor. App icons have the file extension app.icons
and are stored in your_project /model/resources/
app.icons.

Application Model The application model describes the content of your
mobile application, including user interface, services,
data model, and localisation. It is visualised in the
Outline Editor. Application models have the file
extension .aml and are stored in your_project /model.

Asset An asset describes the composition and style of an
icon. Exporting an asset creates multiple .png icons
for the desired platform to fit any screen resolution.
An asset is edited in the Asset Editor. Asset files have
the file extension .asset and are stored in your_project /
model/resources.

Data Model A data model describes the entities to be used in your
mobile application. It also enables an entity-to-JSON
mapping. A data model can be edited in the EML
Editor. Data models have the file extension .eml and
are stored in your_project /model/entities.

https://developer.android.com/guide/topics/ui/look-and-feel/themes
https://developer.android.com/guide/topics/ui/look-and-feel/themes
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Term Explanation

Jenkins Build A Jenkins build is a Mobile Designer multi-build that
is run on a Jenkins server.

Keystore For a description of the Android keystore, see
“hps://developer.android.com/training/articles/
keystore”.

Mobile Project In Software AG Designer, the Package Explorer
element containing all required files to build an
application is referred to as a mobile project.

Multi-Build Building a mobile project to create the platform-
specific artefacts for iOS and Android is referred to as
a multi-build.

Provisioning Profile A provisioning profile is required to install and run
an iOS application on physical devices. It is bundled
within the application to provide information about
the app id and development team being used as well
as the devices the app is allowed to be tested on.
Manage and download provisioning profiles for your
projects and apps at “hps://developer.apple.com/
account/ios/profile/”.

Sources The Java classes, graphical, and text resources
required to build the mobile application are referred
to as sources.

Target Describes the resulting artefact type when doing
a multi-build. There are the following types for
Android:

Debug (Only use for debug and test purposes
on your devices. The source code will not be
obfuscated.)

Release (Use to publish the final build. The source
code will be obfuscated.)

There are the following types for iOS.

AppStore (Use for distribution in Apple's App Store.
The final build can be uploaded to the App Store.)

Enterprise (Use for inhouse distribution. The final
build can be distributed within your organization.)

https://developer.android.com/training/articles/keystore
https://developer.android.com/training/articles/keystore
https://developer.apple.com/account/ios/profile/
https://developer.apple.com/account/ios/profile/
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Term Explanation

Ad Hoc (Use for inhouse distribution for testing. The
final build can be installed on a limited number of
registered devices.)

Dev Release (Use for testing. The final build can be
installed on test devices.)

Sim Release (Use for testing in a simulator. This
target does not require a provisioning profile.)

XCode project (Only an Xcode project will be created.
Use this target if you want to use Xcode to debug an
application in a simulator).
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Mobile Development Perspective
The Mobile Development perspective contains the views and editors needed to work
with mobile applications.

 Ant view The Ant view is a standard Eclipse view. It shows Ant scripts
that you can use for a mobile project.

Mobile Designer provides several Ant scripts that you use
to perform various tasks for a mobile project. For example,
you use an Ant task to build a project. The build Ant tasks
compile your application code and package the application
so that you can install it on a mobile device.

 Jenkins Build
Explorer view

The Jenkins Build Explorer view is a Mobile Development-
specific view. It lists your Jenkins builds, their state, and the
final binaries for iOS and Android. These binaries can be
downloaded and installed on devices.

 Mobile Explorer
view

The Mobile Explorer view is a Mobile Development-specific
view. It contains a subset of the information in the Package
Explorer. The Mobile Explorer view displays information
only for mobile projects. For each mobile project, the Mobile
Explorer view displays:

Root application
Single, main window for the project
Each view defined for the project
Each dialog defined for the project

Use the Mobile Explorer view to navigate to the project
information you want to view and work with in the Outline
Editor. For example, if you want to work on one of the views
in the project, you can navigate to that view in the Mobile
Explorer view and display it in the Outline Editor so that you
can edit the view.

 Outline view The Outline view is a standard Eclipse view. It shows
previews for editors, such as the Outline Editor, the Asset
Editor, and the App Icon Editor.

 Package Explorer
view

The Package Explorer is a standard Eclipse view. It shows a
Java-specific view of your projects, including mobile projects.
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The Package Explorer tree structure contains a top-level
node for each mobile project. The name of the top-level node
matches the name of the mobile project.

The Package Explorer allows access to all information in a
project, including the application code, resource handler
code, application resources, properties files, and information
about the devices a project supports.

 App Icon Editor The App Icon Editor is a Mobile Development-specific editor
that allows you to import and customize the app icon (icon
displayed when an application starts) and launch screen (the
first screen displayed).

 ASL Editor The ASL Editor is a Mobile Development-specific editor that
allows you to configure Android styles.

 Asset Editor The Asset Editor is a Mobile Development-specific editor that
allows you to create and customize an asset file. The asset
file defines how an icon looks like, and Mobile Development
creates different icon sizes based from this asset definition.

 EML Editor The EML Editor is a Mobile Development-specific editor that
allows you to edit a project-specific data model.

 Layout Builder The Layout Builder is a Mobile Development-specific editor
that is used to model constraint layouts.

 Outline Editor The Outline Editor is a Mobile Development-specific editor
that will be shown when you add or display a mobile object.
It shows an outline of the mobile project. The Outline Editor
consists of the following:

A Model section, which displays the tree structure, or
outline, of the mobile project. It lists, for example, the
window, views, and dialogs in the project. Child nodes of
a window, view, or dialog list the user interface elements,
such as buons or text entry fields, that the window, view,
or dialog contains. Additionally, the outline of the project
lists the languages that the project supports.

A Properties section, which displays the properties for the
node that is selected in the Model section. Use the Properties
section to view and edit properties.

A palee, which lists all objects that can be added to
the mobile project. To add an object, you drag it to the
appropriate node in the Model section.
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Opening the Mobile Development Perspective
Software AG Designer provides a Mobile Development perspective that contains the
views and editors needed to work with mobile applications.

Note: When you open Software AG Designer for the very first time, a Welcome page
is shown. You can also open the Mobile Development perspective by clicking
the corresponding link in the Welcome page.

To open the Mobile Development perspective

1. In Software AG Designer, select Window > Open Perspective > Other.

2. In the Open Perspective dialog box, select Mobile Development.

3. Click OK.

Software AG Designer switches to the Mobile Development perspective.

Displaying a Mobile Project in the Outline Editor
You can use the Outline Editor to view an outline structure of your mobile project,
update the user interface for the application, and specify languages that your application
supports.

You can open a mobile project from the Mobile Explorer view or the Package Explorer.

Note: If the above-mentioned views do not yet show a mobile project, see “Creating
a New Mobile Project” on page 34.

To display a mobile project in the Outline Editor

To display a mobile project from the Mobile Explorer view:

1. Expand the project in the Mobile Explorer view.

The top-level child node of the project represents the root application for the
project.

2. Do one of the following to display the mobile project in the Outline Editor:

Double-click the root application node.

Select the root application node and press ENTER.

To display a mobile project from the Package Explorer:

1. Locate the project in the Package Explorer.
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2. Expand the project to locate the root application node in the model folder, for
example, model > application_name .aml, where application_name .aml is the node
that represents the root application for the project.

3. Do one of the following to display the mobile project in the Outline Editor:

Double-click the root application node.

Select the root application node and press ENTER.

Right-click the root application node and select Open With > Mobile Application
Editor.

Displaying a Window, View, or Dialog in the Outline Editor
If you want to work on a mobile project’s main window or work on a specific view or
dialog in a mobile project, you can display information for that window, view, or dialog
in the Outline Editor. By doing so, you can concentrate on just the single item on which
you want to work rather than displaying the entire mobile project in the Outline Editor.

You can open a mobile project from the Outline Editor or the Mobile Explorer view.

To display a single window, view, or dialog in the Outline Editor

From the Outline Editor:

1. Expand the outline to locate the window, view, or dialog with which you want to
work.

Note: If you cannot locate the element (window, view, dialog) in the outline,
the Outline Editor might be displaying only a portion of the project that
does not include the element you want. In this case, use the instructions
below to display the window, view, or dialog from the Mobile Explorer
view.

2. Double-click the node for the window, view, or dialog.

From the Mobile Explorer view:

1. Expand the project and locate the window, view, or dialog with which you want
to work.

2. Either double-click the node for the window, view, or dialog or select the node
and press ENTER.

Modifying How Information is Displayed in the Outline Editor
The Outline Editor contains the Model section that displays the tree structure (or outline)
of the project and the Properties section that displays the properties for the node that is
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selected in the project’s outline. You can display the Model and Properties sections in the
following orientations:

Horizontally, one on top of the other

Vertically, side-by-side

To modify how the sections are displayed in the Outline Editor

To display the Model and Properties sections horizontally, one on top of the other,
click Change to Horizontal Layout which is shown in the toolbar of the Outline
Editor.

To display the Model and Properties sections vertically, side-by-side, click Change to
Vertical Layout which is shown in the toolbar of the Outline Editor.

Adding Objects to a Mobile Project
In the Outline Editor, you add the following types of objects to a mobile project.

User interface objects, for example:
Views and dialogs
User interface controls, such as buons, check boxes, tables, search fields, and
text entry fields

Languages that the application supports

Services that you want to use in your mobile application. For example, you might
want to add a service that you use to obtain data that your application displays.

Note: You can either add objects to a mobile project as described below or by
dragging them from the palee to the Model section of the Outline Editor
as described in “Using the Palee to Add Objects to the Mobile Project” on
page 25.

To add an object to a mobile project

1. Ensure the mobile project or specific window, view, or dialog to which you want
to add an object is open in the Outline Editor. For instructions, see “Displaying a
Mobile Project in the Outline Editor” on page 22 or “Displaying a Window,
View, or Dialog in the Outline Editor” on page 23.

2. In the Model section of the Outline Editor, expand the outline so that you view the
parent node where you want to add a child object.

3. To add a child object, right-click the parent node and select New Child > child_object,
where child_object  is the name of the child object you want to add.

The New Child list contains only objects that are valid children of the selected parent
node.
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Tip: After adding a new node, you can edit the properties for the new node.
For more information, see “Seing Properties in the Outline Editor” on
page 26.

To update the Java classes that Mobile Development generates for the project
so that your changes are represented in the generated sources, save the project
and regenerate sources. For instructions, see “Generating Sources for a Mobile
Project” on page 46.

Using the Palette to Add Objects to the Mobile Project
The palee that is available in the Outline Editor allows you to drag objects to the Model
section of the Outline Editor and thus to add objects to the mobile project. You can hide
and show the palee by clicking the arrow that is shown at the top right of the palee.

When you drag an object to the Model section, you can only drop it on a node that allows
the dragged object as a child object. The mouse pointer will indicate on which node it is
possible to drop the object.

Using the palee is especially helpful if you want to add the following objects:

Table

TableBuon

Resources

PaneConfiguration

TaskClient Services

Web Services

For these objects, a wizard appears in which you can specify the details for the new
node. All additionally required child nodes are then automatically added to the Model
section. You do not have to add them manually.

Note: For detailed information on how to use the above-mentioned service objects,
see “Adding Services to a Mobile Project” on page 61.

To add an object to a mobile project using the palette

1. Ensure the mobile project or specific window, view, or dialog to which you want
to add an object is open in the Outline Editor. For instructions, see “Displaying a
Mobile Project in the Outline Editor” on page 22 or “Displaying a Window,
View, or Dialog in the Outline Editor” on page 23.

2. In the Model section of the Outline Editor, expand the outline so that you view the
parent node where you want to add a child object.

3. Make sure that the palee is shown. If the palee is currently hidden, click the arrow
( ) that is shown at the top right of the Outline Editor to display it.
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4. Click on one of the header-type nodes in the palee (for example, Views or Controls)
to display the objects in that node. Clicking the same node once more closes the
node.

5. Drag the desired object from the palee to the parent node in the Model section
where you want to add the object as a child node. Watch the icon that is shown on
the mouse pointer. When it is possible to drop the object, the mouse pointer shows a
plus icon. For example:

Tip: After adding a new node, you can edit the properties for the new node.
For more information, see “Seing Properties in the Outline Editor” on
page 26.

To update the Java classes that Mobile Development generates for the project
so that your changes are represented in the generated sources, save the project
and regenerate sources. For instructions, see “Generating Sources for a Mobile
Project” on page 46.

Removing Objects from a Mobile Project
In the Outline Editor, you can remove objects from a mobile project.

To remove an object from a mobile project

1. Ensure the mobile project or specific window, view, or dialog from which you want
to remove an object is open in the Outline Editor. For instructions, see “Displaying
a Mobile Project in the Outline Editor” on page 22 or “Displaying a Window,
View, or Dialog in the Outline Editor” on page 23.

2. In the Model section of the Outline Editor, expand the outline so that you can view
the node you want to remove.

3. To remove a node, right-click the node and select Delete.

Alternatively, you can select the node and press the DELETE key.

Tip: To update the Java classes that Mobile Development generates for the project
so that your changes are represented in the generated sources, save the project
and regenerate sources. For instructions, see “Generating Sources for a Mobile
Project” on page 46.

Setting Properties in the Outline Editor
After you add a new node to the outline, you should set properties for the new node.
You can update the properties later if you need to change the seings.
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To set the properties for a node

1. Ensure the mobile project or specific window, view, or dialog for which you want to
work with properties is open in the Outline Editor. For instructions, see “Displaying
a Mobile Project in the Outline Editor” on page 22 or “Displaying a Window,
View, or Dialog in the Outline Editor” on page 23.

2. In the Model section of the Outline Editor, expand the outline so that you view the
node for which you want to set properties.

You can also use the following icons:  to expand all child nodes or  to collapse all
expanded child nodes. Both icons always apply to the node that is currently selected
in the editor. For example, when a Table node is currently selected, only the child
nodes of the Table will be expanded or collapsed.

3. Select the node for which you want to set properties.

4. In the Properties section of the Outline Editor, fill in the properties for the selected
node.

For more information about the properties, see “Logic to Transition to Another
View” on page 116 and “Services Object Reference” on page 223.

Note: If the Content Assist Available icon is displayed next to a field, click into
the field and press CTRL+SPACE to view the types of information you
can specify for a property. The content assist shows valid values and/
or syntax you can use to specify a valid value. If the content assist lists
@{myMethodName} or @{my.package.class.static.method}, you can specify
the name of a method to execute at run time to supply the value for the
property. For more information, see “Logic to Programmatically Set a
Property Value at Run Time” on page 115.

Tip: To update the Java classes that Mobile Development generates for the project
so that your changes are represented in the generated sources, save the project
and regenerate sources. For instructions, see “Generating Sources for a Mobile
Project” on page 46.

Using Mobile Designer Ant Targets
Mobile Designer provides several Ant targets that you can use to test and build your
mobile project.

For more information about the Ant targets that are available and the actions the Ant
targets perform, see Using webMethods Mobile Designer.

To run an Ant target for a mobile project

1. In the Project Explorer, locate the project for which you want to execute an Ant
target.
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2. Expand the project and drag its build.xml file to the Ant view.

3. In the Ant view, double-click the Ant target that you want to run.

Mobile Development Preferences
You can set preferences for Mobile Development.

To set the Mobile Development preferences

1. In Software AG Designer, select Window > Preferences. If you are working with Mac
OS, select Software AG Designer > Preferences instead.

2. In the Preferences dialog box, expand the Software AG node.

3. Select Mobile Development, and set the following options, if required:

Option Description

Mobile
Designer

The path to the Mobile Designer installation directory. It is
recommended that you check this path after the installation
to make sure that Mobile Development uses the correct
Mobile Designer installation directory. By default, this path
is relative to the Software AG Designer installation directory.
If a path is not defined, it is not possible to use Mobile
Designer to build or simulate apps. In addition, creating new
projects will fail. Click Browse if you want to select a different
installation directory.

Mobile Support
Client

The path to the Mobile Support Client installation
directory. Set this path if you want to enable offline data
synchronization with Mobile Support Client. Click Browse
to select the installation directory. See also “Adding the
SyncComponent Object” on page 65.

Important: If you set this option, you must regenerate the source
code for the desired mobile project and you also must
reactivate the handset.

Package Name The Java package name which will be used as the default
value when creating new mobile projects. See also “Creating
a New Mobile Project” on page 34.

Ant Target
Name

Select the Mobile Designer Ant target that should be
executed after each run of the code generation.

4. Click OK to save your changes and to close the Preferences dialog box.
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5. To specify a Jenkins build server, select Mobile Development > Jenkins Build Servers and
do the following:

a. Click the plus icon in the upper right corner to add a new server connection.

b. In the Add Jenkins Server dialog, enter the host name or IP of the Jenkins server
in the Host Name or IP field, your Jenkins server user name in the User Name field,
and your Jenkins server password in the Password field. Click OK to close the
dialog.

c. To modify an existing Jenkins server connection, right-click the connection and
select Edit from the context menu. Modify the connection in the Add Jenkins
Server dialog and click OK.

d. To remove an existing Jenkins server connection, right-click the connection and
select Remove from the context menu.

e. To refresh an existing Jenkins server connection, right-click the connection and
select Refresh from the context menu.

f. Click Apply and Close to save the specification and to close the dialog.
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3   Mobile Development Process Overview

Mobile Development is a process that involves the following basic stages:

Stage 1 Create a mobile project, and define and configure
resources for it.

For more information, see “Creating a Mobile Project”
on page 33.

Or

Import and migrate mobile projects that were built
with an older version.

For more information, see “Migrating Mobile Projects”
on page 53.

Or

Import and use a sample project.

For more information, see “Using Sample Projects” on
page 57.

Stage 2 (optional) Add services to your mobile project.

For more information, see “Adding Services to a
Mobile Project” on page 61.

Stage 3 (optional) Add a data model to your mobile project.

For more information, see “Adding a Data Model to a
Mobile Project” on page 71.

Stage 4 Build the user interface for your mobile application.

For more information, see “Building the User Interface
for a Mobile Application” on page 75.

Stage 5 Add business logic to your mobile application.

For more information, see “Creating Business Logic for
a Mobile Application” on page 109.

Stage 6 Test, build, and install your mobile application.
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For more information, see “Testing, Building, and
Installing a Mobile Application” on page 125.

Stage 8 (optional) Manage your mobile projects and applications:
Rename the mobile project or application, or rename
the package name for the mobile project.

For more information, see “Managing Mobile
Applications and Projects” on page 137.
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4   Creating a Mobile Project
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Creating a New Mobile Project
Mobile Development provides the New Mobile Development Project wizard that
you can use to create a new mobile project. When you create a mobile project, Mobile
Development automatically adds the following to your mobile project:

Adds your system language as a language that your application supports. You can
add additional languages and/or remove languages after the project is created. For
more information, see “Configuring Supported Languages” on page 43.

Adds several universal devices that your application supports. You can add
additional devices and/or remove devices after the project is created.

To create a new mobile project

1. Open the New Mobile Development Project wizard by selecting one of the following:

File > New > Mobile Project

File > New > Project > Software AG > Mobile Project

2. Specify the following seings for the mobile project:

a. In the Project Name field, type a name for the new project.

The name that you type will automatically be used as the default value in the
Application Name field and as a prefix in the Package Name field.

b. Optional. If you want to use an application name other than the default value,
type the name in the Application Name field.

Mobile Development uses the application name internally, for example, as part
of the name of the application_name AppControllerImpl.java Java class that it creates.

Note: You can rename the application at a later time. However, if you
have added custom code to application_name AppControllerImpl.java, you
must take further action. For more information, see “Renaming the
Application” on page 138.

c. Optional. If you want to use a package name other than the default value, type
the name in the Package Name field. When specifying the name, be sure to only
use characters that are valid in a Java package name.

The default value for the package name is defined in the Mobile Development
preferences. If you want to modify the default value, you can simply click
the Configure the default Package Name link. For more information, see “Mobile
Development Preferences” on page 28.

Mobile Development uses the supplied name as part of the package names
for the Java classes in the gen/src and src folders of your project. For example,
if you specify com.mycompany.myproject, the gen/src folder contains the
com.mycompany.myproject package.
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d. Indicate where you want to save the project:

To use the default location, select the Use default location check box.

To specify an alternate location, clear the Use the default location check box,
click Browse, and browse to and select the location where you want to save
the project.

e. Click Next.

3. Select the application template that you want to use. The application template
helps to speed up development because default configurations that are ready for
customization will be generated. The following templates are provided for selection
(see the template descriptions in the wizard for more detailed information):

Single pane (default)

Single pane with navigation bar

Two panes for tablets

Two panes and navigation bar for tablets

4. Click Finish.

Defining Resources for a Mobile Project
Each project requires its own resource handler. The resource handler defines all
resources to be included into your mobile application, such as icons and texts. Mobile
Development provides the UniversalResHandler implementation so that you do not need
to code your own. For more information about how to use the UniversalResHandler, see
“Using the UniversalResHandler” on page 35.

The UniversalResHandler is responsible for providing resources to the resulting native
application as well as to the Phoney run time, such as:

Graphical assets. For more information, see “Adding Graphical Assets” on
page 36.

Static web resources. For more information, see “Adding Static Web Resources” on
page 42.

Text resources. For more information, see “Configuring Supported Languages” on
page 43.

Using the UniversalResHandler
You can use the UniversalResHandler resource handler that Mobile Development provides.

Note: While writing your own resource handler is going to be deprecated, you can
still code your own implementation and make the project to take use of it.
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To run the resource handler

1. Do one of the following:

a. Execute the +Run-Reshandler ANT target.

b. Execute the ++Reactivate-Handset ANT target.

c. Do a multi-build.

2. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

3. Select the top-level child node of the project, which is the root application node.

4. Modify the Res Handler property in the Properties section of the Outline Editor. Enter
the fully-qualified name of your implementation, and add the custom resource
handler implementation to the your_project /reshandler directory.

Adding Graphical Assets
Mobile applications often use a large number of icons to customize and emphasize the
user interface. Icons have to be provided in different sizes in order to support multiple
screen resolutions. With Mobile Development, you do not need to take care of different
icon sizes for every screen resolution: You only need to define one asset file. The asset
defines how an icon looks like, and Mobile Development creates different sizes based
from this asset definition.

Mobile Development also supports a graphical way to configure your app icons
(the icon displayed when an application starts) and launch screens (the first screen
displayed). For more information, see “Importing Images for App Icons and Launch
Screens” on page 41.

To create and define a new asset

1. Locate your mobile project in the Package Explorer. Right-click the project node in
the Package Explorer, then select  Mobile > Create new Asset > Mobile Tools > Create Asset.

After the new asset was created, the Asset Editor is opened, and you can start to
define your asset. The Asset Editor allows you to define an asset in three different
ways. You can either:

Select and customize a library icon. For more information, see “Customizing a
Library Icon” on page 37.

Define an asset based on a Scalable Vector Graphic (SVG). For more information,
see “Creating a Scalable Vector Graphic” on page 38.

Create an asset set by importing single PNG icons. For more information, see
“Importing Icons” on page 40.

2. To save the asset, specify a unique, lowercase file name. After saving, the asset file
can be located in the your_project /model/resources directory.



M
Odd Header

Creating a Mobile Project

webMethods Mobile Development Help Version 10.3 37

3. To open an existing asset, locate the asset file you want to open.

4. Open the Asset Editor by double-clicking the asset file, or right-click the asset file,
select Open > Open With, and select Asset Editor.

Customizing a Library Icon
Mobile Development includes an icon library, containing hundreds of icons, which you
can customize and use in your application.

To customize a library icon

1. Do one of the following:

a. Open the Asset Editor by double-clicking an existing asset file, or right-click an
existing asset file, select Open > Open With, and select Asset Editor.

b. Create a new asset file as described in “Adding Graphical Assets” on page 36.

2. In the Asset Editor, on the Customize a library icon page, modify the information as
required:

For this field, button, or tab You can do this

Asset Name Enter or modify a name for the asset.

Source > Search for a
category or icon name

Do a keyword search for an icon name.

Or

Press CTRL + SPACE to select a category from the
list of categories.

Source > Displayed icons Select an icon. The selected icon is shown in the
Preview at the right side of the editor.

Source Click  to copy the source of the selected library
icon to the clipboard.

Or

Click  to proceed to the Create a Vector
Graphic page of the Asset Editor and compose
a vector graphic of the library icon as described
in “Creating a Scalable Vector Graphic” on
page 38.

Properties > Stroke Color Click the field, enter a Hex color code, or select
a color from the list of colors defined in the
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For this field, button, or tab You can do this
application model to specify a stroke color for the
icon.

Or

Click . In the color picker, select a color from
the Delite (Software AG) or Material (Android)
color palee.

Properties > Fill Color Click the field, enter a Hex color code, or select
a color from the list of colors defined in the
application model to specify a fill color for the
icon.

Or

Click . In the color picker, select a color from
the Delite (Software AG) or Material (Android)
color palee.

Properties > Background
Shape

Click RECT or CIRCLE to select a rectangle or a
circle background decoration.

Asset Size Specify a size and padding for the asset for
Android or iOS devices.

Or

Select one of the predefined asset sizes Small Icon,
24 dp, 48 dp, Tab Icon, or Navbutton Icon.

3. Click CTRL + S to save the asset.

When saving the asset, Mobile Development automatically creates icons for every
screen resolution. Those icons are located within the your_project /gen/.assets/graphics
directory. Make sure to commit this directory when working with a source code
management system.

Creating a Scalable Vector Graphic
You can define an asset that is based on a Scalable Vector Graphic (SVG).

Tip: You can open the SVG-document of a library icon. To do so, select a library
icon on the Customize a library icon page of the Asset Editor, and click  on
the Source tab of this page.
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To create an SVG asset

1. Do one of the following:

a. Open the Asset Editor by double-clicking an existing asset file, or right-click an
existing asset file, select Open > Open With, and select Asset Editor.

b. Create a new asset file as described in “Adding Graphical Assets” on page 36.

2. In the Asset Editor, click Create Icon in the upper right corner.

3. On the Create a Vector Graphic page, modify the information as required:

For this field, button, or tab You can do this

Asset Name Enter or modify a name for the asset.

Source > Width and Height By default, the asset is exported with a dimension
of 24 x 24 dp. You can scale it to a different size
by modifying the width and height value or by
selecting a different asset size in Asset Size.

Source > Path Specify the path definitions for the SVG asset. You
can also load and modify an example by clicking
Try an example? Click here. For more information
on path definitions, see “hps://www.w3.org/TR/
SVG/”.

Source Click  to load an SVG asset that is stored on
your machine.

Properties > Name Enter a name for the path, group, etc. of your SVG
asset.

Properties > Path Data Modify the path data.

Properties > Stroke Color Click the field, enter a Hex color code, or select
a color from the list of colors defined in the
application model to specify a stroke color for the
graphic.

Or

Click . In the color picker, select a color from
the Delite (Software AG) or Material (Android)
color palee.

https://www.w3.org/TR/SVG/
https://www.w3.org/TR/SVG/
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For this field, button, or tab You can do this

Properties > Fill Color Click the field, enter a Hex color code, or select
a color from the list of colors defined in the
application model to specify a fill color for the
graphic.

Or

Click . In the color picker, select a color from
the Delite (Software AG) or Material (Android)
color palee.

Properties > Opacity Modify the opacity of the graphic.

Properties > Scale To,
Translate To, Shear To

Modify the vector definitions as described in
“hps://www.w3.org/TR/SVG/”.

Asset Size Select one of the predefined asset sizes Small Icon,
24 dp, 48 dp, Tab Icon, or Navbutton Icon.

4. Click CTRL + S to save the asset.

When saving the asset, Mobile Development automatically creates icons for every
screen resolution. Those icons are located within the your_project /gen/.assets/graphics
directory. Make sure to commit this directory when working with a source code
management system.

Importing Icons
You can create an asset set by importing single PNG icons.

To import single PNG icons

1. Do one of the following:

a. Open the Asset Editor by double-clicking an existing asset file, or right-click an
existing asset file, select Open > Open With, and select Asset Editor.

b. Create a new asset file as described in “Adding Graphical Assets” on page 36.

2. In the Asset Editor, click Import Icon in the upper right corner.

3. Drag and drop a single icon into the dedicated placeholder. Ensure that the icon you
dropped matches the required icon size, as this import approach uses no scaling.

4. Click CTRL + S to save the asset.

When saving the asset, Mobile Development copies the imported icons into your mobile
project and renames them accordingly. Those icons are located within the your_project /

https://www.w3.org/TR/SVG/
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gen/.assets/graphics directory. Make sure to commit this directory when working with a
source code management system.

Importing Images for App Icons and Launch Screens
You can import PNG images to be used as application icons (icons displayed when an
application starts) and launch screens (first screen of an application).

To import app icons and launch screens

1. Do one of the following:

a. Display your mobile project in the Outline Editor. Select Click to open the App Icon
Editor from the top right toolbar of the editor.

b. Locate your mobile project in the Package Explorer. Right-click the project node
in the Package Explorer, then select  Configure App Icons.

The App Icon Editor shows placeholders for your application icons and launch
screens, sorted by platform, and thus gives a visual overview about them. It also lists
the size required for each individual image.

2. Do one of the following:

a. Drag and drop a single image into the dedicated placeholder. Ensure that the
image you dropped matches the required image size, as this import approach
uses no scaling.

b. Import a single, high-resolution PNG image to let the editor fill all the image
placeholders with a scaled-down version of the imported image. For this, select
Import a single high-res icon from the top right toolbar of the editor. A wizard
opens where you can drag and drop an image from your local file system. After
dropping this image, you can preview how the image is scaled down into a
variety of sizes at the right pane of the wizard. If you are satisfied with the
resulting quality, click Finish. Optionally, you can select if this image should be
used for every or for a particular platform.

3. Click CTRL + S to save the editor.

When saving the editor, Mobile Development copies the imported images into your
mobile project and renames them accordingly. Those images are located within the
your_project /gen/.assets/graphics directory. Make sure to commit this directory when
working with a source code management system.

Using Graphical Assets

Configuring an Image Element to Use an Asset

When working with the Outline Editor, you can specify the name for an asset within the
properties section of the Outline Editor for the following elements:

Image: Image property,

Tab: Image property,
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Navbuon: Icon property.

The entered value must be the file name of an asset including the .asset file extension.

Loading an Asset at Run Time

An asset can be loaded at run time using the
com.softwareag.mobile.runtime.toolkit.AbstractApplicationController.loadImage(String) method. Make
sure to pass the file name including the .asset file extension. This method returns an
instance of javax.microedition.lcdui.Image. By loading an asset, the run time implementation
returns the corresponding asset for the target screen density, so that you do not need to
scale the image at run time. For detailed information, refer to Using webMethods Mobile
Designer.

Adding Static Web Resources
You can add static web resources, such as HTML, JS, CSS files to your mobile project.
The UniversalResHandler is responsible for copying those files to the resulting native
project or to the Phoney run time. Therefore, all static web resources must be copied
to your_project /resources/www. The files can be accessed at run time after running the
resource handler. For detailed information, see “Using the UniversalResHandler” on
page 35.

You can access every file at run time using the following code snippet:
<Java>
final String content = 
AbstractApplicationController.getInstance().loadWWWResource("yourFile");
</Java>

For example, you can store a HTML file and load its content at run time.
Afterwards, you can pass the file's content to a WebView object using the method
nUIWebView#setHTMLText(String).

Using Custom Android Resources
The Android platform build has been extended to take custom resources into account, as
this is a common source for native code injections. During the Android build, resources
will be copied into the your_project /res directory and thus must follow Android's
resources guidelines. To include custom Android resources (e.g., specific drawables,
colors.xml), you must use the property android.project.build.resources.drawables in targets/
_defaults_.xml, e.g:
<property name="android.project.build.resources.drawables" 
value="native/graphics/android" />

Resources will be copied into the Android project using the following order:

Copy default files provided by Mobile Designer.

Copy (and override existing) resources generated by Mobile Development (i.e., when
using styles, themes).
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Copy (and override existing) resources from ${android.project.build.resources.drawables}.

Configuring the Orientations Setting for the Application
An application’s orientation seing indicates whether the user interface for the
application displays in portrait mode, landscape mode, or rotates from portrait mode to
landscape or vice versa as the user rotates the device.

To configure the orientation setting for a mobile application

1. Ensure the mobile project is displayed in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the project so that you can view
the top-level child node that represents the root application for the project.

3. Select the root application node.

4. In the Properties section of the screen, select the orientation you want to use in the
Orientation property.

Select PerHandset if you want to set the orientation seings for each device a project
supports rather than use a single global orientation seing for all devices. When
you use PerHandset, the orientation seing for a device is made in the XML file for
the device in the project’s targets folder. In this case, you are responsible for seing
the correct orientation property for each device. For more information about project
properties, see Using webMethods Mobile Designer.

Tip: To update the Java classes that Mobile Development generates for the project
so that your changes are represented in the generated sources, save the project
and regenerate sources. For instructions, see “Generating Sources for a Mobile
Project” on page 46.

Configuring Supported Languages
When you create your project, Mobile Development adds your system language to
your mobile project as a language your application supports. If needed, you can add or
remove languages your application supports.

Note: If you want to change the default language, see “Seing the Default Language
for the Project” on page 44.

To add or remove languages that your application supports

1. Ensure the mobile project for which you want to manage languages is open in the
Outline Editor. For instructions, see “Displaying a Mobile Project in the Outline
Editor” on page 22.
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2. In the Model section of the Outline Editor, expand your mobile project’s Languages
container node.

3. To add a language, do the following:

a. Right-click the Languages container node, and select New Child > Language.

b. Select the Language node you just added.

c. In the Properties section of the Outline Editor, specify the following properties:

For this property Specify

Directionality Direction to use for the language. Select one of the
following:

L2R for left-to-right

R2L for right-to-left

Short Name Abbreviation for the language, for example, “en”. Use
the two-character language code defined by the ISO-639
standard.

4. To remove a language, in the Model section of the Outline Editor, right-click the
language you want to remove and select Delete.

Alternatively, you can select the language and press the DELETE key.

Tip: To update the information that Mobile Development generates for the project
so that your changes are represented in the generated text resources, save the
project and regenerate sources. For instructions, see “Generating Sources for a
Mobile Project” on page 46.

Setting the Default Language for the Project
Mobile Development can create localized mobile applications. You designate one
language that your project supports as the default. Your application uses the default
language when no specific language is selected.

When you generate sources for a mobile project, Mobile Development generates text
resource files for the text fields in the mobile project. Although Mobile Development
maintains a text resource file for each language in the mobile project, it only includes
text values in the text resource file for the default language. For more information, see
“Text Resources that Mobile Development Creates for a Mobile Project” on page 51.
For information about working with languages that are not the default, see “Specifying
Values for Non-Default Language Text Resources” on page 45.

Note: When you switch the default language to another language and then
generate sources for the project, Mobile Development does not clear or
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update values in the text resource file of the former default language. Mobile
Developmentonly updates and/or adds values to the text resource file
associated with the default language.

To set the default language for the project

1. Ensure the mobile project is displayed in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the project so that you can view
the top-level child node that represents the root application for the project.

3. Select the root application node.

4. In the Properties section of the screen, select the language you want to use from the
list in the Default Language property.

This list is populated with all the languages that your application supports. In other
words, languages you have added to the Languages container node in the model.

Tip: To update the information that Mobile Development generates for the project
so that your changes are represented in the generated text resources, save the
project and regenerate sources. For instructions, see “Generating Sources for a
Mobile Project” on page 46.

Specifying Values for Non-Default Language Text Resources
When generating text resource files for a mobile project, Mobile Development only
includes the values for the text strings in the text resource file that is associated with the
default language. It is your responsibility to translate the values for other languages and
specify the values in the text resource files for those languages. For more information
about the text resource files, see “Text Resources that Mobile Development Creates for a
Mobile Project” on page 51.

To specify values for non-default language text resources

1. Locate the project in the Package Explorer.

2. Expand the project to locate the resources/text folder.

3. Expand the text folder.

4. Open a core.language_code .txt file for a non-default language, where language_code
is the language code you specified for the Short Name property when you added the
language to the mobile project.

Tip: You might find it helpful to also open the core.language_code .txt file for the
default language so that you can see the values you need to translate.

5. For each line in the file, fill in the translated value for each text field.
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Caution: Do not edit values for the default language in this manner because
when you save the mobile project, Mobile Development regenerates the
core.language_code .txt file for the default languages, and your changes
will be lost. To change values for the default language, edit the associated
values in the Outline Editor.

6. Save the file.

Repeat this procedure for each non-default language that the mobile project supports.

Compiling Resources
Use the +Run-Reshandler Ant target to compile the resources for the current device.

You should compile resources for a device:

After you change or add language resources, such as text or header text.

After you change or add graphical assets.

After you add parameters to the _defaults_.xml file.

Note: Alternatively, you can use the ++Activate-Handset Ant target, which allows you
to select the device that you want to activate. For information about using the
++Activate-Handset Ant target, see Using webMethods Mobile Designer.

To compile resources for a device

1. In the Project Explorer view, expand the mobile project, and drag the build.xml file to
the Ant view.

2. In the Ant view, double-click Run-Reshandler.

The Ant target compiles the resources for the current device.

Generating Sources for a Mobile Project
To incorporate the changes you make to the mobile project’s model, you must generate
the sources. When you generate sources, Mobile Development generates Java classes for
the mobile application. For a description of the Java classes that Mobile Development
generates, see “Java Sources that Mobile Development Generates” on page 47.

You should generate sources after you update a project, for example, by adding
additional user interface objects to the project. You can generate sources from the
Outline Editor or the Package Explorer.

The generated Java classes contain the current content of the Outline Editor. That is, they
contain any changes that have not been saved yet.
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Note: Mobile Development also creates .txt files for each language that the mobile
project supports. For more information, see “Text Resources that Mobile
Development Creates for a Mobile Project” on page 51.

To generate sources

From the Outline Editor:

1. Display your project in the Outline Editor. For more information, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Outline Editor, right-click anywhere and select Generate Source Code >
Application Model.

From the Package Explorer:

1. Locate the project in the Package Explorer.

2. Right-click the project node or any file in the project and select Generate Source
Code > Application Model.

Note: Selecting Generate Source Code > Application Model generates the source code for
the mobile project based on the model you define in the Outline Editor. If you
select Generate Source Code > Application Model and API, Mobile Development
also generates the Mobile Development API in the gen/api-src folder.

Java Sources that Mobile Development Generates
When you generate sources for your mobile project using Generate Source Code >
Application Model in the Outline Editor, Mobile Development generates Java classes in the
following folders:

gen/src folder contains Java classes that are specific to your mobile project and are
based on the model you develop in the Outline Editor.

All the Java in the gen/src folder is generated. Mobile Development regenerates the
Java classes in this folder each time you generate sources for your mobile project. As
a result, the Java classes reflect the changes you make to your model, for example, if
you add or remove user interface objects.

src folder, also known as the user space, contains Java classes that you update to
provide the business logic for your application.

Mobile Development generates each Java class in the src folder only one time. If
the class already exists when you generate sources, Mobile Development does not
override it. Additionally, to preserve logic you might have added to generated logic,
Mobile Development also does not delete the Java classes, for example, if you rename
or delete a corresponding item in the model. You must delete unneeded Java classes
manually for the project to compile.

Note: If you use Generate Source Code > Application Model and API, Mobile
Development also creates Java classes in the gen/api-src folder. The names of
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the Java packages in this folder start with com.software.mobile.runtime.toolkit. These
packages contain Java classes for the Mobile Development API.

Caution: Do not make changes to the Java classes in the gen/src or gen/api-src folders.
These folders contain classes that Mobile Development automatically
generates, and changes you make will be lost.

Model-Specific Java Code in the gen/src Folder

When you generate sources for your mobile project, Mobile Development generates the
following packages based on the model that you defined in the Outline Editor. In the
names of the following packages, package_name  is the package name that you specified
for your mobile project.

Package name in the gen/src folder Description

package_name This package contains general model-based
Java classes.

package_name .i18n This package contains Java classes for
language support to load languages that
you indicated your mobile application
supports. You specify languages your
application supports by adding the languages
to the model. For more information, see
“Configuring Supported Languages” on
page 43.

package_name .services.rest This package contains Java classes that
correspond to the services that you add to
your mobile project in the Outline Editor. For
more information, see “Adding Services to a
Mobile Project” on page 61.

package_name .ui This package contains Java classes that
correspond to the user interface that you
designed in the Outline Editor. This includes
Java classes for each view in your user
interface along with its associated abstract
controller.

package_name .ui.dialog This package contains Java classes that
correspond to the dialogs that you designed
in the Outline Editor.
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Package name in the gen/src folder Description

package_name  ui.styles This package contains Java classes
corresponding to the definition of every Style
in the application model.

package_name .ui.templates This package contains Java classes that
correspond to the templates you defined
in the Outline Editor, if any. For more
information about using templates, see
“Using Templates to Define Custom Objects
for a Mobile Project” on page 100.

package_name .utils This package contains a helper class that
provides services, such as, determining
whether the application is running on a tablet
or the orientation of the device, whether
portrait or landscape.

Model-Specific Java Code in the src Folder

When you generate sources for your project, Mobile Development generates the
following packages based on the model that you defined in the Outline Editor. In the
names of the following packages, package_name  is the package name that you specified
for your mobile project.

Package name in the src folder Description

package_name  data.comparator This package contains Java classes corresponding
to the datasource comparators in the
application model. Those classes inherit from
com.softwareag.mobile.runtime.toolkit.delegates.IComparator
and must be implemented by the developer.

The comparator name can be used multiple times
within the application model, but will result in a
single Java class, named by the comparator name.

package_name  data.transformer This package contains Java classes
corresponding to the data transformers in the
application model. Those classes inherit from
com.softwareag.mobile.runtime.toolkit.delegates.IDataTransformer
and must be implemented by the developer.

The transformer name can be used multiple times
within the application model, but will result in a
single Java class, named by the transformer name.
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Package name in the src folder Description

package_name .ui.controller.impl This package contains Java classes that correspond
to the user interface that you designed in the Outline
Editor. Mobile Development generates the classes a
single time. You add your application logic to these
Java classes. The Java classes in this package are:

application_name AppControllerImpl.java

In the name of the Java class, application_name
is the name you assigned to the application.
Mobile Development generates one
application_name AppControllerImpl.java class for your
mobile project.

Add the logic to this Java class that you want the
application to execute when the application starts
and when the user rotates the device, changing its
orientation. This is also a good location for code that
is not related to a specific view.

view_name ControllerImpl.java

In the name of the Java class, view_name  is the
name of a view you defined in the Outline
Editor. Mobile Development generates one
view_name ControllerImpl.java class for each view in
your model.

Add logic specific to a view to this Java class.
You can add custom code here that extends the
generated abstract view controller methods
that Mobile Development generates in the
Abstractview_name Controller.java files, which reside in
the gen/src folder in the package_name .ui package.

For more information about the types of logic to add
these Java classes, see “About Adding Application
Logic” on page 110.

package_name .ui.dialog This package contains Java classes that correspond to
the dialogs that you added to the user interface in the
Outline Editor. Mobile Development generates the
classes a single time.

For each dialog you define in the Outline Editor,
Mobile Development generates a dialog_name .java
class, where dialog_name  is the name you assigned to
the dialog in the Outline Editor.
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Package name in the src folder Description

Mobile Development generates the Java classes for
dialogs a single time. You add logic to customize the
user interface object to the generated Java classes.

package_name  ui.styles For each style you define in the Outline Editor,
Mobile Development generates a style_name .java
class, where style_name  is the name of the style.
Mobile Development generates the Java classes for
styles a single time. You override common methods
to change the style.

package_name .ui.templates This package contains Java classes that correspond
to the templates you defined in the Outline Editor.
You use templates to customize user interface
objects that Mobile Development provides. For more
information, see “Using Templates to Define Custom
Objects for a Mobile Project” on page 100.

For each template you define in the Outline Editor,
Mobile Development generates a template_name .java
class, where template_name  is the name you assigned
to the template in the Outline Editor.

Mobile Development generates the Java classes
for templates a single time. You can add your
logic for the dialogs to these Java classes. For more
information, see “Creating a Template for a Custom
Object” on page 100.

Text Resources that Mobile Development Creates for a Mobile
Project
In addition to generated Java sources, Mobile Development generates .txt files for each
language that the mobile project supports.

When you create the project using the New Mobile Development Project wizard, as
described in “Creating a New Mobile Project” on page 34, Mobile Development
generates .txt files in the project’s resources/text folder. Mobile Development updates
the .txt files each time you save the project. Mobile Development generates one .txt file
for each language that the mobile project supports. The following shows the naming
convention for the .txt files:

core.language_code .txt

The language_code  in the file name corresponds to the language code you specified for
the Short Name property when you added the language to the mobile project.
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Each core.language_code .txt file contains lines for the text strings that you use in a mobile
project’s view. For example, the file contains a line for the view’s Header Text property.
If you add a Textfield object to a view, the file contains a line for the Textfield object ‘s Text
property.

Note: Mobile Development only creates text resource entries for properties that
take a text string for a value when you provide a value for the property.
Additionally, you must name the element to which the property belongs. You
name a property using the element’s Name property. If you specify a value for
a property, but do not name the element, Mobile Development generates the
plain String value instead of creating a reference to the text resource.

When generating the core.language_code .txt files, Mobile Development only includes the
values in the .txt file that is associated with the project’s default language. For example,
if the default language uses the language code “en”, the core.en.txt file might have the
following line:
MASTERVIEW_HEADER_TEXT=Master View

If a mobile project also includes a language with the language code “de”, but “de” is not
the default language, the corresponding line in the core.de.txt file is:
MASTERVIEW_HEADER_TEXT=

It is your responsibility to provide the appropriate translations for the strings for the
core.language_code .txt files of the languages that are not the default language.
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Importing Mobile Projects
You can use mobile projects that were built with an older version. To migrate these
mobile projects, you must first import them into your workspace.

To import existing mobile projects

1. Select Import file from the main menu of Software AG Designer.

2. Select General > Existing Projects into Workspace in the upcoming dialog.

3. Click Next.

4. Select the root directory of your mobile project and click Finish.

After your mobile project was imported, you must generate the source code of your
application.

5. Open your mobile project in the Outline Editor as described in “Displaying a Mobile
Project in the Outline Editor” on page 22.

6. Check for warnings and errors for the application model and fix them.

7. In the Package Explorer, right-click the mobile project root node and select Generate
Source Code-> Application Model and API.

You can now work with the mobile project.

Tip: You can manually adapt ListView and Entry objects that were built with a
previous version to use a newer structure. To do so, open the mobile project
in the Outline Editor. Right-click ListView and select Migrate from the context
menu. Or right-click Entry and select Migrate to Floating Entry.

Solving Compile Issues
After generating the source code, your application may show compile issues because
of necessary API migration in Mobile Development. To solve them, locate the issues in
your Java files and replace them as follows:

For this issue... Use this replacement...

boolean AbstractViewController#setVisible(nUIObject,
boolean)

void nUIObject#setVisible(boolean)

boolean AbstractViewController#isVisible(nUIObject) boolean nUIObject#isVisible()

boolean AbstractViewController#forceHide(nUIObject) void nUIObject#setVisible(boolean)
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For this issue... Use this replacement...

void onAlertDialogButtonPressed(final AbstractAlertDialog
dialog, final int buttonId)

void onDialogButtonPressed(final
AbstractDialog dialog, final int
buttonId)

package name for AbstractAlertDialog:
com.softwareag.mobile.runtime.toolkit.ui

com.softwareag.mobile.runtime.toolkit.ui.dialog

Migrating App Icons and Launch Screens
From version 10.1, Mobile Development features the App Icon Editor. Here, you can
configure your app icons and launch screens. When migrating a mobile project that
was built with a version prior to 10.1, you can import app icons and launch screens as
described in “Importing Images for App Icons and Launch Screens” on page 41. Then,
locate the old app icons and launch images in the your_project /gen/.assets/graphics
directory and delete them.

Migrating Other Icons
From version 10.1, Mobile Development features the Asset Editor. Here, you can define
one asset file. The asset defines how an icon looks like, and Mobile Development
creates different sizes based from this asset definition. When migrating a mobile project
that was built with a version prior to 10.1, you can define asset files as described in
“Defining Resources for a Mobile Project” on page 35. Then, locate your old icons in the
your_project /gen/.assets/graphics directory and delete them.
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Importing Sample Projects from Mobile Designer
Mobile Designer includes a couple of sample projects. Every sample describes how to
use a dedicated feature. The Mobile Designer samples are located within the Samples
directory in your Mobile Designer installation.

To import a sample project from Mobile Designer

1. Open the import wizard by selecting File > Import > General > Existing Projects into
Workspace.

2. Select the Select root directory option and click Browse.

3. In the upcoming dialog, select the Mobile Designer installation and locate the
Samples directory.

4. Click Open.

5. Select the projects you want to import into your workspace.

6. Click Finish.

Note: Before running Phoney or doing a multi-build, make sure to activate a
handset first. These samples are not using the Mobile Development runtime
API and tooling.

Using the Cocktail App Example
The Cocktail App can be used as a reference or starting point when building a new mobile
project. It demonstrates how to build complex application logic and uses modern UI
concepts without the need of user space code. This example shows how to:

build a TabView,

build a SideView,

use a RESTful service to populate a ListView,

create entities from a JSON service response,

provide graphical assets, and

use styles and color definitions.

To import the Cocktail App

1. Open the import wizard by selecting File > New > Example > Software AG Mobile Solutions
> The Cocktail App.

2. Click Finish.
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Using the City 311 Example
The City 311 Demo App shows how a mobile application that communicates with an
Adabas/Natural application can be used to provide 311 services. 311 is a non-emergency
phone number that citizens can call in many communities in the US and Canada
and that provides access to municipal services. In this sample project, webMethods
Integration Server and EntireX are used as middleware, and webMethods Mobile Suite
is used to provide the necessary mobile capabilities of mobile enterprise application
platforms for application development and deployment.

To import the City 311 Demo App

1. Open the import wizard by selecting File > New > Example > Software AG Mobile Solutions
> City 311 Demo App.

2. Click Finish.



M
Even Header

webMethods Mobile Development Help Version 10.3 60



M
Odd Header

Adding Services to a Mobile Project

webMethods Mobile Development Help Version 10.3 61

7   Adding Services to a Mobile Project

■   Adding RESTful Services .............................................................................................................    62

■   Adding RESTful IS Services ........................................................................................................     63

■   Adding Virtual Services ................................................................................................................     64

■   Adding the SyncComponent Object .............................................................................................    65

■   Adding Task Client Services ........................................................................................................     66

■   Adding ARIS Services ..................................................................................................................    67

■   Adding Web Services ...................................................................................................................    67



M
Even Header

Adding Services to a Mobile Project

webMethods Mobile Development Help Version 10.3 62

Adding RESTful Services
You can use RESTful services as data sources for a mobile application. An application
can execute RESTful services to obtain data to display in the application’s user interface.
Because RESTful services typically return multiple data elements, it is common to
use a ListView object to display the data you obtain from a RESTful service. For more
information, see “Using a Content Provider to Populate a ListView” on page 87.

To add RESTful services

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the project so that you view the
Services container node.

If the model does not have a Services container node, add one by right-clicking the
root application and selecting New Child > Services.

3. Right-click the Services node and select New Child > Resources.

Note: You can also drag the Resources object from the palee of the Outline
Editor to the Services node. In the palee, you can find this object
when clicking the header-type node RESTful Services. In this case, a
wizard appears in which you can specify the details for the new node.
All additionally required child nodes as described below are then
automatically added to the Model section. You do not have to add them
manually. For more information, see “Using the Palee to Add Objects to
the Mobile Project” on page 25.

4. Select the Resources node, and in the Properties section of the Outline Editor set the
properties for the Resources node. For more information, see “Resources Properties”
on page 224.

5. Right-click the Resources node and select New Child > Resource.

6. Select the Resource node, and in the Properties section of the Outline Editor set the
properties for the Resource node. For more information, see “Resource Properties” on
page 225.

7. Right-click the Resource node and select one of the following:

New Child > Method to specify the service you want to use. The mobile application
queries the RESTful service by calling the method you specify.

New Child > Resource if you want to add additional Resource objects to specify
subpaths. If you add another Resource node, repeat the previous step to specify
the properties for the Resource node and this step to add a child node.
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8. When you add a Method child node, select the node, and in the Properties section of
the Outline Editor set the properties for the Method node. For more information, see
“Method Properties” on page 225.

Note: Mobile Development automatically adds two child nodes for the Method
node. The child nodes are Request and Response.

9. Select the Request node, and in the Properties section of the Outline Editor set the
properties for the Request node. For more information, see “Request Properties” on
page 226.

10. If the RESTful service requires input parameters, perform the following steps for
each input parameter:

a. Right-click the Request node and select New Child > Parameter.

b. Select the Parameter node, and in the Properties section of the Outline Editor set
the properties for the Parameter node. For more information, see “Parameter
Properties” on page 226.

11. Select the Response node, and in the Properties section of the Outline Editor set the
properties for the Response node. For more information, see “Response Properties”
on page 227.

Tip: To update the Java classes that Mobile Development generates for the project
so that your changes are represented in the generated sources, save the project
and regenerate sources. For instructions, see “Generating Sources for a Mobile
Project” on page 46.

Adding RESTful IS Services
Adding RESTful IS enables you to trigger services hosted on webMethods Integration
Server. These services can be used like the normal RESTful services as described in
“Adding RESTful Services” on page 62. For detailed information about RESTful IS
Services, see webMethods Service Development Help.

Note: This feature requires the installation of Service Development.

To add RESTful IS services

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the project so that you view the
Services container node. If the model does not have a Services container node, add
one by right-clicking the root application and selecting New Child > Services.

3. Drag the RESTful IS Services object from the palee of the Outline Editor to the
Services node. In the palee, you can find this object when clicking the header-type
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node RESTful Services. You can then see it under the heading webMethods. If the
palee entry RESTful IS Service is not visible, Service Development is not installed.

4. In the resulting dialog box, specify a connection to a server from which you want
to use services. If the selection box does not list any server connection, open your
Integration Server preferences page and connect to an Integration Server. You can
open the Integration Server preferences page with the link below the selection box.
For more information, refer to webMethods Service Development Help.

5. After selecting an existing server connection, the tree selection below becomes
visible. Select the required webMethods package, and select the services you want to
add to your mobile project.

6. Click OK to add the child nodes.

Adding Virtual Services
Virtual Services can be considered as an abstraction layer on top of services. They allow
you to load data from different RESTful services and to map this data to EML entities
(Entity Modeling Language).

They introduce the concept of different contexts in EML entities for @JsonProperty
mappings as shown in the following example:
entity CaseType {
  // default expression
  @JsonProperty(expression="candybarType.caseAppName")
  // contextual expression when loading from AgileApps source  
  @JsonProperty([AgileApps] expression="content") 
  String caseAppName;
}

By mapping different services and their JSON responses to one EML entity, you can
work with entities in code or user interface bindings without checking context or which
service was used to load the data.

Virtual Services can be useful

If you want to support different API versions in one project.

If you want to support different APIs for the same data to be displayed (e.g., to load
and display data from different sources).

Important: You must create a RESTful service before creating a Virtual Service. For more
information, see “Adding RESTful Services” on page 62.

To add a Virtual Service

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the project so that you view the
Services container node.
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If the model does not have a Services container node, add one by right-clicking the
root application and selecting New Child > Services.

3. Right-click the Services node, and select New Child > Virtual Service.

4. Right-click the Virtual Service node, and select New Child > RestMethodDelegate.

Note: You must add at least two REST methods.

5. Select one of the REST methods nodes, and in the Properties section of the Outline
Editor set the properties for it as follows:

For Invoke When, specify when the method should be called. This value must be
unique within a Virtual Service.

Note: You can set Invoke When in code using the following snippet:
AbstractVirtualOperation.CONTEXT.setContextName (
  "myInvokeWhen");

InvokeWhen must be equivalent to the contexts specified for the entity.

For Rest Method, the entry is populated and corresponds to the name of the REST
method node. If you select a different REST method from the menu, the name of
the REST method node changes accordingly.

6. Repeat this step for the other REST method node(s).

Tip: To update the Java classes that Mobile Development generates for the project
so that your changes are represented in the generated sources, save the project
and regenerate sources. For instructions, see “Generating Sources for a Mobile
Project” on page 46.

Adding the SyncComponent Object
The SyncComponent object provides the required client implementation for offline data
synchronization with the Mobile Support Client. It uses the path to the Mobile Support
Client that has been set in the Mobile Development preferences. For more information,
see “Mobile Development Preferences” on page 28.

SyncComponent acts like a service and can be used as a REST method for data sources.
It establishes all the connections to the webMethods Integration Server and retrieves/
synchronizes data.

For more information on data synchronization with the Mobile Support Client, see
Developing Data Synchronization Solutions with webMethods Mobile Support.

To add the SyncComponent object

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.
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2. In the Model section of the Outline Editor, expand the project so that you view the
Services container node.

If the model does not have a Services container node, add one by right-clicking the
root application and selecting New Child > Services.

3. Drag the SyncComponent object from the palee of the Outline Editor to the Services
node. In the palee, you can find this object when clicking the header-type node
RESTful Services. You can then see it under the heading Mobile Support.

Alternatively, right-click the Services node and select New Child > SyncComponent.

4. Select the SyncComponent node, and in the Properties section of the Outline Editor,
set the properties for the SyncComponent node. For more information, see “Services
Object Reference” on page 223.

Adding Task Client Services
Task Client services enable you to work with webMethods Task Engine. These services
can be used like the normal RESTful services as described in “Adding RESTful IS
Services” on page 63. For detailed information on the available services, see the
webMethods Task Engine API and Service Reference.

To add Task Client services

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the project so that you view the
Services container node.

If the model does not have a Services container node, add one by right-clicking the
root application and selecting New Child > Services.

3. Drag the TaskClient Services object from the palee of the Outline Editor to the
Services node. In the palee, you can find this object when clicking the header-type
node RESTful Services. You can then see it under the heading webMethods.

4. In the resulting dialog box, specify the following seings:

a. Specify the URL for the machine on which the Task Engine is running.

b. Either clear the Create all built-in services check box and then select the built-in
services that you want to create, or select this check box if you want to create all
built-in services.

5. Click OK to add the child nodes for the built-in services.
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Adding ARIS Services
The ARIS Mobile API enables you to receive information about databases and their
process models from a remote ARIS instance. ARIS Mobile provides a set of predefined
RESTful Services. These services can be used like the normal RESTful services as
described in “Adding RESTful Services” on page 62.

To add ARIS Services

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the project so that you view the
Services container node.

If the model does not have a Services container node, add one by right-clicking the
root application and selecting New Child > Services.

3. Drag the ARIS Services object from the palee of the Outline Editor to the Services
node. In the palee, you can find this object when clicking the header-type node
RESTful Services. You can then see it under the heading ARIS Mobile.

4. In the resulting dialog box, specify the following seing:

a. Specify the URL for the machine on which ARIS is running.

b. Either clear the Create all built-in services check box and select the built-in services
you want to create, or select this check box if you want to create all built-in
services.

5. Click OK to add the child nodes for the built-in services.

Tip: There are several request parameters that must be x-www-form-urlencoded,
e.g. key in the PostLogin service. You can url encode parameters inMobile
Development if you select the option Url Encode for each specific parameter.
To avoid that sensitive information (e.g., user name, password) is appended
in plain text to the request URL (and therefore shown in the server log file),
the Content Type of the request should be set to x-www-form-urlencoded.

Tip: If you want to use the umc/api/tokens service for authentication, you must set the
Content Type of the request in the PostLogin service to NONE.

Adding Web Services
If you want to generate Java classes based on a specific WSDL file, you must import this
WSDL file into your mobile project. After the import, you can find the WSDL file in the
wsdl subfolder of your mobile project.
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To generate the Java classes, use Generate Source Code > Application
Model and API. The Java classes will be placed in the gen/api-src/
com.softwareag.mobile.runtime.toolkit.ws/wsdlFileName  folder.

Several XSD elements and data types are not supported by Mobile Development. These
are:

Unsupported elements:

<xsd:simpleContent>

<xsd:union>

<xsd:complexType> variable elements are assumed to be in <sequence>, even if
they are not.

<port> as a child of <definitions>

<extension> as a child of <xsd:complexContent>

Unsupported data types:

base64Binary (byte[]) - use string type instead

integer (java.math.BigInteger) - use int, long or string decimal instead

(java.math.BigDecimal) - use string instead (float and double would lose
precision on financial data, but you might consider them acceptable in other use
cases)

dateTime (java.util.Calendar) - use string date instead

(java.util.Date) - use string instead

map

All classes defined in com.ibm.ws.webservices.*

In addition, keep in mind the following when working with web services:

Mandatory variables for objects are not featured in their constructors at this time.

simpleType restrictions are parsed, but no code is output to enforce them.

All setups are currently assumed to be SOAP 1.1 compliant.

To add a web service

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the project so that you view the
Services container node.

If the model does not have a Services container node, add one by right-clicking the
root application and selecting New Child > Services.
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3. Drag the WebService object from the palee of the Outline Editor to the Services
node. In the palee, you can find this object when clicking the header-type node Web
Services.

Alternatively, select File > Import > Other > Import WSDL File and click Next.

4. In the WSDL File Import dialog box, click Browse and select the WSDL file that you
want to import.

5. Click Finish.
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About Data Modeling
Data Modeling uses the Entity Modeling Language (EML) to define a project-specific
data model and its support within the application model. You can specify a data model
using a Java-like syntax, including syntax highlighting, auto-completion, and formaing.

Every EML data model consists of entities and enumerations. An enumeration consists of
a list of literals and is represented by a Java class that contains a public static member
for each literal. Each member is identified by an int value (starting with 0). An entity
represents a Java class and may own a number of variables, collections, and operations,
such as:

Variable: Integer, Float, Double, Char, Byte, String, Object, Image, Boolean, Long

Collection: List<Type>, Map<Type, Type>, Stack<Type>

Operations: void print(String[] args);

Variables can also be used as an array. The language supports cross-referencing (using
another entity as variable type) and inheritance (using the extends keyword) of entities
to build a hierarchical data model.

A convenient way to model a bi-directional cross-referencing relationship is to use the
@Opposite annotation. If at run time the reference to an entity is changed, the generated
code also changes the opposite reference of that relationship. The following use cases are
supported:

1:1 relation between variables of type entity

1:Many relation between variable of type entity and list of type entity

Many:Many relation between two lists of type entity

Two convenience methods are generated if the opposite is a list:

addItemOn<Entity>(final Abstract<Entity> item)

removeItemOn<Entity>(final Abstract<Entity> item)

In this case, a seer is not generated.

The @Opposite annotation is not supported for:

Arrays, enums, maps, and stacks

Variables using a simple type (e.g., int, boolean, etc.)

After code generation, entities and enumerations can be used as normal Java classes. An
entity must have a name, which will be taken as name for the resulting Java class. As an
example, the entities:
package entities; 
entity ProcessInstance { 
  String id; 
  String name; 
  int status; 
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  @Opposite(member=processInstance)
  List taskInstances; 
  void print(String[] args)
}
entity TaskInstance {
  String description;
  @Opposite(member=taskInstances)
  ProcessInstance processInstance;
}

will result in the Java class ProcessInstance.java and TaskInstances.java, located in your
src/your_bundle_name model/entities package. The resulting Java class will then be
generated to include each of the variables and collections as Java class properties:
public abstract class AbstractProcessInstance implements IEntity {
  private String id;
  private String name;
  private Integer status;
  private Vector taskinstances = new Vector();
  public abstract void print(final String[] args);
  public AbstractProcessInstance setTaskInstancesAtIndex
   (final AbstractTaskInstance item, final int index){
      if (taskinstances != null && taskinstances.size() > index && index >= 0){
          final AbstractTaskInstance oldItem = (AbstractTaskInstance) 
          taskinstances.elementAt(index);
          taskinstances.setElementAt(item, index);
          item.setProcessInstance(this);
          oldItem.setProcessInstance(null); 
      }
      return this;
  }
}

The class will also contain geer and seer methods for your properties and helper
methods to access contents of collections. Furthermore, convenience methods like
updateFromJson(), getAppController(), and a constructor with a JSONObject parameter are
generated. With these, it is easily possible to create or update an entity based on a
JSONObject/JSONString and access the AppController.

Data Modeling also includes two entity based data sources that are called EntityDataSource
and EntityStore. An EntityDataSource can be configured to request a remote JSON resource.
The JSON document is automatically parsed into an entity. Furthermore, the entity
is transformed back into a JSON document so that it can send back the data to a
remote JSON resource. The entities will be used as a list data source for ListView and
ListViewElement objects. For more information, see “EntityDataSource Properties” on
page 211. The EntityStore provides a single entity and can be used to bind a single data
object against user interface elements. For instance, having a login mask with input
fields for user name and password, you can bind both input fields against a Credentials
Entity using a DataBinding object.

Adding a Data Model
You can add a data model to your mobile project.
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To add a data model

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the project so that you view the
Entities container node.

If the model does not have an Entities node, add one by right-clicking the root
application and selecting New Child > Entities.

3. Right-click the Entities node and select New Child > Package.

4. In the pop-up dialog, enter a new name for the package and click OK.

A new EML file was added to the mobile project, and the EML editor opens where you
can edit the data model.
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About Building the User Interface
The following lists the tasks to perform to build the user interface for a mobile
application.

Understand the basic structure of the user interface, for information, see “Basic
Structure of the Application User Interface” on page 76.

Define the configuration of panes to use for the application’s window. For more
information, see “Defining Panes for the Application Window” on page 77.

Define the different screens that the application displays. The screens are referred
to as views. For more information, see “Adding Views to the Application’s User
Interface” on page 81 and “Adding Content to a View” on page 83.

Add listeners that wait for user-initiated events when a user interacts with controls
you add to the view and take an action based on the user-initiated event. For more
information, see “Responding to User-Initiated Events” on page 92.

Define templates if you want to customize and reuse user interface structures. For
more information, see “Using Templates to Define Custom Objects for a Mobile
Project” on page 100.

Basic Structure of the Application User Interface
The user interface is made up of a window, panes, views, and content within the views.
Additionally, you can define dialogs.

Main Window for the Application

When using Mobile Development to design the user interface, your application contains
a single main window for your application. The window defines the visible bounds of
the display to use for an application.

When you create a mobile project, Mobile Development defines the application’s main
window for you.

Panes for the Window

You divide the main window into one or more panes. When creating an application for
a small hand-held device, such as a mobile phone, you might want to use a single pane
or maybe two, one for a navigation area and the other for a main area. When creating an
application for a larger device, such as a tablet, you might want to use more panes. For
more information, see “Defining Panes for the Application Window” on page 77.

Views to Place in Panes

You define views that the application displays in the panes of the application’s window.
For information about how to define a view, see “Adding Views to the Application’s
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User Interface” on page 81. For information about the types of views you can add,
see “Objects to Use for Views” on page 166.

Contents of Views

Inside a view, you place the content you want the application to display. For example,
you can add text fields, buons, check boxes, etc. For more information, see “Adding
Content to a View” on page 83.

Dialogs

Define alert dialogs if you need small pop-ups that display over a view. Use dialogs to:

Present information to the user.

Interact with the user by presenting a simple question, for example, a question
requiring a “yes” or “no” answer.

An application can display one dialog at a time. For more information, see “Defining
Dialogs” on page 94.

Defining Panes for the Application Window
You need to define panes and pane configurations for the user interface of a mobile
application. Panes are subsections of an application’s window. The application displays
views within panes. A pane configuration indicates how to lay out the panes within the
window.

You define panes using the PaneDefinition object. You define a pane configuration using
the PaneConfiguration object.

The simplest layout is a single pane. To have a single pane, add a single PaneDefinition
child object to the PaneConfiguration object. The PaneDefinition object indicates the pane to
display and the view that you initially want the application to display in the pane.



M
Even Header

Building the User Interface for a Mobile Application

webMethods Mobile Development Help Version 10.3 78

Another simple layout is to use two panes, either vertically (side-by-side) or horizontally
(one on top of the other). To define this type of configuration, rather than adding the
PaneDefinition child object directly to the PaneConfiguration object, you first add either a
VerticalSplitter object or a HorizontalSplitter object to the PaneConfiguration object. You can
then add two PaneDefinition child objects to the splier object. The order you list the
PaneDefinition objects is the order the panes display in the window. For example, if you
list pane A followed by pane B, in a vertical arrangement pane A is on the left and in a
horizontal arrangement pane A is on the top.
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If you need a more complex arrangement of panes for an application’s user interface,
you can nest VerticalSplitter and HorizontalSplitter objects under parent splier objects. For
example, the following shows a layout with four panes arranged horizontally.

The following shows another example that has three panes, with two panes displayed
horizontally on the left and a single pane on the right.
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Keep the following usage notes in mind when working with panes:

When you create a new project, by default, the application’s window is named
“MainWindow” and has a pane configuration made up of two panes named
“MasterPane” and “DetailPane”. The pane configuration is defined to arrange the
panes vertical, with the MasterPane on the left and the DetailPane on the right.

If you do not want to use the default panes and configuration, you can delete them.

You can add as many panes as you want.

You can define multiple pane configurations and have the application switch pane
configurations, as needed.

For example, you might only want a single pane for an application’s login panels,
but switch to a multi-pane setup after the user logs in.

You can use the same named panes in multiple pane configurations.

A pane configuration can include one or more panes.

For smaller devices, such as phones, you might only use a single pane or maybe two,
one for the navigation and one for the main view. For larger devices, such as tablets,
you might want to use additional panes.

The order you list the PaneDefinition child objects within a PaneConfiguration parent
object is the order the panes display in the window.

By default, when you use a HorizontalSplitter, the split creates two equal sections,
one on top of the other. However, you can define the size for one of the sections,
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and the other section uses the remaining space. To set the absolute size of a
pane, set the HorizontalSplitter object’s Height property. For more information, see
“HorizontalSplier Properties” on page 164.

Note: An exception to the default behavior is when you use a HorizontalSplitter
with a NavView in the boom pane. In this case, the size of the boom
pane is set to the height required for the NavView. The top pane uses the
remaining space.

By default, when you use a VerticalSplitter, the split creates two equal side-by-
side sections. However, you can define the size for one of the sections, and the
other section uses the remaining space. To set the absolute size of a pane, set the
VerticalSplitter object’s Width property. For more information, see “VerticalSplier
Properties” on page 165.

Adding Views to the Application’s User Interface
To add a view to the user interface, you add a ListView, NavView, View, SideView, WebView,
or TabView object to the model. You can then reference the view in your model to display
it in a pane or transition to it when a user-initiated event occurs.

To add a view to the user interface

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the outline so that you view the
Views node.

3. Right-click the Views node and select New Child > child_object, where child_object is the
name of the type of view you want to add.

For a description of the types of views you can add, see “Objects to Use for Views”
on page 166.

4. Set the properties for the view.

For more information, see “Seing Properties in the Outline Editor” on page 26.

For descriptions of the properties, see:
“ListView Properties” on page 167
“NavView Properties” on page 169
“View and SideView Properties” on page 170
“WebView Properties” on page 171
“TabView Properties” on page 169

5. To use the view in the user interface, you can do one or more of the following:

To display the view when using a pane configuration, specify the view in the
Start View property of the PaneDefinition object.



M
Even Header

Building the User Interface for a Mobile Application

webMethods Mobile Development Help Version 10.3 82

To transition to the view when a user-initiated event occurs, set the View property
of the specific Transition event action object. For more information, see “Objects
to Use for Event Actions” on page 216 and “Transition Properties” on
page 220.

You can also add code to your application logic to programmatically transition
to the view. For more information, see “Logic to Transition to Another View” on
page 116.

Tip: To update the Java classes that Mobile Development generates for the project
so that your changes are represented in the generated sources, save the project
and regenerate sources. For instructions, see “Generating Sources for a Mobile
Project” on page 46.

Renaming a View
You specify a name for a view by seing the view’s Name property. When you generate
sources for the mobile project, the view_name ControllerImpl.java Java class that Mobile
Development generates in the src folder includes the view name in the name of the Java
class. After generating sources, if you want to change the name of the view, use the
following procedure.

To rename a view

1. Ensure the view is displayed in the Outline Editor. For instructions, see “Displaying
a Mobile Project in the Outline Editor” on page 22 or “Displaying a Window, View,
or Dialog in the Outline Editor” on page 23.

2. In the Model section of the Outline Editor, select the view node that you want to
rename.

3. Type the new name for the view in the Name property, which is displayed in the
Properties section of the Outline Editor.

4. Save the mobile project and generate sources for the mobile project. For more
information, see “Generating Sources for a Mobile Project” on page 46.

Mobile Development generates a new new_view_name ControllerImpl.java Java class for
the view where new_view_name  is the new name you assigned to the view.

Mobile Development does not remove the old_view_name ControllerImpl.java Java
class, where old_view_name  is the previous name of the view. Mobile Development
retains this file in the event that you previously added custom code to the
old_view_name ControllerImpl.java Java class.

5. Update the new_view_name ControllerImpl.java class with any custom code that you
added to the old_view_name ControllerImpl.java Java class.
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a. In the Package Explorer or Navigator view, locate the src > package  > ui > controller
> impl folder, which contains both the new_view_name ControllerImpl.java and
old_view_name ControllerImpl.java Java classes.

b. Open both Java classes and copy all custom code from the
old_view_name ControllerImpl.java to new_view_name ControllerImpl.java.

c. Save both files.

d. Delete the old_view_name ControllerImpl.java Java class.

Adding Content to a View
What You Can Add to a View

To define a view’s user interface, in the Outline Editor you add user interface objects to
the model as child objects of the view object. For descriptions of the objects you can add
to views, see the following:

“Objects to Use for the Layout of the User Interface” on page 172

“Objects to Use for Tables” on page 177

“Objects to Use for User Interface Controls” on page 181

“Objects to Use for Content Providers or Content Adapters” on page 205

“Objects to Use for Event Listeners” on page 213

“Objects to Use for Event Actions” on page 216

The user interface objects that are valid in a view are based on the specific type of
view, that is, whether you are adding the objects to a ListView, NavView, View, SideView,
TabView, or WebView. For example, the only valid object that you can add to a NavView is
a NavButton object. When using the Outline Editor to build a view’s user interface, the
Outline Editor only lists objects that are valid for each type of view.

The following sections provide general information about adding content to views.
For information specifically about adding content to a ListView, see “Programmatically
Populating a ListView” on page 84 and “Using a Content Provider to Populate a
ListView” on page 87.

Order of Objects You Add to the View

The order of the child objects under a view object dictates the order the objects will
display in a view. For example, assume the following is defined for a view:
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The result is that in the view’s user interface, a textfield is displayed followed by a check
box and a buon.

Nesting Objects in a View

Some objects allow you to nest child objects under them. When the view is displayed,
the child objects are displayed inside their parent object. If you nest multiple objects,
they display in the parent object in the order you list them in the model in the Outline
Editor.

For example, if you use a Container object, you can nest child objects under the Container
object.

The result is that in the view’s user interface, the child objects you place under the
Container object display within the container in the user interface. The order of the child
objects are the order in which the child objects are displayed within the Container object.

Programmatically Populating a ListView
Use a ListView object to display a list of items. You can populate a ListView by adding
logic to the view’s controller.

Note: Rather than adding logic to the view’s controller to populate the ListView
object, you can use a content provider to populate a ListView. For example,
you might populate the ListView with the response from a REST service. For
more information, see “Using a Content Provider to Populate a ListView” on
page 87.

Objects to Add to the Project Model

This section describes the objects you add to the model if you want to add logic to the
view’s controller to populate the ListView object.

In the UserInterface > Views section of the model, you need to add the following
objects.
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Object Description

ListView Required. Defines the ListView.

Pagination Optional. Specifies how many list items to display per page
and identifies templates for objects that the user selects to
view the next or previous page of results.

In the UserInterface > Templates section of the model, you add templates that indicate
how to display the data within the ListView.

Template for Description

List item Required. You must create a template that defines how to
display a single item from the data source.

Typically, you create a template for a Table or TableButton
object.

When you add logic to the controller for the view, you
invoke the Java class for this template to display an item in
the view.

List header Optional. You can create a template to provide a header for
the ListView. For example, you might create a template for
an object like a Textfield or an Image.

If you want to provide a header for the ListView, specify the
template in the ListView object’s List View Header property.

List separator Optional. You can create a template for an object that you
want to display between each list item in the ListView. For
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Template for Description
example, you might create a template for an object like a
Separator, Spacer, or Image object.

If you want to provide a separator for the list of data,
specify the template in the ListView object’s Separator
property.

Control to show
when reloading
data

Optional. You can create a template for an object that the
application will display when the application is accessing
the data source to refresh the data. For example, you might
create a template for an object like a ProgressAnim, Image, or
Textfield object.

If you want the application to display an object when
refreshing the data, specify the template in the ListView
object’s Show On Reload property.

Control to
display the next
page of results

Conditionally required. Create a template for an object, for
example, a Button object, that a user selects at run time to
display the next page of results.

This template is required if you are using the Pagination
object. You specify this template in the Pagination object’s
Next Page Template property.

Control to
display the
previous page of
results

Conditionally required. Create a template for an object, for
example, a Button object, that a user selects at run time to
display the previous page of results.

This template is required if you are using the Pagination
object. You specify this template in the Pagination object’s
Previous Page Template property.

Logic in the Controller for the View

When you generate sources for a mobile project, Mobile Development generates a Java
class named view_name ControllerImpl.java in the src.package_name .ui.controller.impl package.
For example, if you assigned the view the name “MyListView” and the package name
“my.company.com”, Mobile Development generates MyListViewControllerImpl.java in the
src.my.company.com.ui.controller.impl package.

To provide logic to populate the ListView, you override the following methods:

getNumber OfRows(). At run time, the application invokes this method to determine the
total number of list items to display.

Add logic to this method to determine the number of list item results to display, for
example:
public int getNumberOfRows(ListView listView) { 
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    Vector my_items = getMyData(); 
    return my_items.size(); 
}

getCell. At run time, the application invokes this method to obtain a list item to
display in the ListView.

Add logic to this method that returns a single list item to display, for example:
public nUIDisplayObject getCell(ListView listView, int rowIndex){ 
    Vector myItems = getData(); 
    final ListItemTemplate item = new ListItemTemplate(); 
    item.initializeWithData(myItems[rowIndex]); 
    item.setIndex(rowIndex + 1); 
    return item; 
}

onRowSelect(). At run time, the application invokes this method when a user selects
a row in the list of results. Optionally add logic to this method if you want to take
some action when a list item is selected. For example, you might want to transition to
another view or open a dialog.
public void onRowSelect(ListView listView, int rowIndex) { 
   Vector myItems = getData(); 
   getTransitionStackController().pushViewController(new 
       ItemDetailViewImpl(myItems[rowIndex])); 
}

Using a Content Provider to Populate a ListView
Use a ListView object to display a list of items. You can populate a ListView object using a
ContentProvider object to retrieve data from a data source. Mobile Development supports
DynamicDataSource, RESTDataSource and EntityDataSource . For more information about
data sources, see “Objects to Use for Content Providers or Content Adapters” on
page 205.

Note: Instead of using a ContentProvider, you can programmatically populate
the ListView. For more information, see “Programmatically Populating a
ListView” on page 84.

Tip: If your ListViews requires displaying more than one Template instance, it is
recommend to use the ContentAdapter.

Objects to Add to the Application Model

1. Add a ListView object to your application (or use a template containing a
ListViewElement object).

2. Add a data source to your application, as a child of the Datasources node. This can be
a DynamicDataSource, a RESTDataSource or an EntityDataSource .

3. Add a ContentProvider object to the ListView object. The ContentProvider object indicates
from where you obtain data and the template to be used to present the data. Set the
following properties:
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Property Description

List Data Source Required. Specifies the data source.

No Rows Template Optional. A template that is to be shown when
the data source of the ContentProvider contains no
elements.

Reload On Transition To Select this if the ContentProvider is to be reloaded
each time this view is accessed.

Row Template Required. A template used to show the contents of
the ListView.

4. Add one or more TemplateDataBinding objects to the ContentProvider object.
A TemplateDataBinding maps a control contained in the RowTemplate of the
ContentProvider with a given set of data identified by the Expression property. Set the
following properties:

Property Description

Control Required. Select a control that is contained in the
RowTemplate of the ContentProvider.

Data Source Select the data source to populate the data for this
control.

Expression Enter an expression value to identify the data.

5. Optional. Add a RowSelectionListener to react on the user interaction with the ListView.

6. Optional. Add a Pagination object if you want to display the contents of the ListView
on different pages. Set the following properties:

Property Description

Max Number Per Page The maximum number of cells displayed per page.

Next Page Template A triggerable object (such as a Button) which needs
to be triggered in order to load the next page.

Previous Page Template A triggerable object (such as a Button) which needs
to be triggered in order to load the previous page.
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In addition, you can add templates to customize the ListView:

Template for Description

List item Required. You must create a template that defines how to
display a single item from the data source.

Typically, you create a template for a Table or TableButton object.

You reference this template in the ContentProvider object’s
Template property.

List header Optional. You can create a template to provide a header for the
ListView. For example, you might create a template for an object
like a Textfield or an Image.

If you want to provide a header for the ListView, specify the
template in the ListView object’s List View Header property.

List separator Optional. You can create a template for an object that you want
to display between each list item in the ListView. For example,
you might create a template for an object like a Separator,
Spacer, or Image object.

If you want to provide a separator for the list of data, specify
the template in the ListView object’s Separator property.

Control to
show when
reloading data

Optional. You can create a template for an object that the
application will display when the application is accessing the
data source to refresh the data. For example, you might create
a template for an object like a ProgressAnim, Image, or Textfield
object.
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Template for Description

If you want the application to display an object when
refreshing the data, specify the template in the ListView object’s
Show On Reload property.

Control to
display the
next page of
results

Conditionally required. Create a template for an object, for
example, a Button object, that a user selects at run time to
display the next page of results.

This template is required if you are using the Pagination object.
You specify this template in the Pagination object’s Next Page
Template property.

Control to
display the
previous page
of results

Conditionally required. Create a template for an object, for
example, a Button object, that a user selects at run time to
display the previous page of results.

This template is required if you are using the Pagination object.
You specify this template in the Pagination object’s Previous Page
Template property.

If you decided to use a RESTDataSource, you also need to specify a RESTful service which
will be triggered by the data source. For more information, see “Adding Services to a
Mobile Project” on page 61.

Example: How to Use Expressions with a RESTDataSource

Consider you have a RESTful service that has a getEmployeeInfo method that returns
information about employees. The following illustrates a sample JSON response given
by the service:
{
  "Employees": [
    { 
      "ID" : "19", 
      "name" : "Leanna Jones", 
      "Department": {
        "name" : "Research", 
        "location" : "Boston" 
    }},
    { 
      "ID" : "30", 
      "name" : "Zane Smith", 
      "Department": {
        "name" : "Research", 
        "location" : "Reston" 
    }}
  ]
}

If you like to add a ListView containing all employees, you need to set the ContentProvider
object’s Expression property to Employees. The ListView will then contain two elements.
To bind employees information to a particular template, you need to use an expression



M
Odd Header

Building the User Interface for a Mobile Application

webMethods Mobile Development Help Version 10.3 91

which is now relative to Employees. Having a template which visualizes the employee
name and department name of each employee, you need to add two TemplateDataBinding
objects with an Expression property pointing to name and Department.name.

Using a Content Adapter to Populate a ListView
You can populate a ListView object using a ContentProvider object to retrieve data from
a data source. The ContentProvider is designed to initialize one given type of Template
and bound it against the underlying data, provided by the data source. However, this
approach enables developers to quickly setup a ListView object, but is limited, because
only one type of Template can be populated. The ContentAdapter has been introduced
to close this gap and to populate multiple types of Templates to a ListView object. More
information, see “Using a Content Provider to Populate a ListView” on page 87.

Note: Instead of using a ContentAdapter, you can programmatically populate
the ListView. For more information, see “Programmatically Populating a
ListView” on page 84.

To add a ContentAdapter to the ListView or ListViewElement:

1. Add a ListView object to your application or use a Template containing a
ListViewElement object.

2. Add a data source to your application, as a child of the Datasources node. This can be
a DynamicDataSource, a RESTDataSource or a EntityDataSource.

3. Add a ContentAdapter object to the ListView object. The ContentAdapter object indicates
from where you obtain data. Set the following properties:

Property Description

List Data Source Required. Specifies the data source.

No Rows Template Optional. A Template that is to be shown when
the data source of the ContentAdapter contains no
elements.

Reload On Transition To Optional. Select this if the ContentAdapter is to be
reloaded each time this view is accessed.

4. Add one or more TemplateAssignment to the ContentAdapter. The TemplateAssignment
configures the Template to display. Set the following properties:
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Property Description

BindMethodName Optional. A name of a Java method will be
generated. The generated contents will initialize
your Template and bind it against the data.

This method is overwriteable in your ListView
controller implementation.

Filter Expression Required. A string value evaluated at runtime, if
the specified Template should be initialized for a
given row index.

Template Required. A Template used to show the contents of
the ListView.

5. Add one or more TemplateDataBinding objects to the TemplateAssignment
object. A TemplateDataBinding maps a control contained in the Template of the
TemplateAssignment with a given set of data identified by the Expression property. Set
the following properties:

Property Description

Control Required. Select a control that is contained in the
Template of the TemplateAssignment. The control
must have a name.

Data Source Required. Select the data source to populate the
data for this control.

Expression Required. Enter an expression value to identify the
data.

6. Optional. Add one or more RowSelectionListener to the ContentAdapter to react on
the user interaction with the ListView. A RowSelectionListener also has a property
filterExpression. This will act like the filterExpression, set for a TemplateAssignment, and
indicates, which of the RowSelectionListeners needs to be triggered, when the user
selects on row of the ListView.

Responding to User-Initiated Events
A user-initiated event is when a user interacts with a control in the application’s user
interface, for example, when a user presses a buon, types text in a text field, selects a
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check box, etc. You can add listeners to your model, so if a user-initiated event occurs for
a control, your application can respond by taking an appropriate action.

Types of Listeners Mobile Development supports:

GainFocusListener listens for, when a user selects an object so that the user interface
object gains focus.

LoseFocusListener listens for, when a user interface object loses focus because the user
stops selecting an object when the user selects another user interface control.

PostEditListener listens for, when a user edits an object, for example an entry field,
and generates an event after the object is edited.

PreEditListener listens for, when a user edits an object, for example an entry field, and
generates an event when the user first selects the object for editing.

CompletedEditListener listens for, when a user edits an object, for example an entry
field, and generates an event when the user ends the editing. End of editing means
closing the keyboard or focusing another UI element.

TriggerListener listens for when, a user uses an object, for example, presses a buon.

RowSelectionListener listens to trigger events for each row in a ListView object, for
example, when a user selects one row. This listener can only be added as a child of a
ContentProvider or ContentAdapter object.

SwipeListener listens to swipe events. You can define either a LeftToRight or
RightToLeft swipe event. This listener can only be added to a normal View control (it
is not possible to add it to a ListView, NavView or WebView control). You can only
add one SwipeListener to a View control.

When you add the objects for event listeners to your application, Mobile Development
generates the code to listen for the user-initiated events. You do not need to add custom
logic to listen for the events.

How the application responds to a user-initiated event:

When you add listeners to your model, at run time if the listener detects the associated
user-initiated event, the application fires an event. For example, if you add a
TriggerListener object to a Buon object, at run time when the user presses the buon,
the application fires an event. In addition to specifying listeners in the model, you can
also define how the application responds to the event, in other words, the action the
application takes when the event occurs.

Mobile Development provides these actions:

Back action to transition to the previous view.

ChangePaneConfiguration action to change the configuration of panes in the
application's window.

Delegate action to execute a method that you code.

OpenDialog action to open an alert dialog that you have defined in your model.
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ReloadContentProvider action to let a ContentProvider object reload its data source.

ToggleVisibility action to make a user interface object that you have defined in your
model either visible or hidden. If the object is currently visible, the action hides the
object. If the object is currently hidden, the action makes the object visible.

Transition action to transition to another view that you have defined in your model.

OpenSideView action to open a desired SideView.

CloseSideView action to close an already opened SideView.

For more information about these objects, see “Objects to Use for Event Listeners” on
page 213 and “Objects to Use for Event Actions” on page 216.

To add event listeners and associated actions

1. Ensure the view to which you want to add event listeners is displayed in the Outline
Editor. For instructions, see “Displaying a Mobile Project in the Outline Editor” on
page 22 or “Displaying a Window, View, or Dialog in the Outline Editor” on page 23.

2. In the Model section of the Outline Editor, right-click the user interface control
for which you want to add a listener and select New Child > event_listener_object,
where event_listener_object is one of the previously mentioned event listener, like
TriggerListener.

3. Right-click the event listener object you added and select New Child >
event_action_object, where event_action_object is one of the previously mentioned
event action objects, e. g. OpenDialog. Please be aware, that every event listener
supports any kind and number of actions. It is up to the developer to add the correct
semantics to the project.

4. Select the event action object that you added.

5. In the Properties section of the screen, set properties for the event action object. For
more information about these objects, see “Seing Properties in the Outline Editor”
on page 26 and “Objects to Use for Event Actions” on page 216.

Note: Based on the event action you are using, you might also need to add
application logic for the action.

Tip: To update the Java classes that Mobile Development generates for the project
so that your changes are represented in the generated sources, save the project
and regenerate sources. For instructions, see “Generating Sources for a Mobile
Project” on page 46.

Defining Dialogs
You can define alert dialogs for a mobile application. A dialog is a pop-up window that
displays over a view. An application can only have only one dialog open at a time.



M
Odd Header

Building the User Interface for a Mobile Application

webMethods Mobile Development Help Version 10.3 95

To add a dialog, you add an AlertDialog object to the Dialogs container in the Outline
Editor. When you add an AlertDialog object to the user interface, Mobile Development
automatically adds an AlertDialogButton as a child object. An AlertDialog object requires at
least one child AlertDialogButton object.

To define a dialog for a mobile application

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the outline so that you view the
Dialogs node.

3. Right-click the Dialogs node and select New Child > AlertDialog.

Mobile Development adds an AlertDialogButton child object as well.

4. Select the AlertDialog object, and in the Properties section of the Outline Editor set
the properties for the dialog. For more information, see “AlertDialog Properties” on
page 176.

Use the Text property to specify the text you want displayed in the dialog.

5. Select the AlertDialogButton object that Mobile Development added for you, and in
the Properties section of the Outline Editor set the properties for the buon. For more
information, see “DialogBuon Properties” on page 176.

6. If you want the dialog to contain an additional buon, right-click the AlertDialog
object and select New Child > AlertDialogButton to add the buon. Then select the buon
and set the properties. Repeat this step for each additional buon you want in the
dialog.

7. To use the dialog in the user interface, you can do one or more of the following:

To display the view in response to a user-initiated event, for example, when a
user selects a check box, specify the dialog for a OpenDialog event action object.
For more information, see “Objects to Use for Event Actions” on page 216,
“Responding to User-Initiated Events” on page 92, and “OpenDialog
Properties” on page 219.

For information about how to add code to a dialog, see “Logic for a Dialog” on
page 113.

Tip: To update the Java classes that Mobile Development generates for the project
so that your changes are represented in the generated sources, save the project
and regenerate sources. For instructions, see “Generating Sources for a Mobile
Project” on page 46.
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Using Colors, Sizes, Styles and Themes
You can centralize the style and user interface definitions of your application by using
any of the model elements offered in the Styles category.

Using Colors
An easy way to define commonly used colors is to add a new color entry in the styles
category. A defined color element can then be referenced everywhere in the model
instead of directly specifying a color. The advantage is that you can easily change the
color that is used in several elements within the model.

To define a color for a mobile application

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the outline so that you view the
Styles node.

3. Expand the Styles node, select the Values node, and select New Child > Color.

4. In the Properties section of the Outline Editor, define a unique name in the Name field
(e.g., Background Color) and a color value in the Value field (e.g., 0xFF880E4F).

Note: If you press CTRL + SPACE in the Value field, a list of all defined colors is
shown. You can also click the pencil icon in the Outline view and use the
available color palees to define a color.

5. Save the Ouline Editor.

Note: (Android only) All defined color values will be saved in a colors.xml resource
file to be used in your Android project, e.g. for native code injections. For
more information, refer to “hps://developer.android.com/guide/topics/
resources/more-resources.html#Color”.

You can easily use the color in the user interface. Open a model element that contains a
color property (background color, font color, etc.), e.g. a “TextField” on page 203. In
that property, specify the name of the previously defined color object. If you press CTRL
+ SPACE, a list of all selectable defined color objects is shown.

Using Sizes
Similar to colors, you can also define sizes. A size is an integer value to be used as a
property for any dimensional user interface property, e.g. innerX, height, position X.

https://developer.android.com/guide/topics/resources/more-resources.html#Color
https://developer.android.com/guide/topics/resources/more-resources.html#Color
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To define a size for a mobile application

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the outline so that you view the
Styles node.

3. Expand the Styles node, select the Values node, and select New Child > Size.

4. In the Properties section of the Outline Editor, define a unique name in the Name field
(e.g., defaultInnerX) and a size value (e.g., 2) in the Value field.

Note: If you press CTRL + SPACE in the Value field, a list of all defined sizes is
shown.

5. Save the Ouline Editor.

Note: (Android only) All defined sizes will be saved in a dimens.xml resource
file to be used in your Android project, e.g. for native injections. For more
information, refer to “hps://developer.android.com/guide/topics/resources/
more-resources.html#Dimension”.

You can easily use the size in the user interface. Open a model element that contains a
size property. In that property, specify the name of the previously defined size object. If
you press CTRL + SPACE, a list of all selectable defined size objects is shown.

Using Font Sizes
In addition to colors and sizes, you can also define font sizes. They can be used as value
for any user interface property named Font Size.

To define a font size for a mobile application

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the outline so that you view the
Styles node.

3. Expand the Styles node, select the Values node, and select New Child > Font Size.

4. In the Properties section of the Outline Editor, define a unique name in the Name field
(e.g., Large, Medium, Small) and a font size value in the Value field (e.g., 10 sp, 12 sp,
14 sp).

Note: If you press CTRL + SPACE in the Value field, a list of all defined font sizes
is shown.

5. Save the Ouline Editor.

https://developer.android.com/guide/topics/resources/more-resources.html#Dimension
https://developer.android.com/guide/topics/resources/more-resources.html#Dimension
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You can easily use the font size in the user interface. Open a model element that contains
a font size property. In that property, specify the name of the previously defined font
size object. If you press CTRL + SPACE, a list of all selectable defined font size objects is
shown.

Using Styles
A style is a collection of common user interface properties that you can apply to most
user interface elements. Using styles enables you to easily reuse properties without
defining them again in every control. In addition, it eases the way to change properties
as they are defined in a single spot.

To define a style for a mobile application

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the outline so that you view the
Styles node. The Styles node is a child of the User Interface node.

3. Right-click the Styles node and select New Child > Style.

4. Select the Styles object, and in the Properties section of the Outline Editor set the
properties.

5. You can define an inheritance of styles. A style inherits all properties from a parent
style. If both styles define a value for the same property, the value of the child take
precedence.

6. To use a Style object, open a user interface related model element (View, Table,
TextField, etc). In that element, you will find the property Style, where you can select
a defined style from the list. If both, the style and user interface element itself, define
a property, then the property defined in the user interface element takes precedence.

Using ApplicationStyle to Define Android Styles and Themes
This section describes how to customize the look and feel of your Android application.

The ApplicationStyle allows you to define styles and themes for your Android project.
In Android, a style is a collection of properties that specify the look and format
for a view. For more information about Android styles and themes, see “hps://
developer.android.com/guide/topics/ui/themes.html”.

Note: Ensure your application model contains an ApplicationStyle.

To define an ApplicationStyle for a mobile application

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

https://developer.android.com/guide/topics/ui/themes.html
https://developer.android.com/guide/topics/ui/themes.html
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2. In the Model section of the Outline Editor, expand the outline so that you view the
Styles node.

3. Right-click the Styles node and select New Child > ApplicationStyle.

The ApplicationStyle node provides a child called Android Theme. You can add an
Android Theme by right-clicking the ApplicationStyle node and selecting New Child ->
Android Theme. After adding an Android Theme to the Application Style, a new editor
opens showing all the defined styles and themes. You will find the corresponding
themes.asl file in your your_project /model/resources/ directory.

Note: A mobile project can only contain one Android Theme file.

A project created with Mobile Suite 9.12 already contains an Android Theme with
default values set. Projects created with versions of Mobile Suite before 9.12 take these
values as defaults as well:
values {
    <style name="ToolbarTheme" parent="ThemeOverlay.AppCompat.Dark">
    </style>
    <style name="ToolbarPopupTheme" parent="ThemeOverlay.AppCompat.Light">
    </style>
}
values-v14 {
    <style name="AppBaseTheme" parent="Theme.AppCompat.Light">
    </style>
}

The editor allows editing of styles and themes in a XML-based language that is familiar
to Android developers. You can group a collection of styles within a values category.
The values category can contain an optional resource qualifier, stated by the suffix -
qualifier, e.g. values-v14. For more information about Android resource qualifiers,
see “hps://developer.android.com/guide/topics/resources/providing-resources.html”.
In Android, each style can contain a set of items, see (“hps://developer.android.com/
guide/topics/resources/style-resource.html”).

You can customize the theme of an Android project by adding the style named
AppBaseTheme to your values category.

Note: Note that themes are limited to AppCompat, e.g. Theme.AppCompat.Light,
Theme.AppCompat and Theme.AppCompat.DayNight.

After code generation, an XML file is created for each of your values categories.
Generated files are placed in the your_project /gen/.assets/android/res directory. Each
of the values categories is stored in a directory named after the category itself, e.g. /
values-v14. This directory contains a single styles.xml file containing your declared
styles and themes. During the multi-build, the entire content of the your_project /
gen/.assets/android/res directory will be copied to the cross compiled Android project.

https://developer.android.com/guide/topics/resources/providing-resources.html
https://developer.android.com/guide/topics/resources/style-resource.html
https://developer.android.com/guide/topics/resources/style-resource.html
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Using Templates to Define Custom Objects for a Mobile
Project
You can add templates to your mobile project to add customizations to the following
user interface objects that Mobile Development provides.

Buon
DateEntry
Entry
Image
ListViewElement
ProgressAnim
SearchEntry
Separator
Spacer
Table
TableBuon
TextField
WebViewElement

For more information about creating a template, see “Creating a Template for a Custom
Object” on page 100.

After you create a template for a user interface object, you can use it in your mobile
application user interface. For more information, see “Using a Template in the Mobile
Application User Interface” on page 101.

Creating a Template for a Custom Object
Create a template if you want to customize a user interface object for your mobile
project.

To create a template

1. Ensure the mobile project to which you want to add a template is open in the Outline
Editor. For instructions, see “Displaying a Mobile Project in the Outline Editor” on
page 22.

2. In the Model section of the Outline Editor, expand the outline so that you view the
UserInterface > Templates node.

3. Right-click the Templates node and select New Child > Template.

Mobile Development adds a Template child node.

4. Select the new Template node.
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5. In the Properties section of the Outline Editor, specify a Java class name in the Class
Name property.

For example, if you want to customize the Buon user interface object, you might
specify MyButtonTemplate.

Mobile Development renames the Template node to the name you specified in the
Class Name property.

6. Right-click the template node you just added and select New Child > object, where
object is the type of object you want to customize.

For example, if you want to customize the Buon object, select New Child > Button.

7. Select the new node you added and in the Properties section of the Outline Editor, fill
in the properties. For more information about properties, see “Template Properties”
on page 222.

8. Save the mobile project and generate sources for the mobile project. For more
information, see “Generating Sources for a Mobile Project” on page 46.

Mobile Development generates the following Java classes for the template:

Abstracttemplate_name .java in the gen/src folder in the package_name .ui.templates
package

This class contains the standard logic to handle the user interface object you are
customizing with the template.

Important: Do not update this Java class. Mobile Development regenerates it
each time you generate sources and any changes you make will be
overwrien.

template_name .java in the src folder in the package_name .ui.templates package

You update the templat_name .java class to customize the user interface object.

For the generated Java classes:

template_name  is the Java class name you specified for the Class Name property of
the template node.

package_name  is the package name you specified for your mobile project.

9. Add the logic to customize the user interface object to thetemplate_name .java class.

Using a Template in the Mobile Application User Interface
After you create a template to customize a user interface object, you can use the object in
the user interface of your mobile application.

The following procedure describe how to use a template by using the TemplateReference
object. You can also use templates to customize a ListView. For more information, see
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“Programmatically Populating a ListView” on page 84 and “Using a Content
Provider to Populate a ListView” on page 87.

To use a template in a mobile application user interface

1. Ensure the mobile project or specific window, view, or dialog to which you want to
add the template is open in the Outline Editor. For instructions, see “Displaying a
Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the UserInterface part of the outline
so that you view the location where you want to add the template.

3. Right-click the node in which you want to use the template and select New Child >
TemplateReference.

Note: If TemplateReference is not listed in the right-click menu, it is not valid
where you want to use the template.

4. Select the TemplateReference node.

5. In the Properties section of the Outline Editor, specify the following properties:

For this property Specify

Name Name for your own reference purpose. This name does not
appear in the application’s user interface.

Template Template that you want to use.

The list includes the templates that you have added to your
project.

Tip: To update the Java classes that Mobile Development generates for the project
so that your changes are represented in the generated sources, save the project
and regenerate sources. For instructions, see “Generating Sources for a Mobile
Project” on page 46.

Predefined Templates
There are some predefined templates available which can be used to quickly create
commonly used templates without the need to manually create every single element in
these templates. These predefined templates must be transferred via drag and drop to
the templates section in the model. Then the whole content of the predefined template
will be added to the model. Afterwards, the template can be changed and used as any
other template.
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Template Content

Avatar with Text and Icon Contains a TableButton with two dedicated TextFields for
title and description and images for an Avatar and an
arrow.

Is typically used in a ListView to show a list element
which is linked to a details view.

Two-line item Contains a TableButton with two dedicated TextFields for
title and for description.

Using Constraint Layout
Constraint layout allows you to create a user interface for your mobile application
without having to build complex hierarchies for user interface objects in views.
Instead of using absolute positioning, you layout user interface objects according to
relationships between sibling objects and the parent layout.

You use the Layout Builder to build a user interface with constraint layout. With the
Layout Builder, you can

Configure your layout in the Preview tab by dragging and dropping user interface
objects in a parent layout.

Edit the code of your layout template in the text editor of the Model tab.

Insert Java code for your layout template in the Java tab.

To define the position of a user interface object within the layout template, the Layout
Builder uses contraints. A constraint represents a connection or alignment to another
user interface object or to the parent layout. You must define at least one horizontal and
one vertical constraint for each user interface object.

The following images show how to align user interface objects to a parent or to a sibling.
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Object A is vertically and horizontally aligned to the parent layout.

Second object B is vertically and horizontally aligned to the sibling object A.

For more information about how to configure a constraint layout template, see
“Configuring a Constraint Layout Template” on page 106.

For more information about how to create a constraint layout template, see “Creating
a Constraint Layout Template” on page 105 and “Creating a Constraint Layout
Template When Creating a View” on page 105.

For more information about how to delete a constraint layout template, see “Deleting a
Constraint Layout Template” on page 107.

Note: You cannot test a mobile project that uses constraint layout in the Phoney
phone simulator as Phoney does not support constraint layouts.
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Creating a Constraint Layout Template
Create a new constraint layout template if you want to layout your application with the
Layout Builder.

To create a constraint layout template

1. Ensure the mobile project for which you want to create a new constraint layout
template is open in the Outline Editor. For instructions, see “Displaying a Mobile
Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the outline so that you view the
UserInterface > Templates node.

3. Right-click the Templates node and select New Child > Constraint Layout.

Mobile Development opens the Create a new Constraint Layout dialog.

4. In the Name field, enter a name for the layout template using characters, numbers,
and "_". Do not use special characters.

5. In the Select a Constraint Layout Template section, click the layout template you want to
work with.

6. Click OK.

The constraint layout template is created and stored in your_project/ model/
layouts/constraint_layout_name .layout.

Creating a Constraint Layout Template When Creating a View
You can also create a new constraint layout template when creating a view.

To create a constraint layout template when creating a view

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the outline so that you view the
Views node.

3. Make sure that the palee is shown. If the palee is currently hidden, click the arrow
( ) that is shown at the top right of the Outline Editor to display it.

4. Drag the View object from the palee and drop it on the Views node in the Model
section of the Outline Editor.

The Create a new View dialog opens.

5. In the Name field, enter a name for the view.

6. Select the Create a Constraint Layout Fragment check box.
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7. In the Fragment Name field, enter a name for the constraint layout template and select
one of the layout fragments.

8. Click OK.

The constraint layout template is created and stored in your_project/ model/
layouts/constraint_layout_name .layout.

Configuring a Constraint Layout Template
To configure a constraint layout template, you use the Layout Builder. This editor has
three tabs that allow you to edit the code of the layout template, to insert Java code, or to
add and position user interface objects by drag and drop.

To configure a constraint layout template

1. In the Package Explorer, locate the constraint layout template under
your_project/ model/layouts/constraint_layout_name .layout.

2. Double-click the file. Or right-click and select Open with > Layout Builder.

The constraint layout template is opened in the Layout Builder.

3. To edit the code of the layout template, select the Model tab and enter code in the text
editor. Click CTRL+SPACE to use the content assist.

4. To enter Java code for the layout template, select the Java tab and enter your code in
the text editor.

5. To insert and position user interface objects by drag and drop, select the Preview tab
and do one of the following:

a. Select a user interface object from the palee and drop it on the parent layout.

The object is inserted and top-left aligned to the parent layout.

b. To specify constraints, i.e. alignments to sibling user interface objects or the
parent layout, click one of the middle black squared handles around the object
and drag and drop the object so that it is horizontally or vertically aligned to a
sibling or to the parent.
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c. To insert a margin between the object and the sibling or to the parent you aligned
it with, drag and drop the object until the required margin is reached.

d. To resize the object, click one of the black squared handles in the corners of the
object and tear until the required size is reached.

e. In the toolbar of the Layout Builder, you can specify if you want to preview the
layout for smartphone or tablet, in portrait or landscape mode, or as full screen
or side view. You can also modify the preview size.

6. Click CTRL+S to save your layout template.

Deleting a Constraint Layout Template
You can delete a constraint layout template that is not used any longer.

To delete a constraint layout template

1. Ensure the mobile project for which you created the constraint layout template is
open in the Outline Editor. For instructions, see “Displaying a Mobile Project in the
Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the outline so that you view the
UserInterface > Templates node.

3. Locate the respective constraint layout template.

4. Right-click and select Delete from the context menu.

The constraint layout template is deleted from the file system.
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About Adding Application Logic
When you generate sources for a mobile project, Mobile Development generates logic
to handle the display of the views and dialogs in the mobile application. The generated
code is based on the model you define in the Outline Editor. For example, for a view
you design in the Outline Editor, Mobile Development generates logic to operate the
user interface based on the user interface objects you add to a view and the property
seings for each object. As a result, you do not need to add code for this type of logic for
a mobile project. Instead, you can concentrate on the business logic for your application.

When coding the business logic for your application, add your custom code to the user
space, that is, the Java classes that Mobile Development generates in the mobile project’s
src folder.

Caution: Do not add logic to the Java classes in the gen/src or gen/api-src folders. When
you generate sources or when you generate sources and API for a mobile
project, Mobile Development regenerates all the Java classes in those folders.
Changes you make will be lost.

The following tables lists the types of business logic you might want to add to a mobile
application.

Type of Logic Description

General Logic that applies to the entire application.

For example, you might want to add logic to respond when a
user rotates a device from portrait mode to landscape or vice
versa.

View Business logic for a view.

For more information, see “Logic for a View” on page 112.

Dialog Business logic for a dialog.

For more information, see “Logic for a Dialog” on page 113.

Method Name
property

Logic for a Method Name property.

Several user interface objects have a Method Name property where
you can specify a method to invoke at run time. For example,
you specify a method name for the DynamicDropDownListEntryItem
object to identify the method the application executes at run time
to populate the parent DropDownListEntry object. For information,
see “Logic for a Method Name Property” on page 115.



M
Odd Header

Creating Business Logic for a Mobile Application

webMethods Mobile Development Help Version 10.3 111

Type of Logic Description

Property value Logic to programmatically set a property.

Many properties allow you to specify a method name as the
property value. At run time, the application executes the method
to determine the property value. For example, you might want to
programmatically determine the color to use for the Background
Color property for a Tablerow object. To do so, specify the name of
the method that sets the color as the value of the Background Color
property. For information, see “Logic to Programmatically Set a
Property Value at Run Time” on page 115.

Event handling Logic to respond to a user-initiated event.

For more information, see “Responding to User-Initiated Events”
on page 92.

View
transitions

Logic to transition to another view.

For more information, see “Logic to Transition to Another View”
on page 116

Templates Logic for templates to define custom user interface objects.

For more information, see “Creating a Template for a Custom
Object” on page 100.

About the TransitionStackController
Mobile Development provides a Java class named TransitionStackController.java in the gen.api-
src/com.softwareag.mobile.runtime.toolkit.ui.controller package. Unless you override the use of
TransitionStackController.java, applications you create using Mobile Development use the
logic in TransitionStackController.java at run time to:

Add Back buons to views when the application creates a view.

Set the text that displays on Back buons to display the header text from the
previous view.

Transition to the previous view when a user presses the Back buon.

A TransitionStackController keeps track of the view displayed in each pane of the
application’s window and each NavButton object in a NavView object. It keeps track
by pushing view controllers on to a controller stack. For example, as an application
transitions the views in a pane from one view to the next, the TransitionStackController
pushes the new controller onto the controller stack. As a result, when the user presses
the Back buon, it pops the controller for a view from the controller stack and transitions
to that view.
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In the Java sources that Mobile Development generates, TransitionStackController.java
is imported into the abstract controller for each view. For example, if you
have a view named DetailView, TransitionStackController.java is imported
into AbstractDetailViewController.java. As a result, you can use the methods of
TransitionStackController.java to customize the use of the TransitionStackController in the logic
that you code for a view. For example you can push new controllers on to the controller
stack, remove the last controller from the controller stack, or force the controller stack
to go to the first controller pushed on the stack. For more information about Java
sources generated for your mobile project, see “Java Sources that Mobile Development
Generates” on page 47.

If you do not want to use the TransitionStackController for a mobile application, you can
disable it. However, if you disable the TransitionStackController, you will need to add
application logic to handle transitions back to previous views. To prevent the use of
the TransitionStackController, override the createTransitionStackController() method, which
is in AbstractApplicationController.java in the gen.api-src.com.softwareag.mobile.runtime.toolkit
package. To override this method, add the createTransitionStackController() method to
the application_name ControllerImpl.java file that Mobile Development generates in the
src.package_name .ui.controller.impl package. For example, for a mobile project, if you
assigned the application the name “MyApp” and the package name “com.mycompany”,
you add the createTransitionStackController() method to MyAppControllerImpl.java in the
src.com.mycompany.ui.controller.impl package. The following shows sample code. Note that
this code sample assumes a view named “MyView” exists.
public boolean createTransitionStackController(nUIObject sender, 
                                      PaneConfiguration pc, 
                                      PaneDefinition pane, 
                                      AbstractViewController assignedAVC)  { 
    if (assignedAVC instanceof MyViewControllerImpl)  { 
         return false; 
         } 
         return true; 
    }

Logic for a View
When you generate sources for a mobile project, Mobile Development generates a
Java class named view_name ControllerImpl.java in the src.package_name .ui.controller.impl
package. For example, if you assigned the view the name “MyView” and the package
name “com.mycompany”, Mobile Development generates MyViewControllerImpl.java in the
src.com.mycompany.ui.controller.impl package.

Add business logic for a view to the view_name ControllerImpl.java file.

When initially generated, the view_name ControllerImpl.java file contains several methods
that are commented out that you might want to uncomment and implement. For more
information, see “Common Methods to Override in the Generated Code for a View” on
page 119.
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Logic for a Dialog
Logic to Display a Dialog

You can open a dialog in the following ways:

Open a dialog in response to a listener event.

If you want to open a dialog in response to a listener event, add an OpenDialog object
to the model and select the name of the dialog you want to open for the OpenDialog
object’s Dialog property. For more information, see “Responding to User-Initiated
Events” on page 92 and “OpenDialog Properties” on page 219.

Open a dialog by creating the dialog class.

To create the dialog class, invoke the class that Mobile Development generates for
the dialog, for example, MyAlertDialog.java, where MyAlertDialog is the value you
specified for the AlertDialog object’s Class Name property. For example:
call new MyAlertDialog(delegate).open();

In the code line to create the dialog, delegate is an instance of iDialogDelegate. By
default, all abstract controllers implement iDialogDelegate.

Open a dialog by invoking the openDialog method, which is in
the AbstractApplicationController.java in the gen/api-src folder in the
com.softwareag.mobile.runtime.toolkit package. In this case, pass a generated instance of an
AbstractAlertDialog to the openDialog() method.

For example, for an application named "MyApplication" and a dialog named
"MyAlertDialog", you can use the following:
MyApplicationControllerImpl.openDialog(new MyAlertDialog(dialogDelegate));

Note: Only one dialog can be opened at the same time.

Logic to Close a Dialog

A dialog closes when a user presses any buon in the dialog.

You can also programmatically close a dialog by invoking the closeDialog() method, which
is in the AbstractApplicationController.java in the gen.api-src.com.softwareag.mobile.runtime.toolkit
package.

Additional Logic

When you add a dialog object to the user interface, you can add one or several
DialogButton object(s) as a child object. When you generate sources for the mobile project,
Mobile Development generates code to:

Display the alert dialog with the text you specify in the AlertDialog object’s Text
property.
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Display the pop-up menu with the text you specify in the PopupMenu object’s Cancel
Text property.

If you want a dialog that simply displays text with a single close buon, you do not need
to add any further custom code.

If you want to perform additional logic in the dialog or add additional DialogButton child
objects, you can customize the logic for the dialog.

When you generate sources for a mobile project, Mobile Development generates a Java
class for the dialog where you can add your custom logic. The name of the Java class is
the name you specify for the dialog object’s Class Name property. Mobile Development
generates the class in the src folder in the package_name .ui.dialog package. For example, if
you specify "MyAlertDialog" for the Class Name property and assign the package name
"com.mycompany" to the mobile project, Mobile Development generates MyAlertDialog.java
in the com.mycompany.ui.dialog package.

When a user presses a buon in the dialog, the onDialogButtonPressed(final AbstractDialog
dialog, final intbuonID ) method in the iDialogDelegate Java class is invoked. The buonID  is
the value of the Id property that you specified for the DialogButton object in the model. If
a dialog contains multiple buons, your logic can identify the buon a user selected and
take action based on the specific buon the user pressed. The following shows sample
logic:
public void onDialogButtonPressed(AbstractDialog dialog, 
            int buttonId) { 
    switch (buttonId) { 
    case YMNDialog.YESBUTTON: 
         getView().getDialogResult().setText("YES !!!"); 
         break; 
    case YMNDialog.MAYBEBUTTON: 
         getView().getDialogResult().setText("MAYBE !!!"); 
         break; 
    case YMNDialog.NOBUTTON: 
         getView().getDialogResult().setText("NO !!!"); 
         break; 
  
    default: 
         break; 
    } 
    dialog.close(); 
}

For a PopupMenu object, you can also add buons dynamically. To do so, you must
override the initDialog() method in the generated PopupMenuName class. In this class, you
must call the super method to initially create the pop-up menu. Then you can add the
required buons as follows:
protected nUIPopupMenuBuilder initDialog() {
    nUIPopupMenuBuilder popupMenuBuilder = super.initDialog();
    popupMenuBuilder.addItem("dynamicButton", new Runnable() {
        public void run() {
            // handle this
        }
    });
    return popupMenuBuilder;
}
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You can also dynamically decide which buons should be shown or hidden in a
pop-up menu. In this way, you can define the menu completely in the model and
programmatically decide which buons to show or hide depending on the current data.
The following shows the sample logic:
public boolean showDialogButton(AbstractDialog dialog, int buttonId) {
    switch (buttonId) {
        case Constants.NUIID_BUTTON1:
            return shouldButton1BeVisible();
        case Constants.NUIID_BUTTON2:
            return shouldButton2BeVisible();
        default:
            return true;
    }
}

Logic for a Method Name Property
Several user interface objects have a Method Name property where you can specify
a method to invoke at run time. For example, you specify a method name for the
DynamicDropDownListEntryItem object to identify the method the application executes at
run time to populate the parent DropDownListEntry object.

If you specify a method in a Method Name property, when you generate sources,
Mobile Development generates the method in the abstract controller for the
associated view. Mobile Development generates the abstract controller, which is
named Abstractview_name Controller.java, in the gen/src folder in the package_name .ui
package. For example, if you specify the Method Name property for a user interface
object in the view named “MyView” and you assign the mobile project the
package name “com.mycompany”, Mobile Development generates the method in
AbstractMyViewController.java in the com.mycompany.ui package, which is in the gen/src folder.

To add the logic to the method, first you must add the method to the user space, that
is, into the view_name ControllerImpl.java file in the package_name .ui.controller.impl package in
the src folder. For example, continuing with the previous example, you add the method
to MyViewControllerImpl.java in the com.mycompany.ui.controller.impl package, which is in the src
folder. After adding the view to the user space, you can add your custom logic.

Caution: Do not add your logic to Abstractview_name Controller.java. When you generate
sources, Mobile Development regenerates this class and your changes will be
lost.

Logic to Programmatically Set a Property Value at Run Time
Many properties allow you to specify a method name as the property value. At run time,
the application executes the method to determine the property value. For example, you
might want to programmatically determine the color to use for the Background Color
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property for a Tablerow object. To do so, specify the name of the method that sets the
color as the value of the Background Color property.

At run time, no input parameters will be passed to the method. The output from the
method must be a suitable value for the property. For example, if you are using a
method for a color, the output must be a value that specifies a color in a suitable format.

Where you place the code for the method depends on whether you specified a relative
method name or a fully-qualified method name for the property value.

Relative method name

When you specify a relative method name, Mobile Development generates the
method in the abstract controller for the associated view. The actions you take to add
logic to the method are the same as when you use a Method Name property. For more
information, see “Logic for a Method Name Property” on page 115.

Fully-qualified name

When you specify a fully-qualified method name, the method you specify must exist
in a Java class you create. It is recommended that you save the Java class in a location
within the project’s src folder so that all the code you maintain is in one folder.

Ensure the methods that you create are static so that no instance of the class needs to
be in existence.

Logic to Transition to Another View
Where you add logic to transition from one view to another depends on when you want
the application to transition:

If you want to transition based on a user-initiated event, for example, when a user presses a
buon in the user interface, you can use the Transition event action object.

When you use the Transition event action object, you do not need to add any
code if you simply want to transition to another view. However, if you want to
perform actions before or after the transition, you can add custom code. For more
information, see “Responding to User-Initiated Events” on page 92.

If you want to transition back to the previous view when the user presses
the Back button, typically you do not need to add logic. The Mobile
DevelopmentTransitionStackController provides logic for transitioning to previous views.
For more information, see “About the TransitionStackController” on page 111.

The following lists circumstances when you need to add logic to transition back to
previous views:

You disabled the TransitionStackController.

When you disable the TransitionStackController, your application logic must keep
track of the views that the application displays and how to transition back.

You set the Hide Back Button property for the view to true.
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When you hide the view’s back buon, but have the TransitionStackController
enabled, you can use the following code to transition back to a previous view:
getTransitionStackController().popViewController();

If you want to transition to another view for any other reason, you need to add code to your
view to perform the transition.

Unless you take steps to disable the Mobile DevelopmentTransitionStackController, it is
enabled and you can use the methods in TransitionStackController.java to transition to the
new view. To perform the transition you need to:

Push the controller for the view to which you are transitioning on the controller
stack.

Transition to the new view.

The following shows sample code to transition to a new view named
“MySecondView”.
getTransitionStackController().pushViewController(new 
MySecondViewControllerImpl());

The following shows a sample method you can you use to transition from a view
named “MasterView” to a view named “DetailsView”. You would place this code in
the MasterViewControllerImpl in the src folder.
public void doTransition() 
    final AbstractViewController target = new DetailsViewController(); 
    getTransitionStackController.pushViewController(target); 
}

If you disabled the TransitionStackController, add the logic that you provide to keep track
of the view to which you are transitioning and to perform the transition to the new
view.

Common Methods to Override in the Generated Code for the
Application
When you generate sources for a mobile project, Mobile Development generates a Java
class named application_name AppControllerImpl.java, where application_name  is the name
you assigned the application. The application_name AppControllerImpl.java file resides in the
src.package_name .ui.controller.impl package, where package_name  is the package name you
specified for your mobile project.

Mobile Development provides a set of methods for the controller implementation that
represents the application's life-cycle. These methods are starting points for defining the
custom business logic.
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Method Description

onCreateWindow() This method is executed after the main window for the
application is created. Add logic to this method if you
want to customize the main window of the application.

onOrientationChange() This method is executed when the user rotates the
device and changes the device’s orientation from
portrait to landscape or vice versa. Add logic to this
method that you want performed when a device is
rotated, for example, redisplay the user interface for
the new orientation.

By default, this method updates the dimensions of
the panes in the window. If you need to take further
action, you can uncomment the onOrientationChange()
method and add your custom logic.

onMessage(PushNotification
notification)

This method is called after a push notification
was received by the device while the app
is running. If the app is not running, the
onStartAppFromPushNotification(PushNotification) method
is called. The passed PushNotification object contains
a string (representing the message) and parameters
which were sent with the push notification.

onPushNotificationError(String) This method will be called if a push notification results
in an error.

createSideViewController() This method is called once the user calls
getSideViewController() on the AbstractApplicationController.
It will create a new SideViewController. Overwrite this
method to publish your own implementation.

onDeviceRegistered(String) This method is called after the device is registered to
receive push notifications.

Once the device is registered on the platforms push
notification service (GCM or APNS), a registration id is
created to identify this application. This id will be send
to the application, which results in calling this method.
Overwrite this method to publish the registration id to
your project's backend push registration service.

updatePaneDimensions() This method is called by onOrientationChange after
the user has rotated the device. The default
implementation tries to re-size all panes to the new
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Method Description
dimensions. You can overwrite this method if you want
to have pane dimensions other than those provided by
the default implementation.

onStartAppFromPushNotification
(PushNotification notification)

This method will be called if the app receives a push
notification, but is not running. As a counterpart,
onMessage(PushNotification) will be called if the app
receives a push notification and is running or in the
background.

onStartAppFromURL(String
scheme, String url)

Will be called when the application is started from
an URI scheme it is registered for. The registration
needs to be defined in targets/_default_.xml. For
detailed information, refer to Defining Data Sharing for
an Application in webMethods Mobile Designer Native User
Interface Reference.

onStartAppFromFile(String
mimeType, String
absolutePath)

Will be called when the application is started by
passing a file into the application. The mime-type is
provided as well as the absolute path to read the file
from.

Common Methods to Override in the Generated Code for a
View
When you generate sources for a mobile project, Mobile Development generates a Java
class named view_name ControllerImpl.java, where view_name  is the name you assigned to
the view. The view_name ControllerImpl.java file resides in the src.package_name .ui.controller.impl
package, where package_name  is the package name you specified for your mobile project.

Mobile Development provides a set of methods for the controller implementation that
represents the view's life-cycle. These methods are starting points for defining the
custom business logic.

Method Description

onTransitionTo() This method is executed after the view is created, but
before the application transitions to the view. Add
logic to this method if you want to customize the view,
for example to add or remove controls.

onTransitionFrom() This method is executed before transitioning from the
current view to another view. Add logic to this method
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Method Description
if you want to take action before the view is removed,
for example, to save data.

onAlertDialogButtonPressed() This method is executed when a user presses a buon,
(an AlertDialogButton object) in an alert dialog (an
AlertDialog) object. The method is passed the identifier
that you specify in the AlertDialogButton object’s Id
property so that your logic can determine the buon
the user selected. Add logic to this method to perform
the actions you want to take when a user presses a
buon.

onBackButtonEvent() This method is executed when a user presses the
view’s Back buon. By default, applications you
create using Mobile Development use the provided
TransitionStackController, and as a result, the default
behavior is to transition back to the previous view,
if any. Add logic to this method if you want to
override this default Back buon behavior. For more
information about the TransitionStackController, see “About
the TransitionStackController” on page 111.

hidesBackButton() This method is executed when the view is about
to be displayed for all views except the first view,
which does not have a Back buon. By default,
applications you create using Mobile Development use
the provided TransitionStackController, and as a result, the
default behavior is that the view is created with a Back
buon. Use this method to hide the Back buon if you
do not want the view to have a Back buon.

Note: If your application does not use the
TransitionStackController, views do not automatically
have a Back buon. You manually add a Back
buon to the view using the addBackButton()
method.

For more information about the TransitionStackController,
see “About the TransitionStackController” on
page 111.

getBackButtonTitle() This method is executed when adding the Back
buon to the view. By default, applications you
create using Mobile Development use the provided
TransitionStackController, and as a result, the default
behavior is to use the header text of the previous view
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Method Description
on the Back buon. Use this method to override the
text used on the Back buon, for example, to change
the text to simply “Back”.

nUIEventCallback() This method receives control when a user-initiated
event occurs for any control in the view. Add logic to
this method if you want to override event handling.

You have to call the super method so that the default
event implementations are not disabled:
public void nUIEventCallback() { 
  super.nUIEventEventCall(); 
 }

initBindings() This method is about to be executed when the
controller tries to update the modeled bindings. This
method is executed after all parts of the view have
been created. All user interface elements for the view
will be created at execution time.

onUISynced() This method is called after onUIViewDisplay#onUISynced()
is called by the platforms UI layer. This is typically
the case after the elements within the view are
arranged or changes on the elements are applied.
When this method is called, it is save to get all absolute
dimensions for the view or the containing UI elements.

Common Methods to Override in the Generated Code for a
Template
When you generate sources for a mobile project, Mobile Development generates a Java
class named template_name .java, where template_name  is the class name you assigned to
a template. The template_name .java file resides in the src.package_name .ui.template package,
where package_name  is the package name you specified for your mobile project.

Mobile Development provides a set of methods for the template. These methods are
starting points for defining the custom business logic.

Method Description

init() This method is executed after the template has been
initialized. It creates the contents of the template. If you
want to override this method, you have to add a call to
the super method.
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Method Description

onTemplateCreated() This method is executed by init() after all contents have
been created. You can add custom business logic to this
method.

onAlertDialogButtonPressed() This method is executed when a user presses a buon,
(an AlertDialogButton object) in an alert dialog (an
AlertDialog) object. The method is passed the identifier
that you specify in the AlertDialogButton object’s Id
property so that your logic can determine the buon
the user selected. Add logic to this method to perform
the actions you want to take when a user presses a
buon.

initBindings() This method is about to be executed when the
controller tries to update the modeled bindings. This
method is executed after all parts of the template
have been created. All user interface elements for the
template will be created at execution time.

Using the Sync Component Object
webMethods Mobile Suite provides capabilities to enable offline data synchronization.
This means that a specific set of data can be transmied from a device to a dedicated
server, and vice versa, and conflicts are automatically resolved. With the Mobile Suite,
the Mobile Support library does all the communication with the host and provides
information when a data object is added, changed, or deleted. For more information
about Mobile Support, see Developing Data Synchronization Solutions with webMethods
Mobile Support, which is part of the Integration Server documentation.

Mobile Support, however, is only responsible for synchronizing the data with a server.
In the application, the data still needs to be persisted to enable proper offline support.
To facilitate the development with Mobile Support, Mobile Development builds a library
on top to achieve the offline support and provides a SyncComponent object to configure
and implement the connection. See “Adding the SyncComponent Object” on page 65 and
“Services Object Reference” on page 223.

When the SyncComponent object is added to a project, Mobile Development
generates a number of API classes. After adding the SyncComponent object, it is
therefore required to regenerate the API classes. The SyncComponent object itself
behaves like a RESTful service and can be added to a RESTDataSource object as a
REST method. Once the SyncComponent object has been added to the project, the
singleton instance can be accessed using the AbstractApplicationController#getSyncClient
method. You can thus start or stop the synchronization or even aach a
com.softwareag.mobile.runtime.toolkit.delegates.ISyncClientListener to get information about status
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changes, for example, when the synchronization is about to start or if an exception has
occurred.

When you use the SyncComponent object as a REST method for a RESTDataSource,
the synchronization will start automatically. Otherwise, you have to start it
programmatically by calling #start() on the common instance. Before starting, make sure
that all credentials have been set. As known from RESTful services, the SyncComponent
object is prepared to use the credentials placed on the common Session object. For more
information about providing credentials, see the code snippet in “Configuring a Session
Object with Credentials” on page 148.

To synchronize data, the SyncComponent object establishes a synchronization process:

1. First, it tries to load local data from the underlying SQLite database.

2. If no data is stored, it downloads all data from the dedicated server. If data is stored,
it asks the server whether there are any updates for this data set.

3. Incoming data is stored in the database. It performs delete, update and add
operations to keep the local data up-to-date.

When the synchronization process is complete, it is restarted after a specific update
interval, as specified in the application model or as set programmatically. This
ensures an ongoing synchronization during the entire run time of the application.
Synchronization only stops if an exception occurs with the communication, for example,
if there is no connection to the network. For such a case, you have to implement an
ISyncClientListener and restart the SyncComponent object.
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Validating the Application Model
You can check whether all of your definitions for the application model are valid. Your
model is invalid, for example, if a name you specified contains special characters that are
not allowed or if a required property has not yet been defined.

If one or more errors are detected, the number of errors is indicated in a message at the
top of the Outline Editor, for example, "9 errors detected". When you move the mouse
pointer over this message, a tooltip appears informing you what you must do to fix the
errors.

Mobile Development automatically validates an application model when you save your
changes to it. When entering a name, its characters are checked while you enter them.
However, you can also validate the application model manually at any time.

To validate the application model manually

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. Click Validate Application Model in the toolbar of the Outline Editor.

3. Check the area to the left of the Outline Editor's toolbar to see whether errors have
been detected.

Testing a Mobile Project with Phoney
You can test your mobile project by running it in the Phoney phone simulator. You can
specify run configurations for testing as described in “Specifying a Run Configuration
for Local Testing” on page 127.

For more information on Phoney, see Using webMethods Mobile Designer.

To test your application

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. If you have unsaved changes, select File > Save to save your project.

3. In the Outline Editor, right-click and select Generate Source Code > Application Model.
This step is required if the sources for the application model do not yet exist.
Otherwise, it is optional.

4. To test the application, click  in the toolbar of the Outline Editor.

Your application is run in the Phoney phone simulator.
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Note: Instead of using the toolbar buon, you can also run the corresponding Ant
targets. For detailed information about available Ant targets and how to use
them, see Using webMethods Mobile Designer.

Specifying a Run Configuration for Local Testing
Before you test your mobile project in Phoney, you can create or modify a run
configuration for this project.

To create or modify a run configuration:

1. Locate the mobile project in the Package Explorer.

2. Right-click, and select Run As > Run Configurations... from the context menu.

3. In the Run Configurations dialog box, do one of the following:

a. Select an existing run configuration for a mobile project from the Mobile: Phoney
list on the left side.

b. Create a new run configuration for a mobile project by selecting the project from
the Mobile: Phoney list on the left side and then clicking  in the toolbar.

4. On the Phoney tab on the right side, modify the information as required:

For this section And this field You can do this

Project Click Browse, and locate the mobile
project.

Build Properties

Device Type Specify the platform (Android or
iOS), the device (smartphone or
tablet), and the orientation (portrait
or landscape).

5. Click Apply to save the changes, or click Revert to restore the original specification.

6. To run the test immediately, click Run. Otherwise, click Close.

Building a Mobile Project
To create a build of a mobile project, you can generate project source files and build
these source files to create one or more final binaries that are installable on devices.

For detailed information about how to install these binaries on devices, refer to Using
webMethods Mobile Designer.
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You can also launch an emulator from the Package Explorer view to install the binaries
for Android on an Android device. For detailed information, see “Installing an
Application on Android Using the Emulator” on page 135.

If you are working on Mac OS, you can launch a simulator from the Package Explorer
view to install the binaries for iOS on an iOS device. For detailed information, see
“Installing an Application on iOS Using the Simulator” on page 135.

Two build types are available:

Multi-Build Allows you to build your project for multiple platforms on your local
development machine. For more information, see “Running a Local Multi-Build” on
page 128.

For this build type, you can optionally specify run configurations, see “Specifying a
Run Configuration for a Local Multi-Build” on page 129.

Jenkins Build. Allows you to build your project for multiple platforms on a Jenkins
server. This can be necessary if you want to build for an iOS platform on a Windows
machine.

Before you can run a build on Jenkins, you must configure a Jenkins server as a build
environment for mobile applications. This is explained in detail in Using webMethods
Mobile Designer. In addition, you must configure a Jenkins server connection in the
Mobile Development preferences as described in “Mobile Development Preferences”
on page 28.

For this build type, it is required to specify run configurations, see “Specifying a Run
Configuration for a Jenkins Build” on page 132.

For more information on how to run a Jenkins build, see “Running a Jenkins Build”
on page 131.

Running a Local Multi-Build
You can build your mobile project for multiple platforms on your local development
machine. Optionally, you can specify run configurations as described in “Specifying a
Run Configuration for a Local Multi-Build” on page 129.

Note: Before you can run a build, you must generate the project source files as
described in “Generating Sources for a Mobile Project” on page 46.

To run a local multi-build

1. Locate the mobile project in the Package Explorer.

2. Right-click, and select Run As > Local Android Build or Run As > Local iOS Build from the
context menu.

A local build is run on your development machine. The final binaries for Android and
iOS are stored under your_mobile_project /Builds/version . You can install these files on
devices as described in Using webMethods Mobile Designer.
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Note: Instead of using the Run As option, you can also run the corresponding Ant
targets. For detailed information about available Ant targets and how to use
them, see Using webMethods Mobile Designer.

Specifying a Run Configuration for a Local Multi-Build
Before you run a local multi-build of your mobile project, you can create or modify a run
configuration for this project.

To create or modify a run configuration:

1. Locate the mobile project in the Package Explorer.

2. Right-click, and select Run As > Run Configurations... from the context menu.

3. In the Run Configurations dialog box, do one of the following:

a. Select an existing run configuration for a mobile project from the Mobile: Multi
Build list on the left side.

b. Create a new run configuration for a mobile project by selecting the project from
the Mobile: Multi Build list on the left side and then clicking  in the toolbar.

4. On the General tab on the right side, modify the information as required:

For this section And this field You can do this

Project Click Browse, and locate the mobile
project.

Version Enter the version number.

Build Number Enter the build number.

Build Properties

Retain build files Select if you want to keep the build
files (default). Otherwise, deselect.

 Select if you want to build for an
Android platform, and specify the
following fields.

Build for Android

Target Select from the following build
types:

Release (Only use for debug and
test purposes on your devices.
The source code will not be
obfuscated.)
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For this section And this field You can do this

Debug (Use to publish the final
build. The source code will be
obfuscated.)

Bundle Id Enter the bundle id.

Path to a keystore Click Browse, and locate the
required keystore.

 Select if you want to build for
an iOS platform, and specify the
following fields.

Target Select from the following build
types:

AppStore (Use for distribution
in Apple's App Store. The final
build can be uploaded to the App
Store.)

Enterprise (Use for inhouse
distribution. The final build
can be distributed within your
organization.)

Ad Hoc (Use for inhouse
distribution for testing. The final
build can be installed on a limited
number of registered devices.)

Dev (Use for testing. The final
build can be installed on test
devices.)

Sim (Use for testing in a simulator.
This target does not require a
provisioning profile.)

XCode project (Only an Xcode
project will be created. Use this
target if you want to use Xcode
to debug an application in a
simulator).

Build for iOS

Bundle Id Enter the bundle id.
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For this section And this field You can do this

Path to a
Provisioning
Profile

Click Browse, and locate the
required provisioning profile.

5. Click Apply to save the changes, or click Revert to restore the original specification.

6. To run the build immediately, click Run. Otherwise, click Close.

Running a Jenkins Build
You can build your mobile project for multiple platforms on a Jenkins server.

Note: Before you can run a build, you must generate the project source files as
described in “Generating Sources for a Mobile Project” on page 46. You
can also have Jenkins generate the project source files as a step in the build
process. To do so, select Enable code generation with the next build in the Jenkins
run configurations.

To run and download Jenkins build

1. Locate the mobile project in the Package Explorer.

2. Right-click, and select Run As > Run Configurations... from the context menu.

3. In the Run Configurations dialog box, specify or use the existing run configurations
as described in “Specifying a Run Configuration for a Jenkins Build” on page 132,
and click Run.

A build is run on the Jenkins server you configured. You can monitor the progress
and result of the Jenkins build in the Jenkins Build Explorer view. The view lists
the build sorted by build number. If you expand a build number, you see the final
binary files.

4. To download a build file, right-click the respective file name and select Download
from the context menu.

5. In the Select a Mobile Project dialog, select the mobile project you ran the build for,
and click OK.

The build file is stored in Builds/artifacts/version-buildnumber .

You can install the build files on devices as described in Using webMethods Mobile
Designer. For Android build files, you can use a built-in emulator. For more information,
see “Installing an Application on Android Using the Emulator” on page 135. If you
are working on Mac OS, you can use a built-in simulator. For more information, see
“Installing an Application on iOS Using the Simulator” on page 135.



M
Even Header

Testing, Building, and Installing a Mobile Application

webMethods Mobile Development Help Version 10.3 132

Specifying a Run Configuration for a Jenkins Build
Before you run a Jenkins build of your mobile project, you must create a run
configuration for this project.

To create or modify a run configuration:

1. Locate the mobile project in the Package Explorer.

2. Right-click, and select Run As > Run Configurations... from the context menu.

3. In the Run Configurations dialog box, do one of the following:

a. Select an existing run configuration for a mobile project from the Mobile: Jenkins
Build list on the left side.

b. Create a new run configuration for a mobile project by selecting the project from
the Mobile: Jenkins Build list on the left side and then clicking  in the toolbar.

4. On the Jenkins tab on the right side, modify the information as required:

Important: If you run the build, the following properties are stored for all future
builds that use this run configuration and cannot be modified any longer:

Project, Server, Build Node Label, and Installation Directory

Target Bundle, Id, and Job Name (both for Android and iOS builds)

If you want to run a build of your mobile project with different
properties, you must specify a new run configuration.

For this section And this field You can do this

Project Click Browse, and locate the Mobile
Project.

Server Enter a Jenkins server you specified
in the Mobile Development
preferences.

Click Add a Jenkins build server to
specify a new server connection as
described in “Mobile Development
Preferences” on page 28.

Build Properties

Build Node Label iOS builds cannot be done on a
Windows machine. If Jenkins is
running on Windows and you
want to build for iOS, you must set
up a slave and enter the name of
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For this section And this field You can do this
the Jenkins slave that executes the
build job in this field.

Installation
Directory

Enter the path to the Mobile Suite
on the Jenkins slave.

Version Enter the version number.

Code Generation Select Enable code generation with the
next build to have Jenkins generate
the project source files before
building the project. Deselect, if
you want to skip this step.

 Select if you want to build for an
Android device, and specify the
following fields.

Target Select from the following build
types:

Release (Only use for debug and
test purposes on your devices.
The source code will not be
obfuscated.)

Debug (Use to publish the final
build. The source code will be
obfuscated.)

Bundle Id Enter the bundle id.

Build for Android

Job Name The name of the Jenkins job. The
job contains the necessary build
steps to build a mobile application.
You can specify the name or
use the default name. Entering
${projectName} uses the name of
the mobile project in Software AG
Designer as a parameter.

Build for iOS  Select if you want to build for
an iOS device, and specify the
following fields.
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For this section And this field You can do this

Target Select from the following build
types:

AppStore (Use for distribution
in Apple's App Store. The final
build can be uploaded to the App
Store.)

Enterprise (Use for inhouse
distribution. The final build
can be distributed within your
organization.)

Ad Hoc (Use for inhouse
distribution for testing. The final
build can be installed on a limited
number of registered devices.)

Dev Release (Use for testing. The
final build can be installed on test
devices.)

Sim Release (Use for testing in a
simulator. This target does not
require a provisioning profile.)

XCode project (Only an Xcode
project will be created. Use this
target if you want to use Xcode
to debug an application in a
simulator).

Bundle Id Enter the bundle id.

Job Name The name of the Jenkins job. The
job contains the necessary build
steps to build a mobile application.
You can specify the name or
use the default name. Entering
${projectName} uses the name of
the mobile project in Software AG
Designer as a parameter.

5. Click Apply to save the changes, or click Revert to restore the original specification.

6. To run the build, click Run. Otherwise, click Close.
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Installing an Application on Android Using the Emulator
You can launch an emulator from the Package Explorer view to install the final binaries
for Android on an Android device. The device must either be a physical device
that is connected via USB to your machine. Or it can be an Android Virtual Device
(AVD) that you configured in Android Studio. For more information, see “hps://
developer.android.com/studio/run/managing-avds”.

Note: You must specify the path to the default Android SDK that you want Mobile
Development to use to compile mobile applications for Android devices.
You can either configure the ANDROID_SDK_ROOT environment variable as
described in “hps://developer.android.com/studio/command-line/variables”.
Or you can configure the android.bin.dir.root property in the sdk.properties as
described in Using webMethods Mobile Designer, Configuring Mobile Designer for
the Android SDK.

To install an application on Android

1. In the Package Explorer view, locate the respective .apk file.

2. Right-click, and select Mobile Tools > Run in Emulator from the context menu.

3. In the List of Devices and AVDs dialog box, select a physical device or an AVD, and
click OK.

The application is installed on your Android device or AVD and displayed in the
emulator.

Installing an Application on iOS Using the Simulator
If you are working on Mac OS, you can launch a simulator from the Package Explorer
view to install the final binaries for iOS on an iOS device. The device must either be a
physical device that is connected via USB to your machine or it can be an iOS simulator.

To install an application on iOS

1. In the Package Explorer view, locate the respective .app file.

2. Right-click, and select Mobile Tools > Run in Simulator from the context menu.

3. In the List of Devices and Simulators dialog box, select a physical device or an iOS
simulator, and click OK.

The application is installed and displayed on your iOS device or iOS simulator.

https://developer.android.com/studio/run/managing-avds
https://developer.android.com/studio/run/managing-avds
https://developer.android.com/studio/command-line/variables
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Renaming a Mobile Project
You initially set the name of the mobile project when you create the project using the
New Mobile Development Project wizard. If needed, you can change the mobile project
name.

Note: If you want to change the name of the application, see “Renaming the
Application” on page 138.

To rename the mobile project

1. In the Package Explorer, right-click the top-level node for the project and select
Refactor > Rename.

2. In the New name field, type the new name you want to assign to the mobile project.

3. Leave the Update references check box as is. This check box will not affect mobile
projects.

4. Click OK.

Renaming the Application
You initially set the application when you create the project using the New Mobile
Development Project wizard. If you want to change the application name you specified
in the wizard, you can do so by updating the Name property for the root application
node.

Note: If you want to change the name of the mobile project, see “Renaming a Mobile
Project” on page 138.

To rename the application

1. Ensure the mobile project is displayed in the Outline Editor. For instructions, see
“Opening the Mobile Development Perspective” on page 22.

2. In the Model section of the Outline Editor, expand the project so that you can view
the top-level child node that represents the root application for the project.

3. Select the root application node.

4. Type the new name for the application in the Name property, which is displayed in
the Properties section of the Outline Editor.

5. Save the mobile project.

6. Generate sources for the updated mobile project. For instructions, see “Generating
Sources for a Mobile Project” on page 46.
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Mobile Development generates a new new_app_name AppControllerImpl.java Java
class for the application where new_app_name  is the new name you assigned to the
application.

Mobile Development does not remove the old_app_name AppControllerImpl.java
Java class, where old_app_name  is the previous name of the application. Mobile
Development retains this file in the event that you previously added custom code to
the old_app_name AppControllerImpl.java Java class.

7. Update the new_app_name AppControllerImpl.java Java class with any custom code
that you added to the old_app_name AppControllerImpl.java Java class.

a. In the Package Explorer or Navigator view, locate the src > package  > ui > controller
> impl folder, which contains both the new_app_name AppControllerImpl.java and
old_app_name AppControllerImpl.java Java classes.

b. Open both Java classes and copy all custom code from the
old_app_name AppControllerImpl.java to new_app_name AppControllerImpl.java.

c. Save both files.

d. Delete the old_app_name AppControllerImpl.java Java class.

Changing the Package Name
You initially define the package name for a mobile project when you create the project
using the New Mobile Development Project wizard. If you want to change the seing
you specified in the wizard, you can do so by updating the Bundle Id property for the
root application node.

To change the package name for a mobile project

1. Ensure the mobile project is displayed in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the project so that you can view
the top-level child node that represents the root application for the project.

3. Select the root application node.

4. In the Properties section of the screen, type the new package name in the Bundle Id
property.

5. Save the mobile project.

6. In the Outline Editor, right-click and select Generate Mobile Designer Sources to
regenerate the sources for your project so that your changes are incorporated.

Mobile Development generates new Java classes for the project that use the new
package name.

In the project’s gen/src folder, Mobile Development removes the Java classes that use
the old package name, replacing them with Java classes that use the new name.
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In the src folder, Mobile Development creates new Java classes that use the new
package name, but retains all existing Java classes that use the old package name.
Mobile Development retains the files with the old package name in the event that
you previously added custom code to them.

7. For each Java class in the src folder that contains custom code that you need added,
copy the code from the old Java class files into the corresponding new Java class files.

Look for custom code that you might have added in Java classes that reside in the
following, where old_package  is the old package name:

src.old_package .ui.controller.impl

src.old_package .ui.templates

8. Delete the following folders, where old_package  is the old package name:

src.old_package .ui.controller/impl

src.old_package .ui.templates

Note: Mobile Development does not automatically delete these files because you
might have added custom code that you need to copy, as described in the
previous step.



M
Odd Header

Managing Personal Data

webMethods Mobile Development Help Version 10.3 141

13   Managing Personal Data

■   About Personal Data ..................................................................................................................    142

■   Modifying Personal Data in Mobile Development Preferences ..................................................    142

■   Modifying Personal Data on a Jenkins Server ..........................................................................     142



M
Even Header

Managing Personal Data

webMethods Mobile Development Help Version 10.3 142

About Personal Data
Legislation in various parts of the world means that personal data cannot be collected
and processed without a person’s consent. Personal data covers details that can be used
to identify a person, including their name, email address, and IP address.

Mobile Development uses and stores personal data when:

Specifying Mobile Development preferences in Software AG Designer. For more
information about how to modify this data, see “Modifying Personal Data in Mobile
Development Preferences” on page 142.

Specifying Mobile Development seings on a Jenkins server. For more information
about how to modify this data, see “Modifying Personal Data on a Jenkins Server”
on page 142.

Modifying Personal Data in Mobile Development Preferences
When seing Mobile Development preferences in Software AG Designer, the Jenkins
server user credentials are stored in Eclipse secure storage.

To modify or delete this information

1. Do one of the following:

a. In Designer, click Window > Preferences > Software AG > Mobile Development > Jenkins
Build Servers  in the menu bar.

b. Right-click a mobile project in the Package Explorer view. Select Mobile Tools >
Open Preferences from the context menu. In the Preferences dialog, select Software
AG > Mobile Development > Jenkins Build Servers .

2. Right-click the respective Jenkins server. Select Edit from the context menu. In the
Add Jenkins Server dialog, edit your user credentials or delete the entire server
declaration including your credentials, and click OK.

Modifying Personal Data on a Jenkins Server
When handling signing credentials and provisioning profiles with the Mobile Suite
plugin, the associated files are encrypted using Jenkins' own secure storage protocol for
passwords and saved in the Jenkins server's configuration directory. The Mobile Suite
plugin also stores the passwords for Android key aliases in the same way.

Note: Jenkins server may also handle and store other personal information such
as user names and passwords (for example, in log files). This extra data falls
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outside of the responsibility of the Mobile Suite Jenkins plugin. Refer to
“hp://jenkins.io/” for information on how to manage this data.

To modify or delete this information

1. To modify or delete signing credentials, do the following:

a. In a Web browser, connect to your Jenkins server and log in, if required.

b. On the main page, click Manage Jenkins.

c. Navigate to the Mobile Signing Key Configuration Android/iOS page.

d. Modify passwords for Android key aliases as required, update descriptions for
signing credentials, or delete keys from the store.

e. Click Save at the boom of the section to commit your changes to the server.

Note: There are two Save buons on the Mobile Signing Key Configuration
Android/iOS page, one for updating the Android credentials, and one
for the iOS credentials. If you need to make changes in both sections,
update one section and click Save before modifying the other.

2. To delete iOS provisioning profiles, do the following:

a. In a Web browser, connect to your Jenkins server and log in, if required.

b. On the main page, click Manage Jenkins.

c. Navigate to the Mobile Provisioning Profiles iOS page.

d. Click the Delete buon underneath provisioning profiles that you want to remove
from the server.

e. Click Save at the boom of the section to commit your changes to the server.

http://jenkins.io/
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Using the DateFormatter and DateTransformer
When working with data driven applications, it is a common use case to
convert a Date object into a String or a String into a Date based on a given paern.
The recommended way to handle date format conversions is using the class
com.softwareag.mobile.md.text.DateFormat. If required, DateFormat also allows to use the
Timezone offset and the Locale identifier for the conversions. The locale is important if
you need to convert date strings, which contain the name of a month or a day.

Simple example for using DateFormat:
public String formatDate(java.util.Date date) {
  DateFormat dateFormat = new DateFormat("MM/dd/yyyy hh:mm:ss a");
  String formattedDate = dateFormat.format(date);
  return formattedDate;
}
public java.util.Date parseDateString(String dateString) throws ParseException {
  DateFormat dateFormat = new DateFormat("dd.MM.yyyy");
  java.util.Date date = dateFormat.parse(dateString);
  return date;
}

There is also a new transformer implementation as wrapper for DateFormat
that allows date conversions in code as well as in the application model
file (for example, in ContentAdapter or Template bindings). The transformer
implementation com.softwareag.mobile.runtime.toolkit.transformer.DateTransformer implements
com.softwareag.mobile.runtime.toolkit.delegates.IDataTransformer and can therefore be used in all
transformer definitions in the application model. It can also be used programmatically,
as you can see in the snippets below:
public String formatDate(java.util.Calendar calendar) {
  DateTransformer dateTransformer = new DateTransformer("dd.MM.yy");
  String formattedDate = (String) dateTransformer.transform(calendar.getTime(), 
  IDataTransformer.TYPE_STRING);
  return formattedDate;
}
public java.util.Date parseDateString(String dateString) {
  DateTransformer dateTransformer = new DateTransformer("dd.MM.yy");
  java.util.Date date = (java.util.Date) dateTransformer.transform(dateString, 
  IDataTransformer.TYPE_DATE);
  return date;
}

Detecting the Current Platform
At run time, it is often required to get information on the platform on which the
application is running. This information may be used, for example, to return a color
value that depends on the current platform.

The com.softwareag.mobile.runtime.toolkit.AbstractApplicationController contains public methods for
determining the current platform:

boolean runningOnAndroid();
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boolean runningOnIOS();

These methods can also be used if you want to simulate your application using Phoney.
The return value then depends on the activated handset.

See the following snippet for an example:
import com.softwareag.mobile.runtime.toolkit.AbstractApplicationController;
public int getColorValue() {
       int colorValue = 0xff000000;
       if(AbstractApplicationController.getInstance().runningOnAndroid()) {
          colorValue = 0xff00ff00;
       }
       return colorValue;
}

Using the Context Key Store to Store and Retrieve
Application-wide Settings
Mobile Development follows the Model-View-Controller architecture which splits user-
wrien business logic from the generated sources. A frequently-asked question is how to
take over a set of data from one view into another. The ContextKeyStore offers a simple
way to achieve this goal from the application model and also programmatically.

When you use the application model, the input fields (Entry and SearchEntry) populate
the property Context Key, which requires a String value as a unique name. Seing
up Entry or SearchEntry elements with a context key will generate a logic which
automatically saves the entered value to the ContextKeyStore. To identify the data, the
specified context key is taken into account as a unique key. In addition to storing the
data, any already contained value will be automatically applied to the UI element. All
entered context keys will be generated to the ContextKeys.java interface. The context key
can be embedded in any text property using the {@CONTEXT_myContextKey} syntax.
This token will be automatically resolved and replaced with the actual value.

Using a programmatic approach, you need to put a key value pair into the
ContextKeyStore, as described by the following snippet:
import com.softwareag.mobile.runtime.toolkit.util.ContextKeyStore;
ContextKeyStore.set("MyKey", "MyValue");
String myValue = (String) ContextKeyStore.get("MyKey");

Supported values are all primitive types including String. To store a date value, you
need to put the corresponding long value into the ContextKeyStore, using the java.lang
wrapper classes for primitive types:
final Date date = new Date();
final long dateAsLong = myDataObject.getTime();
ContextKeyStore.set("MyDate", new Long(dateAsLong));

The values contained in the ContextKeyStore can be persisted. For this, the application
property Context Persistence Mode must be set to Permanent. All values and their keys are
then placed in a RecordStore when you close the application. They are automatically
loaded when you start the application again.
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Encoding and Decoding Images with Base64
When using RESTful services or web services, it is often required to send binary data
(such as images) encoded as String. This can be achieved by using several API classes, as
described in the following snippet:
import org.apache.axis.j2me.rpc.Base64;
import javax.microedition.lcdui.Image;
import com.softwareag.mobile.runtime.media.ImageHandler;
public String encodeImage(final Image image) {
       String encodedImage = null;
       if (image != null) {
           final byte[] bytes = ImageHandler.pngCreateByteArray(image);
           final byte[] encodedBytes = Base64.encode(bytes);
           encodedImage = new String(encodedBytes);
       }
       return encodedImage;
}
public Image decodeImage(final String encodedImage) {
       Image image = null;
       if (!AppUtility.instance.isEmpty(encodedImage)) {
           final byte[] decodedBytes = Base64.decode(encodedImage.getBytes());
           if ((decodedBytes != null) & (decodedBytes.length > 0)) {
                image = Image.createImage(decodedBytes, 0, decodedBytes.length);
           }
       }
       return image;
}

Configuring a Session Object with Credentials
When using RESTful services, it is often required to send authentication information
with the HTTP header. This can be achieved using the Session object. A session is used
to manage cookies and user credentials across different HTTP requests. Only one session
exists at a time.

Use the Session object to add credentials to be automatically applied to any RESTful
service.
import com.softwareag.mobile.runtime.toolkit.rest.Credentials;
import com.softwareag.mobile.runtime.toolkit.rest.Session;
final Session session = Session.get();
final Credentials credentials = new Credentials("user", "password");
credentials.addHostname("hostname");
credentials.addProtocol("http");
credentials.addRealm("realm");
session.addCredentials(credentials);

Seing credentials this way will ensure that each request uses these credentials. By
default, credentials will be added to the request header as HTTP basic authentication.

It is also possible to delete a session. Be aware that all credentials and cookies set before
destroying will be lost. If there is currently no session, executing a request will create
one.
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final Session session = Session.get();
session.destroy();

Creating Your Own Operation
Larger operations, such as database access or remote communication, often require a
lot of time and must therefore be performed in a thread different from the main thread
so that the responsiveness of the user interface is not blocked. Mobile Development
provides the AbstractThreadedOperation class, which can be used to create asynchronous,
thread-safe operations. This class creates its own thread once it is executed and provides
thread-safe notifications. The following snippet shows how to create a subclass:
import com.softwareag.mobile.runtime.toolkit.operations.AbstractThreadedOperation;
public class MyOperation extends AbstractThreadedOperation {
       protected void runInternal() throws Exception {
           // put code here, let's have exceptions being thrown
       }
}

To extend AbstractThreadedOperation, you need to put logic into runInternal(). This
method is executed after AbstractThreadedOperation#execute() has been called. Because
AbstractThreadedOperation inherits from IOperation, it is possible to aach multiple
IOperationDelegate classes for being notified of the operation's state. The following snippet
shows how to start the operation and how to add listeners:
final MyOperation operation = new MyOperation();
operation.addOperationDelegate(new IOperationDelegate() {
      public void onOperationFinished(final IOperation operation) {
      }
      public void onOperationFailed(final IOperation operation) {
      }
});
operation.execute();

It is recommended to add the delegates before executing the operation. The
IOperationDelegate#onOperationFinished(IOperation) method is called after runInternal()
has completed without any exception. If an exception is thrown, onOperationFailed
is called. The result of the operation can be set using the protected member
AbstractThreadedOperation#result.

Chaining Multiple Operations
Let us assume that you need to call an operation GetID to get a particular ID of an object
and that you need to call GetDetails afterwards to get more information about this object.
In this case, you need to chain GetID and GetDetails, and you have to keep error and
result handling in mind. To achieve this goal, it is recommended that you handle one
particular result code for an operation with one IOperationDelegate. In our case, you need
to introduce three classes which implement IOperationDelegate:
public class ErrorDelegate implements IOperationDelegate {
  public void onOperationFailed(final IOperation operation) {
    new MessageDialog(AbstractApplicationController.getInstance()).open();
  }



M
Even Header

Code Snippets

webMethods Mobile Development Help Version 10.3 150

  public void onOperationFinished(final IOperation operation) {
    if (operation.getResultCode() != HttpConnection.HTTP_OK) {
      onOperationFailed(operation);
    }
  }
}
public class GetIDResultDelegate extends ErrorDelegate {
  public void onOperationFinished(final IOperation operation) {
    super.onOperationFinished(operation);
    if (operation.getResultCode() == HttpConnection.HTTP_OK) {
      final GetDetails getDetailsOperation = new GetDetails();
      getDetailsOperation
          .addOperationDelegate(
              new GetDetailsResultDelegate());
      getDetailsOperation.execute();
    }
  }
}
public class GetDetailsResultDelegate extends ErrorDelegate {
  public void onOperationFinished(final IOperation operation) {
    super.onOperationFinished(operation);
    if(operation.getResultCode() == HttpConnection.HTTP_OK) {
      final String details = operation.getResult();
      // do something
    }
  }
}

Extending from ErrorDelegate allows for implicit error handling. If an operation requires
error handling that differs from the standard behavior in ErrorDelegate, it is also possible
to use different OperationDelegates.

For complex scenarios, see “Geing the Current GPS Position and Translating it into a
Human-readable Location” on page 152 and “ Downloading an Image from a Remote
Host” on page 152.

Using Multipart Requests
The Request object for creating services in the Outline Editor supports multipart/form-
data content types. A file upload is a typical use case for a multipart request.

The following snippet shows a sample implementation of an Agile Apps photo upload:
final Image img = getMyImage();
if (img != null) {
  final UpdatePhotoRequest request = new UpdatePhotoRequest();
  request.addOperationDelegate(this);
  final StringBuffer xmlData = new StringBuffer();
  xmlData.append("<platform><record>\r\n");
  xmlData.append("<photo>photo.png</photo>\r\n");
  xmlData.append("</record></platform>\r\n");
  // add two parts to the multipart request
  // first part is XML to tell Agile Apps about the data being uploaded
  // second part is the image data to be uploaded
  request.addBytePart(xmlData.toString().getBytes(), "_xml_data_", 
         "application/xml", false);
  request.addImageFilePart(img, "photo.png", "photo", "image/png", false);
  request.execute();
}
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As of Mobile Development 9.8, AbstractMultipartRestOperation is available, which extends
AbtractRestOperation for full support of multipart requests. Adding the following parts is
currently supported by AbstractMultipartRestOperation:

addBytePart(...)

addFilePart(...)

addImageFilePart(...)

As of Mobile Development 9.8, only image/png content type is supported when using
addImageFilePart(...). This converts the given javax.microedition.lcdui.Image data automatically
to PNG data.

For more information, see the Javadoc for AbstractMultipartRestOperation.

Doing Error Handling for Operations
Each operation provides a response code as a protected member. The interpretation of
this integer value depends on the operation type. Mobile Development uses this type to
differentiate between RESTful operations (which inherit from AbstractRestOperation) and
customized operations (which inherit from AbstractThreadedOperation). See also “Creating
Your Own Operation” on page 149.

An AbstractRestOperation is meant as a super class for generated RESTful services. It opens
an HTTP connection so that the response code can easily be compared with the HTTP
result codes. The interface HTTPConnection lists all possible result codes for this kind of
operation. It is recommended to use one IOperationDelegate for one HTTP result code. For a
sample, see “ Chaining Multiple Operations” on page 149.

An AbstractThreadedOperation is mostly used to encapsulate a single piece of business logic.
Therefore, the response code must be set in its implementation class. Let us assume that
you want to use a simple operation as described in “Creating Your Own Operation” on
page 149. The recommended way is to introduce a set of public variables that can also
be used to determine the result in an IOperationDelegate. If everything works correctly, you
can simply set the protected member responseCode to OK. If an exception occurs, set the
responseCode to the error and also throw the nested exception. Throwing the exception
will force the operation to call onOperationFailed for each added IOperationDelegate.
public class MyOperation extends AbstractThreadedOperation {
  public static int RESULT_OK = 1;
  public static int RESULT_ERROR = 2;
  protected void runInternal() throws Exception {
    try {
      // some logic in here
      responseCode = RESULT_OK;
    } catch(Exception e) {
      responseCode = RESULT_ERROR;
      throw e;
    } 
  }
}
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Getting the Current GPS Position and Translating it into a
Human-readable Location
Using Mobile Designer, it is possible to get the current GPS position. From a user
experience perspective, it is often required to show a readable location to the user. This
use case can be seen as complex example of how to chain multiple requests (see also “
Chaining Multiple Operations” on page 149). You first have to get the current GPS
location, and after this, you have to ask a common service to translate the coordinates
into a readable location.

The first step is to access the GPS coordinates. It is recommended to use an
AbstractThreadedOperation because this operation may take several seconds.
public class GetGPSCoordinates extends AbstractThreadedOperation {
  protected void runInternal() throws Exception {
    final LocationProvider lp = LocationProvider.getInstance(null);
    final Location l = lp.getLocation(20);
    final Coordinates c = l.getQualifiedCoordinates();
    responseCode = 0;
    if (c != null) {
      result = (String.valueOf(c.getLatitude()) + "," String.valueOf(c
          .getLongitude())).getBytes();
      responseCode = HttpConnection.HTTP_OK;
    }
  }
}

For more information about the LocationProvider, see the Mobile Designer documentation.

The second step is to ask a common service provider for a readable location.
This can be achieved, for example, using the public Google API under http://
maps.googleapis.com/maps/api/geocode/json.

To execute this request, create a new RESTful service using the palee, enter the above
URL and a name for the service class to be executed from Java. This request also requires
a query parameter named latlng. In this example, the RESTful service to execute this
request is named GetLocation. If GetGPSCoordinates results in HTTPConnection.HTTP_OK,
you can trigger GetLocation with the result of the previous operation.
final GetLocation getLocation = new GetLocation();
getLocation.execute(operation.getResult());

Downloading an Image from a Remote Host
Downloading an image from a server is a typical scenario for using
AbstractThreadedOperation. First, you must subclass AbstractThreadedOperation. After this, you
must open an HTTPConnection, and the result must be read using a DataInputStream.
import java.io.ByteArrayOutputStream;
import java.io.DataInputStream;
import java.io.InputStream;
import javax.microedition.io.Connector;
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import javax.microedition.io.HttpConnection;
import javax.microedition.lcdui.Image;
import com.softwareag.mobile.runtime.toolkit.operations.AbstractThreadedOperation;
public class ImageLoaderOperation extends AbstractThreadedOperation {
  private final String url;
  private byte[] imageData = new byte[0];
  public ImageLoaderOperation(final String url) {
    this.url = url;
  }
  protected void runInternal() throws Exception {
    HttpConnection hpc = null;
    DataInputStream dis = null;
    final ByteArrayOutputStream output = new ByteArrayOutputStream();
    try {
      hpc = (HttpConnection) Connector.open(url);
      final byte[] data = new byte[8192];
      int read = 0;
      final InputStream stream = hpc.openInputStream();
      dis = new DataInputStream(stream);
      while ((read = dis.read(data, 0, 8192)) > 0) {
        output.write(data, 0, read);
      }
      imageData = output.toByteArray();
    } finally {
      if(dis != null) {
        dis.close();
      }
      if(output != null) {
        output.close();
      }
    }
  }
  public Image getImage() {
    Image image = null;
    if ((imageData != null) && (imageData.length > 0)) {
       image = Image.createImage(imageData, 0, imageData.length);
    }
    return image;
  }
}

Using a Java Class to Communicate with the Natively
Injected Code
With Mobile Designer, it is possible to extend the given capabilities, especially those for
interacting with the target operation system. This feature can be used to add platform-
specific features to a mobile project, such as integrating a barcode scanner or displaying
PDF files. Adding platform-specific code to a mobile project is called native code injection.

The principle behind native code injection is to use a Java class as a bridge to the
native code. The Java class provides a signature and with that an entry point for
communicating with the native code. Furthermore, the Java class is replaced during the
build process. Because of this, the native equivalent must also implement the signature
to avoid any compile issues that may occur during the build process. For technical
examples, see the Mobile Designer sample projects NativeUI My Native Element and the
NativeUI PDF Demo.
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To implement native code injection

1. Create a Java class with a common signature (for example, a static method).

2. Do a local build for the desired native platform.

3. Configure the mobile project to use native code injection. To do so, implement the
project.hookpoint.target.postcrosscompiler hookpoint in your defaults.xml file and configure
which classes need to be replaced. For more information about hookpoints, see Using
webMethods Mobile Designer.

With Mobile Development, the project.hookpoint.target.postcrosscompiler hookpoint is
already pre-configured in each mobile project. You only need to add the native
classes to the project_name /native/platform  folder and ensure that the folder structure
matches the Java package. The platform folders are:

Platform Folder

Android project_name /native/android

iOS project_name /native/ios

Phoney project_name /native/phoney

For example, when you have a Java class named com.softwareag.mobile.Helper.java, you
have to add the native source code for Android to project_name /native/android/com/
softwareag/mobile/Helper.java.

4. The local build cross-compiles the Java class to the target platform, which results
in a native source file already translated to the target programming language. You
can copy this source file and customize it without having to take care of how to add
imports or method declarations in the target programming language.

5. Do a build for the platform once more. The result will contain the natively injected
code.

Configuring Your Application to Receive Push Notifications
Mobile Suite enables customers to set up the application to receive push notifications.

Note: On Android, Firebase Cloud Messaging is supported for push notifications.
To configure your mobile project for this, follow the procedure as described
in “Configuring Mobile Projects to Work With Firebase Cloud Messaging on
Android” on page 155.

To prepare your mobile project to receive push notifications

1. Open your application model and locate the Application node.
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2. In the Properties section, configure the Use Push Notifications property. For more
information, see “Application Node Properties” on page 160.

3. Regenerate the Java sources. For more information, see “Generating Sources for a
Mobile Project” on page 46.

4. Open the application_name AppControllerImpl.java class of your mobile project
and override the onDeviceRegistered(String), onMessage(PushNotification), and
onStartAppFromPushNotification(PushNotification) methods as follows:
public void onDeviceRegistered(final String newPushUID) {
  String pushtoken = deviceRegistrationId;
  if (runningOnIOS()) {
    // converting the ios push token as it might come formatted
    // <.... .... .... ....>
    final StringTokenizer tokenizer = new StringTokenizer(
     deviceRegistrationId, "/<> ");
    final StringBuffer iosToken = new StringBuffer();
    while (tokenizer.hasMoreElements()) {
      iosToken.append((String) tokenizer.nextElement());
    }    
    pushtoken = iosToken.toString();
  }
  // register the device pushtoken within the backend system the
  // app will receive push notifications from. You need to call a service
  // provided by the backend system.
  // this.registerForPushNotification(pushtoken, this.username)
}
public void onMessage(final PushNotification notification) {
  final String message = notification.getMessage();
  if (message != null) {
    // present message to the user
  }
  super.onMessage(notification);
}
public void onStartAppFromPushNotification(
 final PushNotification notification) {
  // process push notification
  final String taskId = (String) notification.getParams().get("taskID");
  if (taskId != null) {
    // present task with taskId to the user
  }
}

For more information, see “Common Methods to Override in the Generated Code for
the Application” on page 117.

5. Configure your iOS and/or Android multibuilds to build your application with the
correct signing required for push notifications. For more information, see Using
webMethods Mobile Designer.

Configuring Mobile Projects to Work With Firebase Cloud Messaging
on Android
To work with Firebase Cloud Messaging on Android devices, you must download an
Android configuration file from the Firebase console and store it in your mobile project.



M
Even Header

Code Snippets

webMethods Mobile Development Help Version 10.3 156

To enable Firebase Cloud Messaging

1. Open the Firebase console with the following link: “hps://
console.firebase.google.com/”.

2. Create a new project or use an existing one.

3. Add Firebase to your Android application and follow the setup steps. Use your
application's package name.

4. Download the google-services.json file.

5. Store this file in the gen/.assets/android/firebase folder of your mobile project.

Configuring a Content Adapter to Use Multiple Templates
In a Content Adapter, you can declare to use multiple templates. This is useful if the
selected data source contains different types of elements. Each type can then use a
dedicated template to display its data.

To add multiple templates to a content adapter

1. Ensure the mobile project is open in the Outline Editor. For instructions, see
“Displaying a Mobile Project in the Outline Editor” on page 22.

2. In the Model section of the Outline Editor, expand the project so that you view the
Content Adapter where you want to add multiple templates.

3. Right-click and select New Child > TemplateAssignment. Select the template you want to
use from the drop-down list. If you need to create a new template, refer to “Creating
a Template for a Custom Object” on page 100.

4. Enter the filter expression for this type of element. This String is required later to
identify the different types of elements from the data source. The String should be
unique across all TemplatesAssignments within that Content Adapter.

5. Repeat steps 3 and 4 for all different types of elements that you want to display. See
below for an example of a model using 3 different templates.

6. Open the Java Source file for the data source that you defined in the Content Adapter.

https://console.firebase.google.com/
https://console.firebase.google.com/


M
Odd Header

Code Snippets

webMethods Mobile Development Help Version 10.3 157

7. Override the method public boolean matchesExpression(String filterExpression, int elementIndex).
This method is called for each element of the data source to identify which template
should be used for displaying it.

a. The parameter filterExpression is one of the filter expression that you just defined in
the template assignment.

b. The parameter elementIndex defines the index of the element in the data source.
You can use the methods getEntityForIndex(int) (in an EntityDatasource) or
getElementAtIndex(int) (in a ListDatasource) to get the element at this position.

The following example shows how to implement this method.
public boolean matchesExpression(final String filterExpr, final int elementIndex) {
    final IEntity entity = getEntityForIndex(elementIndex);
    if ((entity instanceof TaskTypeImpl) && "task".equalsIgnoreCase(filterExpr)) {
        return true;
    } else if ((entity instanceof ProcessTypeImpl) 
        && "process".equalsIgnoreCase(filterExpr)) {
        return true;
    } else if ((entity instanceof SectionTitleImpl) 
        && "section".equalsIgnoreCase(filterExpr)) {
        return true;
    }
    return false;
}

Configuring the SearchNavButton Object
To add a search or filter functionality using a SearchNavButton, you must add an
ISearchFieldListener to it. To do so, you must override the createSearchNavButton() method in
the [ViewName]ControllerImpl class. In this class, you must call the super method to initially
create the SearchNavButton and then add the listener. The most important part in the
ISearchFieldListener is the onQueryTextSubmit() method which is invoked when the user wants
to start the search.

Use the following code to override the createSearchNavButton() method:
nUISearchNavButton createSearchNavButton(int nuiid, String text, Image icon) {
  nUISearchNavButton searchNavButton = 
    super.createSearchNavButton(nuiid, text, icon);
  searchNavButton.setSearchFieldListener(new ISearchFieldListener() {
    public void onTextChanged(String newText) {
      // could be used to implement search-while-you-type
    }
    public void onQueryTextSubmit(String query) {
      // start the search
    }
    public void onCancelButtonClicked() {
      // reset the searched/filtered elements
    }
  });
  return searchNavButton;
}
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Configuring the SwipeButton Object
The ListView allows you to show a set of buons when swiping left or right. You can
define these buons by adding a SwipeButton object to a TemplateAssignment object and
defining properties for it as described in “SwipeBuon Properties” on page 202.
To define the action after clicking one of these buons, you must implement the
onActionButtonClicked() method in the [ViewName]ViewControllerImpl class as follows:
public void onActionButtonClicked(final int row, nUIActionButton button) {
  switch (button.getId()) {
    case TASK_COMPLETE_BUTTON_ID:
      Toast.showToast("onActionButtonClicked: TASK_COMPLETE_BUTTON_ID");
      break;
    case TASK_CANCEL_BUTTON_ID:
      Toast.showToast("onActionButtonClicked: TASK_CANCEL_BUTTON_ID");
      break;
    case PROCESS_EDIT_BUTTON_ID:
      Toast.showToast("onActionButtonClicked: PROCESS_EDIT_BUTTON_ID");
      break;
    default:
      break;
  }
}

Configuring the SwipeRemove Object
The SwipeRemove object allows you to select an element from the ListView by swiping
and have it removed. For the selected element to be removed, you must implement the
onSwiped() method in the [ViewName]ViewControllerImpl class as follows:
public void onSwiped(int row, int type) {
  nUIDisplayObject cell = getCell(row, null);
  Object instance = cell.getTag();
  [your_dataSource ].getFilteredElements().removeElement(instance);
  getView().deleteRow(row, IListRenderer.ROW_ANIMATION_STYLE_NONE);
}
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User Interface Objects
The following table lists the objects you can define for your application and where you
can find a description of the user interface objects and a description of the properties to
set for each object.

For information about... See...

Application node “Application Node Properties” on page 160

Windows “Objects to Use for Windows” on page 162

Panes “Objects to Use for Panes” on page 163

Views “Objects to Use for Views” on page 166

Layout “Objects to Use for the Layout of the User Interface” on
page 172

Dialogs “Objects to Use for Dialogs” on page 175

Tables “Objects to Use for Tables” on page 177

Controls “Objects to Use for User Interface Controls” on
page 181

Content Providers “Objects to Use for Content Providers or Content
Adapters” on page 205

Event Listeners “Objects to Use for Event Listeners” on page 213

Event Actions “Objects to Use for Event Actions” on page 216

Templates “Objects to Use for Templates” on page 220

Application Node Properties
The following table provides descriptions of the properties you can set for the mobile
project’s root application node.
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Property Description

Bundle Id Package name for your mobile project.

You initially define the package name for a mobile project
when you create the project using the New Mobile
Development Project wizard. You can use this property
to change the package name. For more information, see
“Changing the Package Name” on page 139.

Context Persistence
Mode

If set to Permanent, all values set for the context key store
are made persistent. This allows users to reuse the values
in the context key store even when restarting the app.

Default Language Default language for the application. For more
information, see “Seing the Default Language for the
Project” on page 44.

Name Name of the mobile application. This is an internal
application name that Mobile Development uses.

You initially define the application name when you create
the project using the New Mobile Development Project
wizard. You can use this property to change the name. For
more information, see “Renaming the Application” on
page 138.

Orientation Whether you want the application to display in portrait
mode, landscape mode, or rotate as a user turns the device.

You initially define the orientation seing when you
create the project using the New Mobile Development
Project wizard. You can use this property to reconfigure
the seing. For more information, see “Configuring the
Orientations Seing for the Application” on page 43.

Res Handler Name of the resource handler for the mobile application
project. By default, the mobile application uses the default
application that Mobile Development provides, which is
UniversalResHandler.

If you want to use a custom resource handler, use this
property to specify its fully-qualified name.

For more information, see “Defining Resources for a
Mobile Project” on page 35.
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Property Description

Use Camera Whether you want to set the Mobile Designer property
project.handset.uses.camera to true. See Using webMethods
Mobile Designer for more information on this property.

Use Location Whether you want to set the Mobile Designer property
project.handset.uses.Location to true. See Using webMethods
Mobile Designer for more information on this property.

Use PIM PIM stands for Personal Information Manager.
Whether you want to set the Mobile Designer property
project.handset.uses.FCPIM to true in order to list all contacts
on your device. See Using webMethods Mobile Designer for
more information on this property.

Use Push Notifications Whether you want to set the Mobile Designer property
project.handset.push.notifications to true. See Using webMethods
Mobile Designer for more information on this property.

Use Sensors Whether you want to set the Mobile Designer property
project.handset.uses.Sensors to true. See Using webMethods
Mobile Designer for more information on this property.

Use WMA WMA stands for Wireless Messaging API. Whether
you want to set the Mobile Designer property
project.handset.uses.WMA to true. See Using webMethods
Mobile Designer for more information on this property.

Objects to Use for Windows
The following table provides a description of the user interface object you use for the
application’s window.

Object Description

Window Defines the application’s window.

For information about seing properties for the Window
object, see “Window Properties” on page 163.
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Window Properties

Property Description

Name Name you assign to the application’s window. This name
does not appear in the application’s user interface.

Start Pane
Configuration

Name of the pane configuration that you want to use when
the window is initially displayed. Specify the name of a
PaneConfiguration object that you previously defined for the
mobile project.

Left Side View A reference to a Side View object. This Side View will be
taken into account for the OpenSideView and CloseSideView
actions. For more information about seing properties for the
OpenSideView and CloseSideView, see “Objects to Use for Event
Actions” on page 216.

Objects to Use for Panes
The following table provides descriptions of the user interface objects you use to define
panes for an application’s window. For more about using panes, see “Defining Panes for
the Application Window” on page 77.

Object Description

HorizontalSplitter Indicates that you want to display two panes horizontally,
one on top of the other.

For information about seing properties for the
HorizontalSplitter object, see “HorizontalSplier Properties”
on page 164.

PaneConfiguration Specifies the name of a configuration of panes.

Add HorizontalSplitter, VerticalSplitter, and/or PaneDefinition
child objects to define how to place panes in the
application’s Window object when using this pane
configuration.

For information about seing properties for the
PaneConfiguration object, see “PaneConfiguration
Properties” on page 165.
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Object Description

PaneDefinition Specifies the following for a single pane in a pane
configuration:

Name of the pane.

Name of a view that you want initially displayed in the
pane.

Flag indicating whether the view is visible or not.

For information about seing properties for the
PaneDefinition object, see “PaneDefinition Properties” on
page 165.

VerticalSplitter Indicates that you want to display two panes vertically,
side by side.

For information about seing properties for the
VerticalSplitter object, see “VerticalSplier Properties” on
page 165.

HorizontalSplitter Properties

Property Description

Height Absolute size to use for the height of one of panes, either the
top or boom pane. The other pane uses the remaining space
available. You can specify the height using either a percentage
value or the number of pixels.

To set the absolute size to use for the top pane, type the value.
For example:

To use 320 pixels for the top pane, specify: 320

To use 38 percent for the top pane, specify: 38%

To set the absolute size for the boom pane, type a comma
followed by the value. For example:

To use 320 pixels for the boom pane, specify: , 320

To use 38 percent for the boom pane, specify: , 38%

If you do not specify a value, the split creates two equal sections.

Note: An exception to the default behavior is when you use a
HorizontalSplitter with a NavView in the boom pane. In
this case, the size of the boom pane is set to the height
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Property Description
required for the NavView. The top pane uses the remaining
space.

PaneConfiguration Properties

Property Description

Name Name you assign to the pane configuration.

PaneDefinition Properties

Property Description

Name Name of the pane.

Start View Name of a view that you want initially displayed in the
pane. This can be a name that you previously defined for a
View, ListView, NavView, or WebView object.

Visible Whether the pane is visible or hidden.

VerticalSplitter Properties

Property Description

Width Absolute size to use for the width of one of panes, either the left
or right pane. The other pane uses the remaining space available.
You can specify the width using either a percentage value or the
number of pixels.

To set the absolute size to use for the left pane, type the value.
For example:

To use 320 pixels for the left pane, specify: 320

To use 38 percent for the left pane, specify: 38%

To set the absolute size for the right pane, type a comma
followed by the value. For example:

To use 320 pixels for the right pane, specify: , 320
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Property Description

To use 38 percent for the right pane, specify: , 38%

If you do not specify a value, the split creates two equal sections.

Objects to Use for Views
The following table provides descriptions of the types of views that you can use in an
application’s user interface.

Object Description

ListView Defines a view that displays a list of data obtained from a
specified data source.

Add a ContentProvider child object to the ListView object to
define the content you want to list in the view.

For information about seing properties for a ListView, see
“ListView Properties” on page 167.

NavView Defines a view that you want to use for navigation in your
application.

The navigation view has different formats based on the
platform. For example, for some platforms the navigation
view might display as a menu bar that is always visible
and uses both icons and text. For other platforms, the
navigation view might have hidden menu items that are
displayed only when a user presses a buon.

For information about seing properties for a NavView
object, see “NavView Properties” on page 169.

SideView A SideView is a common paern that displays the main
navigation options for your application. It is hidden most
of the time, unless the user opens it using the dedicated
OpenSideView action or a programmatically implemented
solution.

For information about seing properties for a View object,
see “View and SideView Properties” on page 170.

TabView Is a common paern that lets you group several other
views and allows quick switching between them.
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Object Description
Optionally you can define User Interface elements, which
will be displayed above the tabs.

For information about seing properties for a TabView
object, see “TabView Properties” on page 169.

View Defines a general purpose view for your application.

For information about seing properties for a View object,
see “View and SideView Properties” on page 170.

WebView Defines a view in which you want to display Web content.

For information about seing properties for a WebView
object, see “WebView Properties” on page 171.

ListView Properties

Property Description

Back Button Text Text to display on the Back buon.

If you do not set this property, the default is to display the
Header Text property value of the previous view, which will
be displayed if the user presses the Back buon.

Background Color Background color of the view.

Background Image Image to display as the background for the view.

Header Background
Color

Background color of the header area of the view.

Header Foreground
Color

Foreground color of the header area of the view.

Header Image Image to display as the header of the view.

Header Text Text you want displayed in the header area of the view.

Leave this property blank if you do not want text in the
header.
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Property Description

Hide Back Button Whether you want the Back buon in the view to be
displayed or hidden.

HScrollable Whether you want to allow horizontal scrolling in the
view.

Inner Height Usable height of the view in which you can insert child
objects.

Inner Width Usable width of the view in which you can insert child
objects.

Inner X Distance from the view’s left edge to where child elements
are drawn.

Inner Y Distance from the view’s top edge to where child elements
are drawn.

Inner YSpacing Vertical distance between each element in the view.

List View Header Template that defines an object to display as the header for
the list of data displayed in the ListView.

Specify a template that you previously defined. The
template should customize an object like a Textfield or
Image object.

Name Name that you assign the view. This name does not appear
in the application’s user interface.

Popup Dismiss Text For the iOS platform, the text to use on a label that closes
an open keyboard or drop-down list.

Separator Template that defines an object to display between the each
list item displayed in the ListView.

Specify a template that you previous defined. The template
should customize an object like a Separator object.

Show On Reload Template that defines an object to display while the
application is obtaining data to refresh the list of items in
the view.
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Property Description

Specify a template that you previous defined. The template
should customize an object like a ProgressAnim, Image or
Textfield object.

VScrollable Whether you want to allow vertical scrolling in the view.

NavView Properties

Property Description

Name Name you assign the view. This name does not appear in
the application’s user interface.

TabView Properties

Property Description

Tab Background Color Background color of the tabs.

Tab Font Size Font size of text elements in the tabs

Tab Font Style Font style of text elements in the tabs.

Tab Indicator Color Color of the selected tab indicator (the small line at the
boom of the tab).

Tab Indicator Height Height of the selected tab indicator (the small line at the
boom of the tab).

Tab Mode The way the tabs are displayed; either FIXED or DYNAMIC
(Android only).

Tab Selected Text Color Color of the text elements in the selected tab.

Tab Text Color Color of text elements in the tabs.
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View and SideView Properties

Property Description

Back Button Text Text to display on the Back buon.

If you do not set this property, the default is to display the
Header Text property value of the previous view, which will
be displayed if the user presses the Back buon.

Background Color Background color of the view.

Background Image Image to display as the background for the view.

Header Background
Color

Background color of the header area of the view.

Header Foreground
Color

Foreground color of the header area of the view.

Header Image Image to display as the header of the view.

Header Text Text you want displayed in the header area of the view.

Leave this property blank if you do not want text in the
header.

Hide Back Button Whether you want the Back buon in the view to be
displayed or hidden.

HScrollable Whether you want to allow horizontal scrolling in the
view.

Inner Height Usable height of the view in which you can insert child
objects.

Inner Width Usable width of the view in which you can insert child
objects.

Inner X Distance from the view’s left edge to where child elements
are drawn.

Inner Y Distance from the view’s top edge to where child elements
are drawn.
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Property Description

Name Name you assign the view. This name does not appear in
the application’s user interface.

Popup Dismiss Text For the iOS platform, the text to use on a label that closes
an open keyboard or drop-down list.

VScrollable Whether you want to allow vertical scrolling in the view.

WebView Properties

Property Description

Back Button Text Text to display on the Back buon.

If you do not set this property, the default is to display the
Header Text property value of the previous view, which will
be displayed if the user presses the Back buon.

Background Color Background color of the view.

Background Image Image to display as the background for the view.

File File that contains the Web content to display. The file
should be in the project’s resources\www folder.

Header Background
Color

Background color of the header area of the view.

Header Foreground
Color

Foreground color of the header area of the view.

Header Image Image to display as the header of the view.

Header Text Text you want displayed in the header area of the view.

Leave this property blank if you do not want text in the
header.

Hide Back Button Whether you want the Back buon in the view to be
displayed or hidden.
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Property Description

HScrollable Whether you want to allow horizontal scrolling in the
view.

Inner Height Usable height of the view in which you can insert child
objects.

Inner Width Usable width of the view in which you can insert child
objects.

Inner X Distance from the view’s left edge to where child elements
are drawn.

Inner Y Distance from the view’s top edge to where child elements
are drawn.

Name Name you assign the view. This name does not appear in
the application’s user interface.

Overscrolling Enabled Whether you want to allow overshooting the bounds of a
scrolling operation (only for Android).

Popup Dismiss Text For the iOS platform, the text to use on a label that closes
an open keyboard or drop-down list.

Scale To Fit Enabled Whether you want to scale the WebView to fit the parent
element (only for iOS).

Url URL to the web page to load into the view.

VScrollable Whether you want to allow vertical scrolling in the view.

Objects to Use for the Layout of the User Interface
The following table provides descriptions of user interface objects that you can use to
define the layout of user interface objects within a view.

Object Description

Group Creates a container that holds a group of user interface
objects.
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Object Description

To specify user interface objects to include in the group,
add the objects as children of the Group object.

Use the Group object’s Visible property to indicate whether
you want the group of user interface objects visible or
hidden.

For information about seing properties for the Group
object, see “Group Properties” on page 173.

RadioButtonGroup Creates a container that holds a group of radio buons.

To specify the radio buons to include in the group, add
RadioButton objects as children of the RadioButtonGroup
object.

This object has no properties.

Separator Displays a horizontal line that you can use to separate
blocks of content.

For information about seing properties for the Separator
object, see “Separator Properties” on page 174.

Spacer Displays blank space that you can use to create extra
padding between user interface objects.

For information about seing properties for the Spacer
object, see “Spacer Properties” on page 174.

Group Properties

Property Description

Name Name you assign the group in the Outline Editor for your
own reference purpose. This name does not appear in the
application’s user interface.

Visible Whether you want the user interface objects in the group
to be visible.
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Separator Properties

Property Description

Color Color of the separator line.

Height Height of the separator line.

Name Name you assign the separator in the Outline Editor for
your own reference purpose. This name does not appear in
the application’s user interface.

Position X Distance from the separator line’s left edge to its parent
object’s inner X position.

Position Y Distance from the separator line’s top edge to its parent
object’s inner Y position.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

Visible Whether you want the separator line to be visible.

Width Width of the separator line.

Spacer Properties

Property Description

Height Height of the spacer object.

Name Name you assign the spacer object in the Outline Editor for
your own reference purpose. This name does not appear in
the application’s user interface.

Position X Distance from the spacer object’s left edge to its parent
object’s inner X position.

Position Y Distance from the spacer object’s top edge to its parent
object’s inner Y position.
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Property Description

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

Visible Whether you want the spacer object to be visible.

Width Width of the spacer object.

Objects to Use for Dialogs
The following table provides descriptions of the user interface object that you can use to
create dialogs.

Object Description

AlertDialog Displays a small pop-up that you can use to:

Present information to the user.

Interact with the user by presenting a simple question, for
example, a question requiring a “yes” or “no” answer.

You must add at least one DialogButton child object for the
AlertDialog object.

For information about seing properties for the AlertDialog
object, see “AlertDialog Properties” on page 176.

DialogButton Displays a buon to include in a dialog.

For information about seing properties for the
DialogButton object, see “DialogBuon Properties” on
page 176.

PopupMenu A useful and light-weight user interface element to display
a set of actions that is similar to a context menu.

For information about seing properties for the PopupMenu
object, see “PopupMenu Properties” on page 176.
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AlertDialog Properties

Property Description

Class Name Name of the class to generate for the alert dialog and to
which you can add logic for.

For more information, see “Logic for a Dialog” on
page 113.

Header Text Text to be displayed in the header area of the dialog.

Leave this property blank if you do not want text in the
header.

Text Text to be displayed in the dialog. You must specify this
property.

DialogButton Properties

Property Description

Id Identifier you assign to the buon. You must specify this
property.

Text Text to be displayed on the buon.

PopupMenu Properties

Property Description

Cancel Text Text to be displayed to close the menu.

Class Name Name of the class to generate for the pop-up menu and to
which you can add logic for.

For more information, see “Logic for a Dialog” on
page 113.
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Objects to Use for Tables
The following table provides descriptions of user interface objects that you can use to
define tables that you want to display in an application’s view.

Object Description

DynamicTablecell Specifies a method that executes at run time to populate
a table cell. A DynamicTablecell object is the child of a
TableRow object.

For information about seing properties for the
DynamicTablecell object, see “DynamicTablecell Properties”
on page 178.

DynamicTablerow Specifies a method that executes at run time to
dynamically define the layout for the table and populate
the table. A DynamicTablerow object is the child of a Table
object.

For information about seing properties for the
DynamicTablerow object, see “DynamicTablerow Properties”
on page 178.

Table Displays a table.

To specify the rows in the table, add one or more TableRow
objects or a single DynamicTablerow object as children of the
Table object.

For information about seing properties for the Table
object, see “Table Properties” on page 179.

TableButton Displays a table that contains other objects and that acts as
a buon.

For information about seing properties for the TableButton
object, see “TableBuon Properties” on page 180.

TableCell Adds a cell to a table row. A TableCell object is the child of
a TableRow object.

To specify user interface objects that you want to display
in the table cell, add the objects as children of the TableCell
object.



M
Even Header

User Interface Object Reference

webMethods Mobile Development Help Version 10.3 178

Object Description

For information about seing properties for the TableCell
object, see “Tablecell Properties” on page 180.

TableRow Adds a single row to a table. A TableRow object is the child
of a Table object.

A child of a Table object. Use to add a single row to the
table.

To specify the contents of the table row, add one or more
TableCell objects or a single DynamicTableCell object as
children of the TableRow object.

For information about seing properties for the TableRow
object, see “Tablerow Properties” on page 181.

DynamicTablecell Properties

Property Description

Method Name Name of a method you code to populate the table cell.
For information about the Java sources that Mobile
Development generates for the method and how to
provide logic for the method, see “Logic for a Method
Name Property” on page 115.

DynamicTablerow Properties

Property Description

Method Name Name of a method you code to populate the table.
For information about the Java sources that Mobile
Development generates for the method and how to
provide logic for the method, see “Logic for a Method
Name Property” on page 115.
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Table Properties

Property Description

Background Color Background color of the table.

Border Color Color of the table’s border.

Border Thickness Thickness of the table’s border.

Create On Condition Whether to create the table at run time.

Inner Height Usable height of the table in which you can insert child
objects.

Inner Width Usable width of the table in which you can insert child
objects.

Inner X Distance from the table’s left edge to where child elements
are drawn.

Inner Y Distance from the table’s top edge to where child elements
are drawn.

Name Name you assign the table in the Outline Editor for your
own reference purpose. This name does not appear in the
application’s user interface.

Position X Distance from the table’s left edge to its parent object’s
inner X position.

Position Y Distance from the table’s top edge to its parent object’s
inner Y position.

Rel Widths Relative widths of the columns in the table. For example,
if you specify 25, 25, 50, the table has three columns
where the first two each use 25% of the width and
remaining column uses 50% of the width.

Spacing Height Distance between the table rows.

Spacing Width Distance between the table columns.
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Property Description

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

Visible Whether the table is visible or hidden.

Width Width of the table.

TableButton Properties

Property Description

Background Color
Highlight

Color of the table buon when the table buon has focus.

Create On Condition Whether to create the table buon at run time.

Name Name you assign the table buon in the Outline Editor for
your own reference purpose. This name does not appear in
the application’s user interface.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

Visible Whether the table buon is visible or hidden.

Tablecell Properties

Property Description

Background Color Color of the table cell.

HAlign Horizontal alignment of the contents in the cell.

HSpan Number of columns you want the cell to span. For
example, when HSpan is set to 2, the cell spans two
columns.

Inner Height Usable height of the cell in which you can insert child
objects.
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Property Description

Inner Width Usable width of the cell in which you can insert child
objects.

Inner X Distance from the cell’s left edge to where child elements
are drawn.

Inner Y Distance from the cell’s top edge to where child elements
are drawn.

VAlign Vertical alignment of the contents in the cell.

VSpan Number of rows you want a cell to span. For example,
when VSpan is set to 2, the cell spans two rows.

Tablerow Properties

Property Description

Background Color Color of the table row.

Height Height of the table row.

Objects to Use for User Interface Controls
The following table provides descriptions of user interface controls that you can display
in an application’s view.

Object Description

Button Displays a single buon that contains a text label.

For information about seing properties for the
Button object, see “Buon Properties” on page 186.

Button Group Creates a container that holds a group of buons.

To specify the buons to include in the group, add
Button objects as children of the ButtonGroup object.
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Object Description

For information about seing properties for the
Button Group object, see “BuonGroup Properties” on
page 187.

Checkbox Displays a check box.

For information about seing properties for the
Checkbox object, see “CheckBox Properties” on
page 188.

Container Creates a container that holds other user interface
objects.

To specify user interface objects that you want to
display in the container, add the objects as children
of the Container object.

You can set the Container object’s properties to allow
scrolling. For example, you might use a container
to hold long pieces of text that exceed the viewable
area, allowing the user to scroll through the text.

For information about seing properties for the
Container object, see “Container Properties” on
page 188.

DateEntry Displays a date or time selector control.

For information about seing properties for the
DateEntry object, see “DateEntry Properties” on
page 189.

DropDownListEntry Displays a drop-down list that contains selection
items.

To define the items in the drop-down, add one or
more StringDropDownListEntryItem objects or a single
DynamicDropDownListEntryItem object as children of the
DropDownListEntry object.

For information about seing properties for the
DropDownListEntry object, see “DropDownListEntry
Properties” on page 190.

DynamicDisplayObject Name of a method you code to display a user
interface object.
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Object Description

For information about seing properties
for the DynamicDisplayObject object, see
“DynamicDisplayObject Properties” on page 191.

DynamicDisplayObjectArray Name of a method you code to display an array of
user interface objects. For information about seing
properties for the DynamicDisplayObject object, see
“DynamicDisplayObject Properties” on page 191.

For information about seing properties
for the DynamicDisplayObjectArray object, see
“DynamicDisplayObjectArray Properties” on
page 192.

DynamicDropDownListEntryItem Specifies a method that executes at run time to
provide the list of entries to display in the drop-
down list. A DynamicDropDownListEntryItem object is
the child of a DropDownListEntry object.

For information about seing properties for
the DynamicDropDownListEntryItem object, see
“DynamicDropdownlistEntryItems Properties” on
page 192.

EndlessScrolling This is a modern approach to replace the pagination
paern: When a large amount of elements is to be
displayed in a ListView, only the first few elements
are loaded to increase performance and usability.
Once the user scrolls down to the end of the
displayed elements, the next elements are loaded
automatically without refreshing the view by calling
AbstractListViewController#onScrollThresholdReached().
You must override this method in the
[ViewName]ControllerImpl class and implement a
mechanism to load the required additional data, e.g.,
by increasing a pageNumber and using this number in
your data source or REST request.

For information about seing properties for the
EndlessScrolling object, see “EndlessScrolling
Properties” on page 192.

Entry Displays a text entry box.

You can set the Entry object’s Input Type property to:
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Object Description

Restrict the user input to alphanumeric characters
or only numbers.

Mask the field’s contents, making the field suitable
for a user to enter passwords or personal identifier
numbers (PINs).

For information about seing properties for the Entry
object, see “Entry Properties” on page 193.

FloatingEntry Displays a text entry box similar to the Entry object,
but offers far more possibilities to customize the
user interface and functionality. You can specify
hint icons, error text and even a validator. For more
information about the validator, see “StringValidator
Properties” on page 215.

For information about seing properties for the
FloatingEntry object, see “FloatingEntry Properties”
on page 194.

Image Displays an image.

To specify the image that you want to display, set the
Image object’s Image property.

You can use an Image object as a buon if you add a
TriggerListener object as a child object.

For information about seing properties for the
Image object, see “Image Properties” on page 196.

NavButton Displays a buon that an application uses for
navigation.

For information about seing properties for the
NavButton object, see “NavBuon Properties” on
page 197.

Pagination Adds objects that a user selects to display the next or
previous page of list items in a ListView.

For information about seing properties for the
Pagination object, see “Pagination Properties” on
page 197.

ProgressAnim Displays an animated status indicator that indicates
background activity is in progress.
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Object Description

For information about seing properties for the
ProgressAnim object, see “ProgressAnim Properties”
on page 198.

PullToRefresh Allows reloading of the ListView content by
dragging the first rows of the ListView downwards.

This object has no properties.

RadioButton Displays a single radio buon that uses two states,
selected or cleared.

For information about seing properties for the
RadioButton object, see “RadioBuon Properties” on
page 199.

SearchEntry Displays a search entry field.

For information about seing properties for the
SearchEntry object, see “SearchEntry Properties” on
page 199.

SearchNavButton Offers a search functionality that is embedded in the
header. Similar as a NavButton, it can be used in all
kinds of views that offer a header. It has two states:
showing a search icon or showing the search text
input field.

To start a search, an ISearchFieldListener must be
programmatically added to the SearchNavButton.
For more information, see “Configuring the
SearchNavBuon Object” on page 157.

For information about seing properties for the
SearchNavButton object, see “SearchNavBuon
Properties” on page 200.

StringDropDownListEntryItem Adds a single entry to a drop-down list. A
StringDropDownListEntryItem object is the child of a
DropDownListEntry object.

For information about seing properties for
the StringDropDownListEntryItem object, see
“StringDropdownlistEntry Properties” on
page 201.
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Object Description

SwipeButton Can be added to a TemplateAssignment in a ListView
and is shown when the user swipes an element in the
ListView to the left or to the right.

To define the action after clicking one
of these buons, you must implement
the onActionButtonClicked() method in the
[ViewName]ViewControllerImpl class. For more
information, see “Configuring the SwipeBuon
Object” on page 158.

For information about seing properties for the
SwipeButton object, see “SwipeBuon Properties” on
page 202.

SwipeRemove Allows selecting an element by swiping and have it
removed from the ListView.

For the selected element to be deleted, you
must implement the onSwiped() method in the
[ViewName]ViewControllerImpl class. For more
information, see “Configuring the SwipeRemove
Object” on page 158.

This object has no properties.

Textfield Displays plain text in a label or for a block of text.

For information about seing properties for the
Textfield object, see “Textfield Properties” on
page 203.

WebViewElement Use to display rich Web content from a local file or
by specifying the URL of the content to display.

For information about seing properties for the
WebViewElement object, see “WebViewElement
Properties” on page 204.

Button Properties

Property Description

Create On Condition Whether to create the buon at run time.
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Property Description

Font Color Color of the text on the buon.

Font Size Size of the font to use for the text on the buon.

Font Style How the text should be formaed, for example, bold, italic,
or underlined.

HAlign Horizontal alignment of the text on the buon.

Name Name you assign the buon in the Outline Editor for your
own reference purpose. This name does not appear in the
application’s user interface.

Position X Distance from the buon’s left edge to its parent object’s
inner X position.

Position Y Distance from the buon’s top edge to its parent object’s
inner Y position.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

Text Text to display on the buon.

Visible Whether the buon is visible or hidden.

Width Width of the buon.

ButtonGroup Properties

Property Description

Name Name you assign the buon group in the Outline Editor
for your own reference purpose. This name does not
appear in the application’s user interface.
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CheckBox Properties

Property Description

Create On Condition Whether to create the check box at run time.

Font Color Color of the text for the check box.

Font Size Size of the font to use for the check box text.

Font Style How the text should be formaed, for example, bold, italic,
or underlined.

HAlign Horizontal alignment of the text.

Name Name you assign the check box in the Outline Editor for
your own reference purpose. This name does not appear in
the application’s user interface.

Position X Distance from the check box’s left edge to its parent
object’s inner X position.

Position Y Distance from the check box’s top edge to its parent
object’s inner Y position.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

Text Text to display for the check box.

Visible Whether the check box is visible or hidden.

Width Width of the check box.

Container Properties

Property Description

Create On Condition Whether to create the container at run time.

Height Height of the container.
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Property Description

HScrollable Whether you want to allow horizontal scrolling in the
container.

Inner Height Usable height of the container in which you can insert
child objects.

Inner Width Usable width of the container in which you can insert child
objects.

Inner X Distance from the container’s left edge to where child
elements are drawn.

Inner Y Distance from the container’s top edge to where child
elements are drawn.

Name Name you assign the container in the Outline Editor for
your own reference purpose. This name does not appear in
the application’s user interface.

Position X Distance from the container’s left edge to its parent object’s
inner X position.

Position Y Distance from the container’s top edge to its parent object’s
inner Y position.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

Visible Whether the container is visible or hidden.

VScrollable Whether you want to allow vertical scrolling in the
container.

Width Width of the container.

DateEntry Properties

Property Description

Create On Condition Whether to create the date or time selector control at run
time.
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Property Description

Date Format Format in which to display the date or time.

Fallback Text The text to be displayed if no date is set.

Font Color Color of the text.

HAlign Horizontal alignment of the contents in the entry.

Name Name you assign the date or time selector control in the
Outline Editor for your own reference purpose. This name
does not appear in the application’s user interface.

Position X Distance from the date or time selector control’s left edge
to its parent object’s inner X position.

Position Y Distance from the date or time selector control’s top edge
to its parent object’s inner Y position.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

Visible Whether the date or time selector control is visible or
hidden.

Width Width of the date or time selector control.

DropDownListEntry Properties

Property Description

Create On Condition Whether to create the drop-down list at run time.

Font Size Size of the font to use for the text for the drop-down list.

Font Style How the text should be formaed, for example, bold, italic,
or underlined.

HAlign Horizontal alignment of the contents in the entry.
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Property Description

Name Name you assign the drop-down list in the Outline Editor
for your own reference purpose. This name does not
appear in the application’s user interface.

Position X Distance from the drop-down list’s left edge to its parent
object’s inner X position.

Position Y Distance from the drop-down list’s top edge to its parent
object’s inner Y position.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

Visible Whether the drop-down list is visible or hidden.

Width Width of the drop-down list.

DynamicDisplayObject Properties

Property Description

Create On Condition Whether to create the user interface object at run time.

Method Name Name of a method you code to display a user interface
object For information about the Java sources that Mobile
Development generates for the method and how to
provide logic for the method, see “Logic for a Method
Name Property” on page 115.

Name Name you assign the user interface object in the Outline
Editor for your own reference purpose. This name does not
appear in the application’s user interface.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

Visible Whether the user interface object is visible or hidden.



M
Even Header

User Interface Object Reference

webMethods Mobile Development Help Version 10.3 192

DynamicDisplayObjectArray Properties

Property Description

Create On Condition Whether to create the array of user interface objects at run
time.

Method Name Name of a method you code to display an array of user
interface objects. For information about the Java sources
that Mobile Development generates for the method and
how to provide logic for the method, see “Logic for a
Method Name Property” on page 115.

Name Name you assign the array of user interface objects in the
Outline Editor for your own reference purpose. This name
does not appear in the application’s user interface.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

Visible Whether the array of user interface objects is visible or
hidden.

DynamicDropdownlistEntryItems Properties

Property Description

Method Name Name of a method you code to populate the entries in
the drop-down list. For more information about the
Java sources that Mobile Development generates for the
method and how to provide logic for the method, see
“Logic for a Method Name Property” on page 115.

EndlessScrolling Properties

Property Description

Scroll Threshold Number of rows from the boom. When this number is
reached, additional data is automatically reloaded.
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Entry Properties

Property Description

Context Key Name of a context key you want to reference using syntax
such as ${CONTEXT_key}.

By default, Mobile Development saves the value you
enter in the control to a context that is available within the
lifetime of the application for the key you specify.

Create On Condition Whether to create the text entry box at run time.

Enabled Whether you want the element to be enabled or disabled.

Font Size Size of the font to use for the text for the text entry box.

Font Style How the text should be formaed, for example, bold, italic,
or underlined.

Hint Text you want to be displayed when a user hovers over
text entry box to provide information about what a user
can specify in the entry field.

Leave this property blank if you do not want to provide
hint text.

Input Type Type of input a user can supply in the text entry box.
For example, you might specify text, textPassword, or
number.

Lines Number of lines to display in the text entry box. This is the
number of lines into which a user can type information.

Name Name you assign to the text entry box in the Outline Editor
for your own reference purpose. This name does not
appear in the application’s user interface.

Position X Distance from the text entry box’s left edge to its parent
object’s inner X position.

Position Y Distance from the text entry box’s top edge to its parent
object’s inner Y position.
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Property Description

Style The style that should be used for this entry. For more
information, see “ Using Styles” on page 98.

Tag Used to determine the context of the element at run time,
e.g. in a Delegate to find out which element was pressed.

Text Text to display in the text entry box.

Visible Whether the text entry box is visible or hidden.

Width Width of the text entry box.

FloatingEntry Properties

Property Description

Background Color Background color of the entry.

Context Key Name of a context key you want to reference using syntax
such as ${CONTEXT_key}.

By default, Mobile Development saves the value you
enter in the control to a context that is available within the
lifetime of the application for the key you specify.

Create On Condition Whether to create the text entry box at run time.

Enabled Whether you want the element to be enabled or disabled.

Error Text The error message to be displayed if the given text is
invalid (according to the specified StringValidator).

Error Text Color The color of the error message.

Font Size Size of the font to use for the text for the text entry box.

Font Style How the text should be formaed, for example, bold, italic,
or underlined.
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Property Description

Hint Text you want to be displayed when a user hovers over a
text entry box to provide information about what a user
can specify in the entry field.

Leave this property blank if you do not want to provide
hint text.

Input Type Type of input a user can supply in the text entry box.
For example, you might specify text, textPassword, or
number.

Label Text Color The color of the label.

Lines Number of lines to display in the text entry box. This is the
number of lines into which a user can type information.

Name Name you assign to the text entry box in the Outline Editor
for your own reference purpose. This name does not
appear in the application’s user interface.

Position X Distance from the text entry box’s left edge to its parent
object’s inner X position.

Position Y Distance from the text entry box’s top edge to its parent
object’s inner Y position.

Postfix Hint The hint text to be displayed behind the text.

Postfix Icon The hint icon to be displayed behind the text.

Prefix Hint The hint text to be displayed in front of the text.

Prefix Icon The hint icon to be displayed in front of the text.

Style The style that should be used for this entry. For more
information, see “ Using Styles” on page 98.

Tag Used to determine the context of the element at run time,
e.g. in a Delegate to find out which element was pressed.

Text Text to display in the text entry box.

Visible Whether the text entry box is visible or hidden.
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Property Description

Width Width of the text entry box.

Image Properties

Property Description

Create On Condition Whether to display the image at run time.

HAlign Horizontal alignment of the image.

Image Image to display.

Note: The image must be one of your application resources.
For more information about resources, see “Defining
Resources for a Mobile Project” on page 35.

Name Name you assign the image in the Outline Editor for your
own reference purpose. This name does not appear in the
application’s user interface.

Position X Distance from the image’s left edge to its parent object’s
inner X position.

Position Y Distance from the image’s top edge to its parent object’s
inner Y position.

Scale to Parent Height Whether you want the image to be scaled vertically to
match the height of its parent object. Select the Select to
Parent Height check box if you want the image scaled to the
parent object’s height.

Scale to Parent Width Whether you want the image to be scaled horizontally to
match the width of its parent object. Select the Select to
Parent Width check box if you want the image scaled to the
parent object’s width.

Visible Whether the image is visible or hidden.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.
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NavButton Properties

Property Description

Create On Condition Whether to create the buon at run time.

Icon Icon image to display on the buon.

Note: The icon must be one of your application resources.
For more information about resources, see “Defining
Resources for a Mobile Project” on page 35.

Name Name you assign to the buon in the Outline Editor for
your own reference purpose. This name does not appear in
the application’s user interface.

Text Text to display on the buon.

Type Type of buon. The types are:

BACK

This type is placed on the left of the view header.

DEFAULT

This type is placed on the right of the view header.

Visible Whether the buon is visible or hidden.

Tag Used to determine the context of the element at run time,
e.g., in a delegate to find out which element was pressed.

Pagination Properties

Property Description

Max Number Per Page Maximum number of list items to display on a single page
of a ListView.

Next Page Template Template that defines an object to display at the boom
of the list of items in a ListView if more list items are
available on subsequent pages. A user selects the object to
display the next set of results in a ListView.
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Property Description

Specify a template that you previously defined. The
template should customize an object like a Button object.

Previous Page Template Template that defines an object to display at the top of the
list of items in a ListView if more list items are available
on previous pages. A user selects the object to display the
previous set of results in a ListView.

Specify a template that you previously defined. The
template should customize an object like a Button object.

Important: The templates that you specify for the Next Page Template and Previous Page
Template properties must be for an object that a user can trigger. Do not use a
template for an object like a Textfield, which a user use to trigger an action.

ProgressAnim Properties

Property Description

Create On Condition Whether to create the object at run time.

Name Name you assign the object in the Outline Editor for your
own reference purpose. This name does not appear in the
application’s user interface.

Position X Distance from the object’s left edge to its parent object’s
inner X position.

Position Y Distance from the object’s top edge to its parent object’s
inner Y position.

Visible Whether the object is visible or hidden.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.
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RadioButton Properties

Property Description

Create On Condition Whether to create the radio buon at run time.

Font Color Color of the text displayed for the radio buon.

Font Size Size of the font to use for the text displayed for the radio
buon.

Font Style How the text should be formaed, for example, bold, italic,
or underlined.

HAlign Horizontal alignment of the radio buon.

Name Name you assign the radio buon in the Outline Editor for
your own reference purpose. This name does not appear in
the application’s user interface.

Position X Distance from the radio buon’s left edge to its parent
object’s inner X position.

Position Y Distance from the radio buon’s top edge to its parent
object’s inner Y position.

Text Text to display for the radio buon.

Visible Whether the radio buon is visible or hidden.

Width Width of the radio buon.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

SearchEntry Properties

Property Description

Context Key Name of a context key you want to reference using syntax
such as ${CONTEXT_key}.
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Property Description

By default, Mobile Development saves the value you
enter in the control to a context that is available within the
lifetime of the application for the key you specify.

Create On Condition Whether to create the search entry box at run time.

Hint Text you want displayed when a user hovers over search
entry box to provide information about what a user can
specify in the entry field.

Leave this property blank if you do not want to provide
hint text.

Name Name you assign the search entry box in the Outline
Editor for your own reference purpose. This name does not
appear in the application’s user interface.

Position X Distance from the search entry box’s left edge to its parent
object’s inner X position.

Position Y Distance from the search entry box’s top edge to its parent
object’s inner Y position.

Visible Whether the search entry box is visible or hidden.

Width Width of the search entry box.

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

SearchNavButton Properties

Property Description

Cancel Text The text that should be displayed to close the search text
input field and show the search icon instead.

Create On Condition Whether to create the buon at run time.

Enabled Whether you want the element to be enabled or disabled.
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Property Description

Font Color Color of the text.

Hint Text Text you want to be displayed when the search text input
field is opened and no text is set or entered by the user.

Icon Icon image to display on the buon.

Note: The icon must be one of your application resources.
For more information about resources, see “Defining
Resources for a Mobile Project” on page 35.

Name Name you assign to the buon in the Outline Editor for
your own reference purpose. This name does not appear in
the application’s user interface.

Search Field Background
Color

Background color of the search text input field.

Search Field Foreground
Color

Foreground color of the search text input field.

Search Field Hint Text
Color

Text color of the hint text.

Style The style that should be used for this buon. For more
information, see “ Using Styles” on page 98.

Tag Used to determine the context of the element at run time,
e.g., in a delegate to find out which element was pressed.

Text Text to display on the buon.

Visible Whether the buon is visible or hidden.

StringDropdownlistEntry Properties

Property Description

Item Single item to display in the parent drop-down list object.
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SwipeButton Properties

Property Description

Background Color Background color of the buon.

Direction Swipe direction in which the buon is to be shown.

Font Color Color of the text font.

Font Size Size of the text font.

Font Style How the text should be formaed, for instance, bold, italic,
or underlined.

Image Icon image to display on the buon.

Note: The icon must be one of your application resources.
For more information about resources, see “Defining
Resources for a Mobile Project” on page 35.

Name Name of the buon.

Text Text to display on the buon.

Tab Properties

Property Description

Background Color Background color of the tab.

Image Icon that should be displayed in the tab.

Name Name of the tab.

Text Text that should be displayed in the tab.

View View that should be displayed when you click the tab.
Only View and WebView can be selected.
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Textfield Properties

Property Description

Clip Type Define the truncation mode that should be applied if not
the whole text value can be displayed. Must be one of
CLIP_TYPE_CLIP or CLIP_TYPE_ELLIPSIS.

Create On Condition Whether to display the text field at run time.

Font Color Color of the text.

Font Size Size of the font to use for the text.

Font Style How the text should be formaed, for example, bold, italic,
or underlined.

HAlign Horizontal alignment of the text.

Max Lines Maximum number of lines of text to display in the text
field when line-wrapped.

The value you specify for Max Lines must to be greater than
or equal to the value you specify for Min Lines.

Min Lines Minimum number of lines of text to display in the text
field when line-wrapped.

The value you specify for Min Lines must be less than or
equal to the value you specify for Max Lines.

Name Name you assign the text field in the Outline Editor for
your own reference purpose. This name does not appear in
the application’s user interface.

Position X Distance from the text field’s left edge to its parent object’s
inner X position.

Position Y Distance from the text field’s top edge to its parent object’s
inner Y position.

Render Type Whether to display the text as plain text or hyperlinked.
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Property Description

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.

Text Text to display.

Visible Whether the text field is visible or hidden.

Width Width of the text field.

WebViewElement Properties

Property Description

Create On Condition Whether to display the Web content at run time.

File File that contains the Web content to display.

Height Height to use for the object containing the Web content.

HScrollable Whether you want to allow horizontal scrolling of the Web
content.

Name Name you assign the object in the Outline Editor for your
own reference purpose. This name does not appear in the
application’s user interface.

Overscrolling Enabled Whether you want to allow overshooting the bounds of a
scrolling operation (only for Android).

Position X Distance from the object’s left edge to its parent object’s
inner X position.

Position Y Distance from the object’s top edge to its parent object’s
inner Y position.

Scale To Fit Enabled Whether you want to scale the WebView to fit the parent
element (only for iOS).

Tag Used to determine the context of the element at runtime,
e.g. in a Delegate to find out which element was pressed.
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Property Description

Url URL to the Web content to display.

Visible Whether the object containing the Web content is visible or
hidden.

VScrollable Whether you want to allow vertical scrolling of the Web
content

Width Width to use for the object containing the Web content.

Objects to Use for Content Providers or Content Adapters
The following table provides descriptions of the user interface objects that you use to
specify the content to display in a ListView object.

Object Description

ContentAdapter Specifies the content you want listed in a ListView object.

For more information about seing properties to the
ContentAdapter object, see “ ContentAdapter Properties” on
page 208.

ContentProvider Specifies the content you want listed in a ListView object.

For information about seing properties for the
ContentProvider object, see “ContentProvider Properties” on
page 208.

CustomDataComparator Allows developers to define an order for the elements
a ListView displays. Can be added as a child to a
DynamicDataSource,RESTDataSource or EntityDataSource.

For more information about seing properties to the
CustomDataComparator object, see “CustomDataComparator
Properties” on page 209.

DataBinding Defines how to bind data from the data source to an object
in the user interface. A DataBinding object is the child of a
Textfield, Image, Checkbox, RadioButton, Entry, SearchEntry
orDateEntry object.
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Object Description

For information about seing properties for the DataBinding
object, see “DataBinding Properties” on page 209.

DataTransformer Allows you to transform a given input to a specific
format required by a particular user interface element.
For example, when you get the name of an icon, the
data transformer will get the file name as its value and
return an icon which is then used by an ImageElement.
A DataTransformer object is the child of a DataBinding or
TemplateDataBinding object.

For information about seing properties for the
DataTransformer object, see “DataTransformer Properties”
on page 210.

DynamicDataSource Holds a list of elements to be bound to the user interface
elements. You need to implement IListDatasource. The
DynamicDataSource object can be used if the underlying
data set is not in JSON format or if the underlying data
consists of a custom data structure. A DynamicDatasource
object is the child of the application's Datasources node.

For information about seing properties for the
DynamicDataSource object, see “DynamicDataSource
Properties” on page 210.

EntityDataSource Holds a list of elements to be bound to the user interface
elements. The data objects from this data source must be
instances of generated Entity models.

For more information about seing properties to the 
EntityDataSource object, see “EntityDataSource Properties”
on page 211.

FileDataProvider A FileDataProvider can be added as child for an
EntityDataSource. It acts like a service for your
EntityDataSource. You can only use it for local/offline data,
which is stored on your device for example. The file
must be located in the projects resources/www folder
(subdirectories are not allowed). You need a DataExpression
to define the format the data is stored in the file and the
Entity to map the data to. Currently only JsonDataExpression
for Json formaed data files is supported.

This object has no properties.
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Object Description

Json Data Expression A  JsonDataExpression represents a path in your Json
reponse document. This path is identified by the
expression property. The underlying Json document will
be transformed into the specified Entity.

For more information about seing properties to
JsonDataExpression, see “ JsonDataExpression Properties”
on page 211.

RESTDataProvider A  RESTDataProvider can be added as child for
an EntityDataSource. It acts like a service for your
EntityDataSource. The given REST Method will be executed
when the data source is reloaded.

For more information about seing properties to the
RESTDataProvider, see “ RESTDataProvider Properties” on
page 211.

RESTDataSource Holds a list of elements to be bound to the user interface
elements. The underlying data set must conform to the
JSON format, and it is retrieved using a RESTful service
specified with the RestMethod property. All expressions
pointing to a RESTDatasource object are relative to the
underlying JSON objects. A RESTDataSource object is the
child of the application's Datasources node.

For information about seing properties for the
RESTDataSource object, see “RESTDataSource Properties”
on page 212.

See also “Objects to Use for RESTful Services” on
page 224.

RowSelectionListener Listens to trigger events for each row in a ListView
object, for example, when a user selects one row.
Multiple RowSelectionListener objects can be added to a
ContentAdapter. A ContentProvider supports only one 
RowSelectionListener.

For more information about seing properties to a
RowSelection Listener object, see “ RowSelectionListener
Properties” on page 215.

TemplateAssignment The TemplateAssignment configures the template to display
by the ListView  object. Each ContentAdapter must provide at
least one TemplateAssignment object.
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Object Description

For more information about seing properties to the
TemplateAssignment object, see “ TemplateAssignment
Properties” on page 212.

TemplateDataBinding Defines how to bind data from the data source to an object
in the user interface. A TemplateDataBinding object is the
child of a ContentProvider or TemplateAssignment object.

For more information about seing properties for the
TemplateDataBinding object, see “TemplateDataBinding
Properties” on page 213.

ContentAdapter Properties

Property Description

List Data Source A reference to a DynamicDataSource, RESTDataSource or
EntityDataSource which contains the elements to populate
to the ListView.

Reload On Transition To A boolean value indicating whether the data source is
to be reloaded each time when the view containing this
ContentAdapter object is accessed.

No Rows Template Name of a Template object that you previously defined. It
will be shown if the data source contains no elements after
having been reloaded.

ContentProvider Properties

Property Description

Expression Expression that identifies the data to obtain from the data
source.

No Rows Template Name of a Template object that you previously defined. It
will be shown if the data source contains no elements after
having been reloaded.
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Property Description

Reload On Transition To A boolean value indicating whether the data source is
to be reloaded each time when the view containing this
ContentProvider object is accessed.

Row Template Name of a Template object that you previously defined.

At run time, the data obtained from the data source is
formaed and displayed in this user interface object.
Specify a Template object that is based on a user interface
object that can display the list of information, such as a
Table object.

For more information about templates, see “Using
Templates to Define Custom Objects for a Mobile Project”
on page 100 and “Using a Content Provider to Populate a
ListView” on page 87.

CustomDataComparator Properties

Property Description

Class Name A name of the class which contains the comparison logic.
This class will be generated into the src/yourBundleId /
comparator package and must implement
com.softwareag.mobile.runtime.toolkit.delegates.IComparator.

DataBinding Properties

Property Description

Data Source Name of the DynamicDataSource, RESTDataSource or  EntityDataSource
object to use to obtain the data to bind to the control.

Expression Expression that identifies the data to bind to the user interface
object.
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DataTransformer Properties

Property Description

Class Name The value of this property can be the simple name of a class
(e.g. MyTransformer ) or a fully qualified class name (e.g.
com.company.transformers.MyTransformer ). If a simple name
is specified, the corresponding Java class is generated into
src/bundleId /data/transformer/classname .java. If a fully qualified
class name is provided, the transformer class is be generated but
must be defined in the projects class path. Press CTRL+SPACE
to view the list of built-in transformers provided by Mobile
Development. All transformer implementations must implement
IDataTransformer.

Constructor
Arguments

A couple of string values can be specified here to be passed to the
transformer as constructor arguments. Only data type String is
supported. The transformer needs to offer a constructor to handle
the specified number of String arguments, e.g., a paern for date
conversion can be specified here.

DynamicDataSource Properties

Property Description

Method Name Name of a method you code to populate a ListView.
For information about the Java sources that Mobile
Development generates for the method and how to
provide logic for the method, see “Logic for a Method
Name Property” on page 115.

The method you code must return an instance of
IListViewDatasource, which is in the gen/api-src folder in the
com.softwareag.mobile.runtime.toolkit.delegates package.

Name Name you assign to the data source in the Outline Editor
for your own reference purpose.
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EntityDataSource Properties

Property Description

Name Name you assign to the data source in the Outline Editor
for your own reference purpose.

JsonDataExpression Properties

Property Description

Expression Identifies a JSON array which will be used as the
source to get the elements managed by the data source.
For more information about JSON expressions, see
com.softwareag.mobile.runtime.toolkit.rest.JPath.

Filter Expression A JSON expression value to filter the underlying JSON
data.

For more information about JSON expressions, see
com.softwareag.mobile.runtime.toolkit.rest.JPath.

Name Name you assign to the data source in the Outline Editor
for your own reference purpose.

Entity A reference to an Entity. Each JSON Object will be
transformed into this Entity. Therefore, the Entity must
contain at least one @JsonProperty annotation.

RESTDataProvider Properties

Property Description

Name Name you assign to the data source in the Outline Editor
for your own reference purpose.

REST Method Method to invoke to provide the data for the ListView
object.
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Property Description

Select a method that you have defined in the model. You
define the method using a Method object that is a child of
the Resource object in the Services part of the model.

RESTDataSource Properties

Property Description

Expression Identifies a JSON array which will be used as the
source to get the elements managed by the data source.
For more information about JSON expressions, see
com.softwareag.mobile.runtime.toolkit.rest.JPath.

Filter A JSON expression value to filter the underlying JSON
data. For more information about JSON expressions, see
com.softwareag.mobile.runtime.toolkit.rest.JPath.

Name Name you assign to the object in the Outline Editor for your own
reference purpose. This name does not appear in the application’s
user interface.

Rest Method Method to invoke to provide the data for the ListView object.

Select a method that you have defined in the model. You define
the method using a Method object that is a child of the Resource
object in the Services part of the model.

TemplateAssignment Properties

Property Description

Bind Method Name A name of a Java method will be generated. The generated
contents will initialize your Template and bind it against the
data.

Filter Expression A String value evaluated at run time if the specified
Template should be initialized for a given row index.

Template A reference to a Template to populate to the ListView object.
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TemplateDataBinding Properties

Property Description

Control Name of the user interface object to which to bind data from the
data source.

Data Source Name of the DynamicDataSource, RESTDataSource or  EntityDataSource
object to use to obtain the data to bind to the control.

Expression Expression that identifies the data to bind to the control specified
by the Control property.

Objects to Use for Event Listeners
The following table provides descriptions of user interface objects that you can include
in the model to add listeners to an application. The objects generate a user-initiated
event when the user performs the action, such as when a user presses a buon.

For more information on the supported listeners, see “Responding to User-Initiated
Events” on page 92.

Object Description

CompletedEditListener Listens for, when a user edits an object, for example an
entry field, and generates an event when the user ends
the editing. End of editing means closing the keyboard or
focusing another UI element.

This object has no properties.

GainFocusListener Generates a user-initiated event when a user interface
object gains focus.

For example, if you want to generate a user-initiated event
when an entry field gains focus because the user selects the
entry field, add a GainFocusListener object as a child of the
Entry object.

This object has no properties.

LoseFocusListener Generates a user-initiated event when a user interface
object loses focus.
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Object Description

For example, if you want to generate a user-initiated event
when an entry field loses focus because the user stops
selecting the entry field by selecting another user interface
control, add a LoseFocusListener object as a child of the
Entry object.

This object has no properties.

PostEditListener Generates a user-initiated event after a user edits an object.

Note: In the case of keyboard entry, a new event is
generated for each character typed or deleted.

For example, if you want to generate a user-initiated event
after a user types an entry in a SearchEntry object, add a
PostEditListener object as a child of the SearchEntry object.

This object has no properties.

PreEditListener Generates a user-initiated event when a user is about to
edit an object.

For example, if you want to generate a user-initiated event
when a user is about to type text in a SearchEntry object,
add a PreEditListener object as a child of the SearchEntry
object.

This object has no properties.

RowSelectionListener Generates a user-initiated event when a user selects a row.

A RowSelectionListener is the child of a ContentProvider
object.

For information about seing properties for the
RowSelection object, see “ RowSelectionListener Properties”
on page 215.

StringValidatorListener Checks the input of an element in real time.

For information about seing properties for the
StringValidator object, see “StringValidator Properties” on
page 215.

SwipeListener Generates a user-initiated event when a user swipes to the
left or right.

A SwipeListener is the child of a View object.
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Object Description

For information about seing properties for the
SwipeListener object, see “SwipeListener Properties” on
page 216.

TriggerListener Generates a user-initiated event after a user uses an object.

For example, if you want to generate a user-initiated event
after a user presses a Button object, add a TriggerListener
object as a child of the Button object.

Note: If you add a TriggerListener as the child of an Image
object, the image acts as a buon.

This object has no properties.

RowSelectionListener Properties

Property Description

Filter Expression This property acts like the filter expression set for
the TemplateAssignment object. It identifies at run time
whether or not the added actions should be executed by
evaluating the filter expression. This property is optional
for RowSelectionListener objects added to a ContentProvider.

StringValidator Properties

Property Description

Class Name The value of this property can be the simple name of a
class (e.g., MyStringValidator ) or a fully qualified class
name (e.g., com.company.validators.MyStringValidator ). If a
simple name is specified, the corresponding Java class is
generated into src/bundleId /data/validator/classname .java.
If a fully qualified class name is provided, the validator
class is not generated but must be defined in the projects
class path. Press CTRL+SPACE to view the list of built-in
validators provided by Mobile Development. All string
validator implementations must implement IStringValidator.

Constructor Arguments A couple of string values can be specified here to be passed
to the validator as constructor arguments. Only data
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Property Description
type String is supported. The validator needs to offer
a constructor to handle the specified number of String
arguments, e.g., a paern for a regular expression can be
specified here.

SwipeListener Properties

Property Description

Direction Either a LeftToRight or RightToLeft swipe event.

Objects to Use for Event Actions
The following table provides descriptions of user interface objects that you include in the
model to specify the action you want an application to take when a user-initiated event
occurs.

For more information on how the application responds to a user-initiated event, see
“Responding to User-Initiated Events” on page 92.

Object Description

Back The application displays the previous view when the
associated user-initiated event occurs.

For information about seing properties for the Back
object, see “Back Properties” on page 218.

Note: This action is only supported if the application uses
the Mobile DevelopmentTransitionStackController. If
the application override the TransitionStackController,
this event action will not work properly. For more
information about the TransitionStackController, see
“About the TransitionStackController” on page 111.

ChangePaneConfiguration The application switches to a pane configuration you
specify when the associated user-initiated event occurs.

For information about seing properties
for the ChangePaneConfiguration object, see
“ChangePaneConfiguration Properties” on page 218.
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Object Description

CloseSideView A SideView is a common paern that displays the main
navigation options for your application. It is hidden most
of the time, unless the user opens it using the dedicated
OpenSideView action or a programmatically implemented
solution. A CloseSideView action closes an already opened
SideView.

For more information, see “Responding to User-Initiated
Events” on page 92.

This object has no properties.

Delegate The application executes a method you specify when the
associated user-initiated event occurs.

For information about seing properties for the Delegate
object, see “Delegate Properties” on page 219.

OpenDialog The application displays the AlertDialog you specify when
the associated user-initiated event occurs.

For information about seing properties for the OpenDialog
object, see “OpenDialog Properties” on page 219.

OpenSideView A SideView is a common paern that displays the main
navigation options for your application. It is hidden most
of the time, unless the user opens it using the dedicated
OpenSideView action or a programmatically implemented
solution. A OpenSideView action opens a desired SideView.

For more information, see “Responding to User-Initiated
Events” on page 92.

This object has no properties.

ReloadContentProvider The application reloads the data source.

This object has no properties.

ToggleVisibility The application switches between making a user interface
object that you specify either visible or hidden.

If the object is currently visible, the application hides it.

If the object is currently hidden, the application makes it
visible.

An example of using the ToggleVisibility action might be to
show a buon if a user enters text in a text entry field.
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Object Description

For information about seing properties for the
ToggleVisibility object, see “ToggleVisibility Properties” on
page 219.

Transition The application transitions to the new view you specify
when the associated user-initiated event occurs.

For information about seing properties for the Transition
object, see “Transition Properties” on page 220.

Back Properties

Property Description

Back To Root Back behavior that you want the application to take when
the user-initiated event occurs.

Clear the check box if you want the application to return
to the previous view.

Select the check box if you want the application to display
the first view.

When you select the check box, the TransitionStackController
opens the first pushed view. For more information
about the TransitionStackController, see “About the
TransitionStackController” on page 111.

ChangePaneConfiguration Properties

Property Description

Method Name Name of a method that performs the change to the new
pane configuration. Specifying the Method Name property is
optional.

When you specify Method Name, Mobile Development
generates a method and places code to change the pane
configuration in the method you specify. You can then add
additional code to the method. For more information, see
“Logic for a Method Name Property” on page 115.
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Property Description

On Condition Whether to perform the change pane configuration action
at run time.

Pane Configuration Pane configuration to which the application switches
when the user-initiated event occurs. Specify the name of
a PaneConfiguration object you previously defined in the
model.

Delegate Properties

Property Description

Method Name Name of a method you code and that the application
executes when the user-initiated event occurs.

For information about the Java sources that Mobile
Development generates for the method and how to
provide logic for the method, see “Logic for a Method
Name Property” on page 115.

OpenDialog Properties

Property Description

Dialog Dialog to display when the user-initiated event occurs.
Specify the name of a AlertDialog object you previously
defined in the model.

ToggleVisibility Properties

Property Description

Control The user interface object that you want to make visible or
hide in response to the user-initiated event.

Note: If you identify a control that is within a template, the
control within the template is made visible or hidden.
If the template is instantiated multiple times, the
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Property Description
control in all instantiated templates are made visible
or hidden at the same time.

If you nest templates inside templates, only identify
controls in the top-level template.

Transition Properties

Property Description

Method Name Name of a method that performs the transition to the new
view. Specifying the Method Name property is optional.

When you specify Method Name, Mobile Development
generates a method and places code to transition to
the view in the method you specify. You can then add
additional code to the method. For more information, see
“Logic for a Method Name Property” on page 115.

On Condition Whether to perform the transition action at run time.

Pane Pane in which to display the view.

Style How to perform the transition to the new view, for
example, fade in the new view or have the new view
appear.

View View to transition to when the user-initiated event occurs.
Specify the name of a ListView, NavView, View, or WebView
object you previously defined in the model.

Objects to Use for Templates
Use templates to define custom user interface objects. For more information about
templates, see “Using Templates to Define Custom Objects for a Mobile Project” on
page 100.

The following table provides descriptions of the user interface objects for using
templates.
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Object Description

ListViewElement Defines a custom object that works like a ListView. When
you create templates for ListViewElement objects, you can
then reference the templates in a normal view, allowing
you to include more than one object in a regular view, each
behaving like a ListView object.

For information about seing properties for the
ListViewElement object, see “ListViewElement Properties”
on page 221.

Template Defines a custom user interface object.

For information about seing properties for the Template
object, see “Template Properties” on page 222.

TemplateReference Adds the custom user interface object to the user interface.

For information about seing properties for the
TemplateReference object, see “TemplateReference
Properties” on page 222.

ListViewElement Properties

Property Description

Adjust Height Adjusts the height of the object to the total size of its child
controls.

Height Height you want to use for the object.

List View Header Template that defines an object to display as the header for
the list of data displayed in the ListView.

Specify a template that you previously defined. The
template should customize an object like a Textfield or
Image object.

Separator Template that defines an object to display between the each
list item displayed in the ListView.

Specify a template that you previous defined. The template
should customize an object like a Separator object.
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Property Description

Width Width you want to use for the object.

Template Properties

Property Description

Class Name Name of the Java class that Mobile Development generates
for this template. For more information about the sources
that Mobile Development generates for the template and
where to add your logic to create a custom user interface
object, see “Creating a Template for a Custom Object” on
page 100.

TemplateReference Properties

Property Description

Name Name you assign to the template reference object in the
Outline Editor for your own reference purpose. This name
does not appear in the application’s user interface.

Template Name of the template for the custom user interface that
you want to add to the user interface.
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Objects to Use for RESTful Services
The following table provides a description of the objects you use for RESTful services.

Object Description

Resources Identifies the server on which the services reside.

For information about seing properties for the Resources
object, see “Resources Properties” on page 224.

Resource Identifies the path to the service you want to use.

For information about seing properties for the Resource
object, see “Resource Properties” on page 225.

Method Identifies the method to execute.

For information about seing properties for the Method
object, see“Method Properties” on page 225.

Request Specifies the content type for the request sent to the REST
service.

For information about seing properties for the Request
object, see “Request Properties” on page 226.

Parameter Specifies an input parameter for the service. Use one
Parameter object for each input parameter.

For information about seing properties for the Parameter
object, see “Parameter Properties” on page 226.

Response Specifies the format of the response from the REST service.

For information about seing properties for the Response
object, see “Response Properties” on page 227.

Resources Properties

Property Description

Base Base URI for the REST services you want to use. This part of
the URI identifies the server on which the services reside, for
example, hps://mycompany.com.
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Property Description

You can include dynamic URI elements, for example, hps://
{company}.apps.com/networking, where {company} is a
dynamic URI element.

Resource Properties

Property Description

Path Path to the service you want to use.

You can include dynamic URI elements, for example, record/
{objectName}, where {objectName} is a dynamic URI element.

You can nest Resource objects under a parent Resource object
to provide subpath values.

The value you specify for the Path properties of the Resource
objects you add to the model are combined with the Base
property of the Resources parent object to form the URI to the
services you want to use.

Method Properties

Property Description

Class Name Name of a Java class that Mobile Development generates in
the gen/src folder in the package_name .services.rest package,
where package_name  is the package name that you specified
for your mobile project.

The generated Java class contains a constructor that sets the
URI and contains the dynamic URI elements as parameters.
The dynamic URI elements, if any, are the ones that you
specify in the Resources object’s Base property and Resource
objects’ Path properties.

The Java class includes an execute method that the mobile
application invokes to execute the REST service.

Name How the request is sent over the network. Select one of the
following:

DELETE to delete the resource identified by the request URI
on the server.
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Property Description

GET to send the request with the data aached to the request
address (URI).

POST to send the request with the data sent as a separate
data block.

PUT to send the request with the data sent as a separate data
block.

Request Properties

Property Description

Content Type Content type for the request sent to the REST service. The
application sends the input parameters, which you define
using child Parameter objects, in the format you specify.
Specify one of the following:

NONE if the REST services requires the parameters to be sent
in plain text format.

application/xml if the REST service requires the parameters to
be sent in XML format.

application/json if the REST service requires the parameters to
be sent in JSON format.

multipart/form-data if the REST service requires the parameters
to be sent in multipart format.

Parameter Properties

Property Description

Default Value Default value for the parameter.

If you specify a value, Mobile Development does not create a
method parameter for the Parameter object.

If you specify a value for Default Value, the Repeating property
must be cleared.

Name Name of the parameter. The value you specify must be
unique among all parameters you specify for a specific
Request object.
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Property Description

Note: Do not use postData as a value. The value postData is
reserved.

Repeating Whether the parameter contains multiple values. Select the
Repeating check box if the parameter contains multiple values.

If you select the Repeating check box, you cannot specify a
value for the Default Value property.

Style Whether the parameter is to be added to the header or query
string.

HEADER if the parameter is to be added to the header.

QUERY if the parameter is to be added to the URL.

Url Encode Specifies that the value of the parameter must be url encoded.

Response Properties

Property Description

Accept Format of the response from the REST service. Specify one of
the following:

NONE if the REST service response is in plain text format.

application/xml if the REST service response is in XML format.

application/json if the REST service response is in JSON
format.

Objects to Use for Mobile Support - Offline Synchronization
The following table provides a description of the objects you use for mobile support.

Object Description

SyncComponent Provides an implementation to synchronize data with
a remote host using the Mobile Support library. Data
will be stored on the device using a SQLite database.
Synchronization is a periodic process which automatically
relaunches itself after the amount of milliseconds specified
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Object Description
in the Update Interval property. A SyncComponent object can
be used as a REST method for a REST data source.

For information about seing properties for the
SyncComponent object, see “SyncComponent Properties” on
page 228.

SyncComponent Properties

Property Description

App Name Name of the mobile application. For more information, see
Developing Data Synchronization Solutions with webMethods
Mobile Support.

App Version Version of the mobile application. For more information, see
Developing Data Synchronization Solutions with webMethods
Mobile Support.

Hostname Host name of the Enterprise Gateway Server.

Msc Alias Alias used to identify the mobile sync component. For more
information, see Developing Data Synchronization Solutions with
webMethods Mobile Support.

Port Port on the above host.

Update Interval A value in milliseconds (default 60000 = 1 minute). After this
time period, the SyncComponent object automatically starts a
new synchronization process.
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